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Preface

Effective communication is an essential part of modern business. However, users frequently 
are frustrated with juggling multiple devices to handle phone, fax, e-mail, instant messaging, 
and Web-based communications. By integrating voice capabilities into current collaboration 
applications, such as e-mail and instant messaging, users can be more productive, 
responsive, and accessible. An example of this integration is having access to phone, fax, and 
electronic messages in a single unified inbox. Another example is to set up a team call by 
clicking names on the buddy list of an instant message application.

Companies that use IBM® Lotus® Sametime® and Lotus Domino® already have a 
comprehensive solution for presence awareness, e-mail, instant messaging, and Web 
conferencing. Now, with the 3Com System i™ IP Telephony and Integrated Collaboration 
solution, Sametime users can make phone calls by using their IP desk phone and simply 
clicking a contact within their Sametime contact list. Alternatively, they can receive voice mail, 
faxes, and e-mail in a single unified inbox as part of the 3Com IP Telephony Messaging for 
System i application integrated with Domino. 

Voice messages are received as attachments that can be opened and played on a computer 
by using standard multimedia applications. Faxes are displayed as a graphics attachment. 
Systems integrators, independent software vendors (ISVs), and application developers can 
integrate telephony into their business and collaboration applications by using the application 
programming interfaces (APIs) that are available with the 3Com IP Telephony Integration 
Software Development Kit (SDK) or SDK Toolkit for System i.

This IBM Redbooks® publication is intended for system administrators and field technicians 
to help you understand and integrate telephony into your collaborative environment. 
Specifically it shows how to configure the Domino server to directly receive voice mail and 
faxes into the Domino inbox. This book includes information about enabling telephony into 
your Sametime Connect clients. In addition, it explains how to synchronize your Domino 
Directory with the IP Telephony VCX directory.

The team that wrote this book

This book was produced by a team of specialists from around the world working at the 
International Technical Support Organization (ITSO), Rochester Center.

Jose Faisca is an engineer and independent Senior IT Consultant 
and Systems Architect from Portugal. He as more than 20 years of 
experience in IT subjects. His areas of expertise include systems 
integration, network computing, and IP telephony. He has extensive 
practical experience in projects that use IBM solutions and 
architectures, including the System i and Domino platforms. He has 
strong skills in systems administration and computer programming. 
Jose is currently focused in projects that use innovative voice and 
advanced real-time communication services over the Internet. You 
can contact Jose by sending e-mail to jose.faisca@gmail.com.
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collaborative technologies. Mike’s areas of expertise include Domino 
and Portal solutions on i5/OS. You can contact Mike by sending 
e-mail to mgordo@us.ibm.com.

Kim Greene is president of Kim Greene Consulting, Inc., which 
specializes in Domino for i5/OS® consulting and services to 
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Chapter 1. Planning, prerequisites, and 
architecture

In this chapter, we help you to plan and prepare for implementing the IBM System i IP 
Telephony and Integrated Collaboration solution. This chapter includes the following topics: 

� “Capacity planning” on page 2
� “Software prerequisites” on page 5
� “Setup checklists” on page 7
� “Networking using virtual IP interfaces for Domino servers” on page 10
� “Solution architecture” on page 18
� “System test environment used in this book” on page 20

1

More information: For detailed information about how to configure your System i machine 
to support IP Telephony, refer to IBM System i IP Telephony Configuring the System i 
Infrastructure, SG24-7382.
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1.1  Capacity planning

IBM System i IP Telephony, Messaging, and Conferencing run in separate Linux® logical 
partitions (LPARs) on one or more System i machines. You create and manage Linux LPARs 
by using either the Hardware Management Console (HMC) or the Virtual Partition Manager 
(VPM). HMC is the preferred tool to configure a multiple logical partitioned System i machine. 
It provides an easy-to-use graphical interface to set up partitions by using either hosted or 
direct input/output (I/O) interfaces. VPM supports the needs of small and medium customers 
who want to add simple Linux workloads to their System i machine without needing an HMC.

The following types of System i processors are supported for IP Telephony:

� IBM POWER5™
� IBM POWER5+™
� IBM POWER6™

For details about sizing your System i machine, refer to 2.9, “Capacity planning,” in IBM 
System i IP Telephony Configuring the System i Infrastructure, SG24-7382, which provides 
information about using the following tools:

� Workload Estimator
� VoIP Designer tool
� System Planning Guide

To run IBM System i IP Telephony and Integrated Collaboration, you must have the following 
additional hardware requirements at a minimum: 

� Processor unit: 670 commercial processing workloads (CPWs)
� Memory: 1.5 GB
� Disk storage: 25 GB
� Network interface: One virtual Ethernet adapter for virtual I/O or dedicated for direct I/O

More information: For details about configuring partitions on a System i machine for IP 
Telephony, refer to IBM System i IP Telephony Configuring the System i Infrastructure, 
SG24-7382.

Important: These tools do not replace the advice of an IBM representative or Business 
Partner who is experienced with IP telephony requirements. Make sure to obtain expert 
assistance before you select a final System i configuration.

System i Sizing Crib Sheet: At the time of writing this book, these requirements were the 
minimum additional requirements to run one System i IP Telephony and Messaging 
partition including Lotus Domino and Sametime integration. For the most current values, 
see the System i Sizing Crib Sheet on the 3Com IP Telephony for IBM System i 
documentation Web page:

http://csoweb4.3com.com/iseries/vcx_doc.cfm
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Table 1-1 and Table 1-2 on page 4 provide an overview of the hardware requirements for 
three scenarios: 

� Scenario 1: 50 phone users, 25 conferencing ports, 38 voice or fax messages going to the 
Domino server per hour

� Scenario 2: 100 phone users, 50 conferencing ports, 75 voice or fax messages going to 
the Domino server per hour

� Scenario 3: 1000 phone users, 100 conferencing ports, 600 voice or fax messages going 
to the Domino server per hour

The figures in these scenarios are based on the following assumptions:

� These guidelines are targets that are estimated at more than 60% processor utilization.
� Each user is calculated as having six calls per hour on a business day.
� Storage guidelines assume medium voice mail usage, at 30 minutes per user per day.
� An average voice message is 20 seconds.
� No broadcast voice mail is sent to all system users.
� Of all users, 25% have e-mail storage needs.
� System i IP Messaging assumes uncompressed storage of voice mail at 480k per minute, 

using G.711 codec for audio compounding.

Table 1-1   Sizing guidelines for IP Telephony and Integrated Collaboration scenarios (part 1)

Server resources Incremental resources for i5/OS 
per hosted LPAR

System i IP Telephony and 
Messaging

System i IP 
Conferencing

Scenario 1: 50 phone users, 25 conferencing ports

Processor unit 50 CPW 600 CPW 600 CPW

Memory 512 MB 1024 MB 512 MB

Disk storage No additional 16 GB 15 GB

Scenario 2: 100 phone users, 50 conferencing ports

Processor unit 50 CPW 600 CPW 1200 CPW

Memory 512 MB 1024 MB 512 MB

Disk storage No additional 17 GB 15 GB

Scenario 3: 1000 phone users, 100 conferencing ports

Processor unit 100 CPW 1100 CPW 2400 CPW

Memory 1024 MB 1024 MB 1024 MB

Disk storage No additional 32 GB 15 GB

 

 

 

Chapter 1. Planning, prerequisites, and architecture 3



 

Table 1-2   Sizing guidelines for IP Telephony and Integrated Collaboration scenarios (part 2)

For example, let us review the second scenario in Table 1-1 and Table 1-2. In this scenario, 
we assume that you plan to use 100 phone users (using either hard or soft phones), 50 
people parallel in one or more conferences, and 75 voice or fax messages forwarded to the 
Domino server per hour in a business day. In addition to this, you plan to have between 2001 
and 5000 click-to calls from Sametime per hour and about 500 Sametime presence users 
with less than 50 buddies in their buddy list.

To set up this environment, you must first have a Domino server configured and running on 
your System i machine. Then you activate the Lightweight Directory Access Protocol (LDAP) 
service in your Domino server and install the Domino IP Telephony integration code. Next you 
install and set up the System i IP Telephony and Messaging partition, including the LDAP 
synchronization and the System i IP Conferencing partition for extended conferencing 
services.

An additional 3475 CPW is needed based on the following CPW requirements:

� 100 CPW (2 x 50 CPW) for the two hosted Linux partitions running System i IP Telephony 
and Messaging as well as the System i IP Conferencing code (see Table 1-1 on page 3)

� 600 CPW to handle the workload on the System i IP Telephony and Messaging partition

� 1200 CPW to cover the maximum workload on the System i IP Conferencing partition

� 15 CPW to handle the additional e-mail received by the Domino server and delivered to 
the Lotus Notes® clients (see Table 1-2)

� 100 CPW used by the System i IP Messaging module on the System i IP Telephony and 
Messaging partition caused by converting and forwarding the voice and fax messages to 
the Domino server

Server 
resources

IBM System i IP Telephony and Integrated Collaboration

Incremental 
resources for the 
Domino server on 
System i

Incremental 
resources for 
System i IP 
Messaging

Incremental 
resources for 
Sametime on System i 
(click-to call only)

Incremental resources 
for System i IP 
Telephony (click-to 
call or presence)

Scenario 1: 38 voice or fax messages going to the Domino server per hour, less than 2000 click-to calls per hour, 
100 Sametime presence users with less than 50 buddies in a buddy list

Processor unit 8 CPW 75 CPW 250 CPW 50 / 210 CPW

Memory No additional No additional No additional No additional

Disk storage 12 GB No additional No additional No additional

Scenario 2: 75 voice or fax messages going to the Domino server per hour, 2001 - 5000 click-to calls per hour, 
500 Sametime presence users with less than 50 buddies in a buddy list

Processor unit 15 CPW 100 CPW 750 CPW 100 / 610 CPW

Memory No additional No additional 512 MB No additional

Disk storage 12 GB No additional No additional No additional

Scenario 3: 600 voice or fax messages going to the Domino server per hour, 5001 - 10,000 click-to calls per hour, 
2500 Sametime presence users with less than 50 buddies in a buddy list

Processor unit 120 CPW 300 CPW 1100 CPW 200 / 2610 CPW

Memory No additional No additional 512 MB No additional

Disk storage 15 GB No additional No additional No additional
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� 750 CPW to handle the additional workload on the Sametime server

� 100 CPW for the click-to-call function on the System i IP Telephony server

� 610 CPW to display the presence status in the Sametime buddy list

A total of 3 GB memory is calculated by adding the integration needs of i5/OS, System i IP 
Telephony and Messaging, System i IP Conferencing, the Domino server, and Sametime.

In this example, 44 GB of disk storage is required. The i5/OS partition requires all the 
additional space. The most common way to set up an System i IP Telephony environment is 
to use hosted Linux partitions that receive their storage from the hosting i5/OS partition. The 
two partitions require 32 GB of disk storage. We assume that the Domino server runs on the 
same i5/OS partition and requires an additional 12 GB of storage.

1.2  Software prerequisites

In this section, we explain the software prerequisites that are necessary to run the IP 
Telephony integration with the Domino server or Sametime. Table 1-3 shows the products that 
must be installed and configured on your system before you can start the installation of the 
System i IP Messaging and System i IP Conferencing software.

Table 1-3   Software prerequisites

Software prerequisites Description References

IBM i5/OS V5R3M0 or 
later, including:
� Option 33 for Portable 

Application Solution 
Environment (PASE)

� Latest Cumulative 
PTF Package

System i partition operating system 
level, including PASE, which is Option 
33 of 5722-SS1

� i5/OS and related software Install, 
upgrade, or delete i5/OS and related 
software, SC41-5120

3Com System i IP 
Telephony Release 
7.2.5c or later

System i IP Telephony and Messaging 
code running in a Linux partition or 
partitions

� 3Com VCX IP Telephony and Messaging 
DVD

� IBM System i IP Telephony Configuring the 
System i Infrastructure, SG24-7382

� 3Com IP Telephony for IBM System i: 
http://csoweb4.3com.com/iseries/
vcx_doc.cfm 

3Com System i IP 
Conferencing Release 
7.2.49 or later (optional)

System i IP Conferencing code running 
in a Linux partition

Whether you must run a separate 
conferencing partition depends on the 
required conferencing ports. If you do 
not need more than five times six people 
in a conference, you do not need a 
separate IP Conferencing server. The IP 
Messaging product includes 30 ports for 
adhoc conferencing.

� 3Com VCX IP Conferencing DVD
� IBM System i IP Telephony Configuring the 

System i Infrastructure, SG24-7382
� 3Com IP Telephony for IBM System i: 

http://csoweb4.3com.com/iseries/
vcx_doc.cfm 

� Section 3.1, “IP Telephony collaboration 
functions in Sametime” on page 56
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In this book, we describe how to install and set up both Domino and Sametime integration. 
Table 1-4 provides a quick reference on where to find the installation code for IBM System i IP 
Telephony and Integrated Collaboration. Refer to the referenced sections in Table 1-4 for 
detailed installation and setup steps.

Table 1-4   Software required for integrated Collaboration installation

Either of the following 
Domino versions:
� For Domino 

integration or LDAP 
synchronization, 
Domino 6.5.6 or later 
on System i 

� For Sametime 
integration, Domino 
7.0.2 or later on 
System i

Domino server code running on i5/OS is 
required to use the LDAP 
synchronization or to integrate with the 
Domino server.

If you want to integrate IP Telephony 
with Sametime, a higher level of Domino 
code is required, which provides the 
features needed to implement the 
integration.

� IBM Lotus Domino 6 for iSeries 
Implementation, SG24-6592

� Implementing IBM Lotus Domino 7 for 
i5/OS, SG24-7311

For Sametime integration, 
Sametime 7.5.1 Server 
on System i

Sametime server code running on i5/OS � Installing and Managing Sametime 7.5.1 
for i5/OS, SC23-5978, on the Web at: 
http://www-128.ibm.com/developerworks/
lotus/documentation/sametime/
Click the 7.5.x tab and scroll down.

IBM Integrated Domino 
Fax for i5/OS V4R4 or 
later (optional)

Integrated Fax server to run fax on i5/OS

With this software, you can send 
outbound faxes directly from your Notes 
clients. With the Print-to-Fax driver, 
Notes users can send faxes directly 
from a Microsoft Windows® application, 
such as Microsoft Word or Excel®.

� IBM Integrated Domino Fax for i5/OS:
http://www.ibm.com/iseries/domino/
related/fxd/

� Chapter 4, “Domino integration” on 
page 111

Software prerequisites Description References

Installation software Description Code location and reference

IPTelephonySPI-version.tar 
version 7.2.74.1 or later

Sametime integration code to be 
executed in the i5/OS PASE 
environment using Qshell

3Com VCX IP Telephony and Messaging DVD

Refer to 3.2, “Installing and setting up IP Telephony 
integration with Sametime” on page 58.

IPTelephonyPlugin.jar 3Com IP Telephony Line Status 
Feature code

This Sametime connect client 
plug-in shows the System i IP 
Telephony line status. With this 
plug-in, you can work with 
telephony preferences under 
File → Preferences.

This file is on your VCX server after installing IP 
Telephony SPI in http://IPTelserver/linestatus. 
Alternatively to run the installation from a different 
server, you can find the IPTelephonyPlugin.jar file in 
/opt/3com/VCX/ipwservice/vcx-html/linestatus.

Refer to 3.2, “Installing and setting up IP Telephony 
integration with Sametime” on page 58.

ipmmail_i5.tar Domino integration code to be 
executed in the i5/OS PASE 
environment by using Qshell

3Com VCX IP Telephony and Messaging DVD

Refer to “Installing the integration package in the 
i5/OS partition” on page 115.
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1.3  Setup checklists

In this section, we provide a checklist of the steps that are required to install and configure 
IBM System i IP Telephony and Integrated Collaboration. The tasks are divided into four 
sections:

� Global prerequisites (Table 1-5)
� LDAP synchronization (Table 1-6 on page 7)
� Sametime integration (Table 1-7 on page 8)
� Domino integration (Table 1-8 on page 9)

1.3.1  Global prerequisites checklist

Table 1-5 summarizes the global prerequisites. Refer to 1.2, “Software prerequisites” on 
page 5, which describes the software prerequisites in detail.

Table 1-5   Global prerequisites checklist

1.3.2  LDAP synchronization setup checklist

Table 1-6 outlines the tasks to set up LDAP synchronization. Refer to Chapter 2, “LDAP 
synchronization” on page 25, for detailed installation instructions and to understand the 
concept of LDAP synchronization between Domino LDAP and the IP Telephony VCX directory.

Table 1-6   LDAP synchronization checklist

Task Required 
or optional

Reference Done

Check your i5/OS level. Required Table 1-3 on page 5

Check the System i IP Telephony and Messaging 
server version.

Required Table 1-3 on page 5

Check the System i IP Conferencing server version 
if installed.

Optional Table 1-3 on page 5

Task Required 
or optional

Reference Done

Check the Domino server version. Required Table 1-3 on page 5

Enable LDAP services on the Domino 
server.

Required 2.2, “Enabling LDAP services for 
the Domino server” on page 28

Modify the Domino LDAP configuration 
to add the telephoneNumber Attribute 
Type to the LDAP schema.

Required 2.2.2, “Modifying the Domino 
LDAP configuration” on page 33

Enable full text indexing of the Domino 
Directory to provide adequate LDAP 
services performance.

Optional 2.2.3, “Full text indexing of the 
Domino Directory” on page 35

Enable LDAP synchronization at the 
initial System i IP Telephony and 
Messaging server configuration.

Required 2.3, “Configuring LDAP 
synchronization” on page 36

Reconfigure LDAP synchronization Optional 2.4, “Reconfiguring LDAP 
synchronization” on page 41
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1.3.3  Sametime integration setup checklist

Table 1-7 lists the tasks to set up the Sametime integration. Refer to Chapter 3, “Sametime 
integration” on page 55, for an overview of the Sametime integration functions. That same 
chapter also provides step-by-step installation instructions and a detailed description of the 
supported features.

Table 1-7   Sametime integration checklist

Task Required or 
optional

Reference Done

Check the Domino and 
Sametime server versions.

Required Table 1-3 on page 5

Prepare the DVD containing the 
IPTelephonySPI-version.tar file.

Required Table 1-4 on page 6

Copy and extract the Telephony 
Service Provider Interface 
(TCSPI) code to i5/OS.

Required “Installing TCSPI” on page 60

End the Sametime server. Required “Ending the Sametime server” on 
page 64

Configure the TCSPI. Required “Configuring TCSPI” on page 65

Start the Sametime server. Required “Enabling TCSPI on the Sametime 
server” on page 68

Enable the TCSPI in Meeting 
Services of the Sametime 
server configuration.

Required “Enabling TCSPI on the Sametime 
server” on page 68

Restart the Sametime server. Required “Restarting the Sametime server” on 
page 69

Install the 3Com IP Telephony 
Line Status Feature on each 
Sametime connect client.

Optional 3.3, “Installing the IP Telephony 
presence plug-in in the Sametime 
Connect client” on page 72

Reconfigure TCSPI and 
corresponding information.

Optional 3.2.3, “(Optional) Reconfiguring and 
enabling the Sametime server” on 
page 70
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1.3.4  Domino integration setup checklist

Table 1-8 lists the tasks to set up the Domino integration. Refer to Chapter 4, “Domino 
integration” on page 111, for an overview of the Domino integration functions. That same 
chapter provides step-by-step installation instructions and a detailed description of the 
supported features.

Table 1-8   Domino integration checklist

Task Required or 
Optional

Reference Done

Check the Domino server version. Required Table 1-3 on page 5

Update the fire wall on the primary 
and secondary System i IP 
Messaging partition.

Optional 4.2.1, “Planning” on page 113

Prepare the DVD that contains the 
ipmmail_i5.tar file.

Required Table 1-4 on page 6.

Copy and extract the ipmmail_i5.tar 
file that contains the installation 
script for IPMADDIN to i5/OS.

Required “Installing the integration package in 
the i5/OS partition” on page 115

End the Domino server. Required “Installing the integration package in 
the i5/OS partition” on page 115

Install the IPMADDIN task. Required “Installing the integration package in 
the i5/OS partition” on page 115

Start the Domino server. Required “Installing the integration package in 
the i5/OS partition” on page 115

Verify the IPMADDIN installation. Optional “Verifying the installation” on 
page 121

Enable Simple Mail Transfer Protocol 
(SMTP) and Internet Message 
Access Protocol (IMAP) services on 
the Domino server.

Required 4.3.2, “Enabling Domino for SMTP 
and IMAP” on page 130

On the Domino server, specify the 
Internet password and Internet 
address (e-mail address) on each 
Person document. This is required 
for users to receive e-mail from the 
System i IP Messaging server.

Required 4.3.3, “Configuring the Domino 
environment” on page 132

In the System i IP Messaging Voice 
mail Administration GUI, add the 
Domino server to the system 
configuration.

Required 4.3.4, “Adding Domino and SMTP to 
the System i IP Telephony 
configuration” on page 134

Configure the SMTP Server 
parameters in the System 
configuration of the Voice mail 
Administrative GUI.

Required 4.3.4, “Adding Domino and SMTP to 
the System i IP Telephony 
configuration” on page 134

In the IP Messaging Web 
Provisioning, add an external e-mail 
address to each user who will 
receive e-mail in their Domino inbox.

Required 4.3.5, “Configuring the System i IP 
Messaging mailbox” on page 143
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1.4  Networking using virtual IP interfaces for Domino servers

As described in IBM System i IP Telephony Configuring the System i Infrastructure, 
SG24-7382, you can configure a virtual Ethernet interface, Proxy Address Resolution 
Protocol (ARP), and Dynamic Host Configuration Protocol (DHCP) server on i5/OS to use 
them in conjunction with the System i IP Telephony partitions. In this section, we explain how 
to configure virtual IP interfaces to be used for any Domino server that is running on i5/OS. 

1.4.1  The concept of virtual IP interfaces

Virtual IP, also called a circuitless or loopback interface, is a powerful function that provides a 
way to assign one or more addresses to the system without binding the address to a physical 
interface. You can use this function when you want to run multiple occurrences of a system 
that is bound to different addresses or if you want to run other services that must bind to 
default ports.

For most environments in which you might want to use virtual IP, you will want to provide 
multiple paths between the local gateway and the System i machine. For example, you might 
want load balancing and fault tolerance. In this context, each path implies an additional 
interface and an additional, nonvirtual IP address on the system. These multiple interfaces 
should be visible only on the local network. You do not want the remote clients to be aware of 
the multiple IP addresses for the system. They detect and connect to your system with a 
single IP address. By using virtual IP, the routing of the inbound packets through the gateway, 
over the local network, and to the system is invisible to a remote client. Because remote 
clients detect only the virtual IP address, you can stop communication to a bounded 
application by taking down this interface. Therefore, you do not have to stop the nonvirtual 
address or the physical Ethernet line.

Figure 1-1 shows an example of how to apply fault tolerance for one Domino server called 
DEMODOM, which is installed on a system called RCHAS10. DEMODOM uses a virtual IP 
interface of 9.5.92.26 that is bound to two nonvirtual IP interfaces, 9.5.92.16 and 9.5.92.18. 
Refer to 1.4.2, “Setting up fault tolerance by using a virtual IP interface” on page 11, for the 
steps to configure this example.

Figure 1-1   Domino server configured with a virtual IP interface

The virtual IP address of 9.5.92.26 acts as the server for remote clients that appear as a 
single host. The virtual IP address must be on a different subnet than the physical interfaces. 
Therefore, the subnet mask for the virtual IP interface is usually set to 255.255.255.255.

IP addresses: 9.5.92.x
Subnet mask: 255.255.255.0

R1

R2

DNS Entry for DEMODOM:
9.5.92.26 

9.5.92.16

9.5.92.18

RCHAS10

Domino server:
DEMODOM

*Virtual IP:
IP address: 9.5.92.26
Subnet mask: 255.255.255.255
Proxy ARP: enabled

Internet
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Because the virtual IP address is not bound to a single physical interface, the system never 
responds to an ARP request to the virtual IP address and is not reachable for the remote 
client. By enabling proxy ARP and binding one ore more local interfaces, one of the interfaces 
can respond to the ARP requests on behalf of the virtual IP address. Otherwise, remote 
systems must have a route defined to reach the address.

1.4.2  Setting up fault tolerance by using a virtual IP interface

To configure virtual IP and proxy ARP for adapter fault tolerance situations as shown in 
Figure 1-1:

1. Use iSeries Navigator to create a new virtual IP interface:

a. In iSeries Navigator, start the New IPv4 Interface wizard. Expand Network → TCP/IP 
Configuration → IPv4. Select Interfaces, right-click, and select New Interface → 
Virtual IP (Figure 1-2).

Figure 1-2   Starting the New IPv4 Interface wizard

Alternative: You can also use the following i5/OS Add TCP/IP Interface (ADDTCPIFC) 
CL command to create a new virtual IP interface:

ADDTCPIFC INTNETADR('9.5.92.26') LIND(*VIRTUALIP) 
SUBNETMASK('255.255.255.255') ALIASNAME(DEMODOM) AUTOSTART(*YES)
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b. On the New IPv4 Interface - Welcome window (Figure 1-3), click Next.

Figure 1-3   New IPv4 Interface - Welcome window
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c. On the New IPv4 Interface - Settings window (Figure 1-4), enter the designated virtual 
IP interface address and the subnet mask for the new interface. 

The subnet mask is set to 255.255.255.255 because we want the clients to see the 
server behind the virtual IP address as a single host. The virtual IP address must also 
be in a different subnet mask than the local interfaces. Figure 1-4 shows that we use a 
description and an alias name in our environment as well. 

Click Next.

Figure 1-4   Virtual IP settings
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d. On the New IPv4 Interface - Start window (Figure 1-5), decide whether you want the 
interface to start each time TCP/IP server starts. In our example, we select Yes. Then 
decide whether you want to start the interface after you close the wizard. In our 
example, we select No because we must change properties. 

Click Next.

Figure 1-5   Virtual IP startup settings
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e. On the New IPv4 Interface - Summary window (Figure 1-6), check your settings and 
click Finish to create the virtual IP interface.

Figure 1-6   Virtual IP setup summary
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2. Enable the proxy ARP and associate the preferred local interfaces:

a. In iSeries Navigator, expand Network → TCP/IP Configuration → IPv4. Select 
Interfaces. In the right pane, right-click your newly created virtual IP interface 
(9.5.92.26 in this example) and select Properties (Figure 1-7).

Figure 1-7   Selecting the virtual IP interface properties

b. On the virtual IP interface Properties window (Figure 1-8), click the Advanced tab.

Figure 1-8   Virtual IP interface properties
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c. On the Advanced tab (Figure 1-9):

i. Select Enable proxy ARP to enable transparent subnetting to associate the virtual 
interface with external interfaces.

ii. In the list of Available interfaces, select the preferred interfaces and click the Add 
button to set up fault tolerance. Whenever an external TCP/IP request is running to 
the virtual IP interface, the first available preferred local interface is selected for 
communication. You can select up to 10 preferred interfaces. To change the order in 
the list, click the Move up and Move down buttons.

As shown in Figure 1-9, we selected the preferred interfaces of 9.5.92.16 and 
9.5.92.18 in the given order. 

iii. After you have made your selections, click OK.

Figure 1-9   Advanced properties tab
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3. Start the newly created virtual IP interface. In iSeries Navigator, expand Network → 
TCP/IP Configuration → IPv4 and select Interfaces. In the right pane, right-click your 
newly created virtual IP interface and select Start as shown in Figure 1-10.

Figure 1-10   Starting the virtual IP interface

Figure 1-11 shows our new active virtual IP interface, 9.5.92.26, with the subnet mask of 
255.255.255.255. The current associated local IP interface is 9.5.92.16, and the proxy ARP is 
enabled.

Figure 1-11   New virtual IP interface started

1.5  Solution architecture

In this section, we discuss the architecture of the IBM System i IP Telephony and Integrated 
Collaboration solution. Figure 1-12 on page 19 provides an overview of the architecture. We 
describe how the following three different integration models work from an architectural point 
of view:

� LDAP synchronization
� Sametime integration
� Domino integration

Starting the virtual IP interface from a 5250: Although you are unable to change the 
Proxy ARP settings from a 5250 emulation session, you can start the virtual IP interface 
from there. Use the following command to start the virtual IP interface:

STRTCPIFC ALIASNAME(DEMODOM)
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Figure 1-12   IBM System i IP Telephony and Integrated Collaboration architecture

1.5.1  Architecture of LDAP synchronization (A)

The LDAP synchronization model helps you to manage your System i IP Telephony user in a 
single directory. By having this configured, you can do a bulk load of your users from the 
Domino Directory to the System i IP Telephony directory. Further more, any changes that are 
made to the Domino address book entry are synchronized to the System i IP Telephony user 
directory by using one-way synchronization.

The Domino address book is the master directory that sends the changes to the Domino 
LDAP directory and forwards them to the System i IP Telephony user directory. The person 
document in the Domino server address book must have their phone number assigned to the 
office phone field in order to be synchronized. To exclude users from being synchronized, you 
must add a pre-configured string into the comments field of those users. 

You can set up LDAP synchronization at the initial System i IP Telephony configuration or any 
time after that. See Chapter 2, “LDAP synchronization” on page 25, for details.

1.5.2  Architecture of Sametime integration (B)

By installing the Sametime integration module, you enable the click-to-dial, the click-to-call, 
and the click-to-conference features inside Sametime. These integration features are 
implemented by installing the TCSPI on your Sametime server that is running on i5/OS. You 
control your 3Com phone remotely by using the integrated System i IP Telephony Web 
Services. By configuring Sametime to use the same LDAP directory as your Domino server 

Independent models: The three integration models can run independent of each other. 
You can install either one, two, or all three of them.

IP Telephony and IP Messaging

Domino Web AccessNotes client Sametime Connect

Domino server on i5/OS

IPMADDIN

Web Services IP Conferencing

Sametime server on i5/OS

TCSPI

LDAP Synch

Client plug-in

SIP

SOAP messagesIPMADDIN
events

IMAPSMTP

NRPC HTTP
Sametime protocol 
over TCP/IP

LDAPA C B

Sametime
Web client

HTTP
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and enabling the LDAP synchronization function, you will have consistent information 
throughout your environment.

The System i IP Telephony internal adhoc conferencing function can accommodate five 
conferences up to six people. If you need more simultaneous conferences or more people in 
the same conference, you must install a System i IP Conferencing server. In addition to the 
functions that are enabled by the TCSPI, you can install a Sametime Connect client plug-in to 
display the status of phone users. You can see if a user has a phone assigned and if the 
phone is in use. Details are provided in Chapter 3, “Sametime integration” on page 55.

1.5.3  Architecture of Domino integration (C)

The Domino integration module provides a unified inbox for e-mail, voice messages, and 
faxes on the Domino server for selected users. It is a real-time synchronization between the 
Domino server and the System i IP Messaging server. By using the Lotus Notes client or the 
Domino Web Access, you have access to this unified inbox. The voice and fax messages are 
sent to the Domino server by using SMTP. Then the installed IPMADDIN Domino task sends 
events back to the System i IP Messaging server to initiate an IMAP poll to synchronize the 
Message Wait Indicator or to delete the message on the System i IP Messaging server. 

You must perform the following tasks:

� Install the IPMADDIN task on your Domino server that is running on i5/OS. 

� Set the Internet (e-mail) address and the Internet password on the person document in the 
Domino server address book. 

� Add an external e-mail account for the mailbox on the System i IP Messaging server to 
connect to the Domino mailbox. 

See Chapter 4, “Domino integration” on page 111, for details.

1.6  System test environment used in this book

We configured our own system test environment for this book. You can use this section as a 
quick reference to find the following information that is used in the examples throughout this 
book:

� Network configuration
� Phone extensions
� Users in Domino, the LDAP directory, and System i IP Telephony directory
� Additional IP Telephony related settings

For details about the server configuration of the primary and secondary IBM System i IP 
Telephony servers that we used to test IBM System i IP Telephony and Integrated 
Collaboration, see Appendix B, “System i IP Telephony and Messaging server settings” on 
page 191. 
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Figure 1-13 illustrates an overview of our environment. Our environment consists of a 
System  i Model 520 running on the following partitions:

� One i5/OS partition
� A hosted primary and one secondary System i IP Telephony, Messaging partition
� A System i IP Conferencing partition

We cover all three integration models. Therefore, we installed and configured a Domino 
server with the LDAP server enabled and a Sametime server.

Because Session Initiation Protocol (SIP) devices are needed for testing, we installed seven 
3Com phones and one analog gateway. One fax device was attached to the gateway to 
simulate incoming faxes. On the clients, we ran Lotus Notes and Sametime Connect clients.

Figure 1-13   The System i test environment used in this book
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DEMODOM
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1.6.1  Our network configuration

Table 1-9 lists the IP addresses that are assigned in our environment. The Domino server and 
the Sametime server use a virtual IP interface and proxy ARP to implement fault tolerance on 
two physical interfaces, 9.5.92.16 and 9.5.92.18. For details about how to configure this 
network, see 1.4, “Networking using virtual IP interfaces for Domino servers” on page 10.

The hosted Linux partitions that hold the System i IP Telephony, Messaging, and 
Conferencing code use virtual Ethernet ports as described in IBM System i IP Telephony 
Configuring the System i Infrastructure, SG24-7382. Since we have only a few SIP devices 
configured, we decided to assign fixed IP addresses to them. However, the phones can obtain 
their IP address from a DHCP server.

Table 1-9   Our network configuration

1.6.2  Our user and phone numbers assigned

Table 1-10 lists the users that are created in the Domino server directory. We set up a 
common LDAP directory within the same domain for the Domino server and the Sametime 
server. Both servers were running on i5/OS.

Since we enabled LDAP synchronization in our test environment, the users and phone 
numbers are populated from the Domino Directory to the System i IP Telephony server 
directory. The LDAP sync column in Table 1-10 indicates whether the user is populated to the 
System i IP Telephony server directory. See Chapter 2, “LDAP synchronization” on page 25, 
for details about why some users are not synchronized. By having this configuration, the 
users and the phone numbers are common within the three applications.

Table 1-10   Domino users and phone numbers in our test environment

Name Description IP address

rchas10.iptdemo.com i5/OS partition running V5R4M0 9.5.92.16
9.5.92.18

demopri.iptdemo.com Primary System i IP Telephony and Messaging server, 
Version 7.5.2c

9.5.92.66

demosec.iptdemo.com Secondary System i IP Telephony and Messaging 
server, Version 7.5.2.c

9.5.92.67

democonf.iptdemo.com System i IP Conferencing server, Version 7.2.49 9.5.92.68

demodom.iptdemo.com Domino server, Version 7.0.2 9.5.92.16

demost.iptdemo.com Sametime server, Version 7.0.2 9.5.92.50

Phones 3Com phones and analog gateway 9.5.92.200 - 207

Workstations Workstations used for testing DHCP assigned

Domino user name Phone 
number

Internet (e-mail) address LDAP sync

Debra Landon 1705 dlandon@iptdemo.com Yes

Domino Administrator 1700 dadminis@iptdemo.com Yes

Has PhoneNumber 1709 hphonenumber@itpdemo.com Yes

Isabelle Ringing 1721 iringing@iptdemo.com Yes
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1.6.3  Additional System i IP Telephony related settings

Table 1-11 shows the additional system-wide settings within the System i IP Telephony server 
that were requested during the setup and installation procedure of the Sametime integration 
model in this book. 

Table 1-11   Additional IP Telephony settings

Isabelle Ringing Copy 1721 ciringing@iptdemo.com No

Jairo Reyes 1707 jairoer@iptdemo.com Yes

Jose Faisca 1703 jfaisca@iptdemo.com Yes

Kim Greene 1701 kgreene@iptdemo.com Yes

Markus Neuhold 1706 mneuhold@iptdemo.com Yes

Mike Gordon 1702 mgordon@iptdemo.com Yes

Moe D’Lawn 1710 mdlawn@iptdemo.com Yes

Moe D’Lawn Copy 1710 cmdlawn@iptdemo.com No

No PhoneNumber - nphonenumber@iptdemo.com No

Perry O’Dontal 1720 perryodontal@iptdemo.com Yes

Rob Haviland 1704 rhaviland@iptdemo.com Yes

User Fax 1730 ufax@iptdemo.com Yes

NotAdded ToVCX 1713 ntovcx@iptdemo.com No

Domino user name Phone 
number

Internet (e-mail) address LDAP sync

End points Value Description

IPCONF 9.5.92.68:5060 Connection to System i IP Conferencing server for All 
Conferences

IPCONF ATT 9.5.92.68.5092 Connection to System i IP Conferencing server for 
Conference Attendant

Route plans Value Description

All Conferences 71* Route Plan connected to IPCONF endpoint. 
Conference range on our System i IP Conferencing 
server is 7100 to 7199

Conference Attendance 7777 Route Plan connected to IPCONF ATT endpoint. 
Conference Attendance 

Note: These settings are done within the Web-based system management of the primary 
System i IP Telephony server. Check the corresponding documentation on 3Com IP 
Telephony for IBM System i documentation Web site for details:

http://csoweb4.3com.com/iseries/vcx_doc.cfm
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Chapter 2. LDAP synchronization

In this chapter, we discuss the following topics:

� “LDAP synchronization overview” on page 26
� “Enabling LDAP services for the Domino server” on page 28
� “Configuring LDAP synchronization” on page 36
� “Reconfiguring LDAP synchronization” on page 41
� “Working with the non-VCX user identifier” on page 43
� “Troubleshooting LDAP synchronization” on page 45

2
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2.1  LDAP synchronization overview

Domino on i5/OS is used to provide LDAP services for the IBM System i IP Telephony 
solution. LDAP synchronization is a function that is included in the IBM System i IP Telephony 
solution. This service is called LDAPSync. LDAP synchronization between the Domino LDAP 
directory and the VCX directory provides two types of services:

� Initial bulk loading of the VCX directory
� Synchronization of user adds, changes, and deletions from the Domino Directory

With bulk loading of the VCX directory, users in the Domino LDAP directory can quickly be 
imported into the VCX user database. When this bulk import happens, users and associated 
voice mailboxes for the users are automatically created in the VCX directory.

After the initial bulk loading of the VCX directory, changes that are made to users in the 
Domino LDAP directory are reflected in the VCX directory. New users who are registered in 
Domino automatically have a user account and voice mailbox created for them in the VCX 
directory. The account and mailbox are created as long as the new user has a phone number 
specified in their Domino Person document and they are not specified as a non-VCX user.

In addition, any changes to users on the Domino Directory (names.nsf) side, such as name 
changes, are synchronized in the VCX directory. These LDAPSync add, modify, and delete 
requests are sent to the VCX data server through a Java™ Database Connectivity (JDBC™) 
interface. After the updates are performed in the VCX database, the VCX database triggers 
notify the LDAPSync application that the updates have been performed. This way the 
LDAPSync knows that it has completed synchronization to the VCX database.

2.1.1  How LDAP synchronization works

As shown in Figure 2-1, the LDAPSync function is a one-way synchronization, from the 
Domino LDAP directory to the VCX directory. Any changes in the VCX directory are not 
reflected in the Domino LDAP directory. The frequency for how often LDAP synchronization 
occurs is shown in Figure 2-15 on page 40.

Figure 2-1   LDAPSynch architecture

The default synchronization time interval is every 1800 seconds (30 minutes). The minimum 
synchronization time allowed is 60 seconds. We recommend that you leave the default 
synchronization interval of 1800 seconds.

Important: Changes in the VCX directory are not synchronized back to the Domino LDAP 
directory.

Domino
LDAP
Server

Domino 
LDAP

VCX
Data

Server

VCX DB

LdapSync
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The LDAPSync only allows LDAP users with unique user names and phone numbers to be 
added to the VCX database. In addition, if a user is specified as a non-VCX user, they are not 
added to the VCX database. Table 2-1 shows which Domino LDAP attributes are 
synchronized to the VCX directory. The table also shows how the attributes map between the 
two directories.

Table 2-1   Domino LDAP attributes that get synchronized to the VCX directory

The phone number field is pulled from the office phone attribute in the Domino Directory, 
which is located on the Work tab of the Person document as shown in Figure 2-2. This 
attribute is not enabled by default in the Domino LDAP directory. We show how to enable this 
LDAP attribute in 2.2.2, “Modifying the Domino LDAP configuration” on page 33.

Figure 2-2   Telephone attribute required in the Domino LDAP directory

Domino LDAP attribute VCX directory attribute

First name First name

Last name Last name

Short name/UserID Weblogin User Name

Internet address E-mail

Work Office Phone Phone address or extension

Company Street Address Street-1

Company City City

Company State State/Province

Company Zipcode ZIP Code

 

 

 

Chapter 2. LDAP synchronization 27



 

2.1.2  Non-VCX user identifier

A non-VCX user identifier identifies which users should not be automatically added to the 
System i IP Telephony and Messaging server. This user identifier is specified during 
installation of the IP Messaging software. See Figure 2-15 on page 40 for details.

The non-VCX user identifier is used in the Domino Directory in the Comments field of a 
Person document. When this field is set to the non-VCX user identifier, the user is not added 
to the VCX directory. If a user has already been added to the VCX directory, the user is 
removed from the VCX directory when the non-VCX user identifier is specified in their Person 
document.

See 2.5, “Working with the non-VCX user identifier” on page 43, for details about how to use 
the non-VCX user identifier.

2.1.3  LDAPSync scenarios

The following types of changes in the Domino LDAP directory are synchronized to the VCX 
directory:

� The addition of a new user in the Domino LDAP directory causes the user to be added to 
the VCX directory as long as the office phone field is filled out and the non-VCX user 
identifier is not specified in the Person document.

� The deletion of a user in the Domino LDAP directory causes the user to be removed from 
the VCX directory.

� Updates to any Domino LDAP attributes listed in Table 2-1 on page 27 cause the 
associated field in the VCX directory entry to be updated for that user.

� Deletion of the user’s phone number in the Domino LDAP directory causes the user to be 
removed from the VCX directory.

2.2  Enabling LDAP services for the Domino server

LDAP must be enabled for the Domino server that is synchronized with the VCX directory. 
Perform the following steps to make sure this task is configured properly:

1. Open the Domino Administration client.

2. Click the Configuration tab.

3. Navigate to Server → All Server Documents and double-click the Domino server 
document for the Domino server.

4. Click the Edit Server button to put the document into edit mode.

Important: Synchronization of users in the VCX database is keyed from the Office phone 
field. If this field is empty in the Person document in the Domino Directory, the user is not 
added to the VCX database.

Logout of end points: The user must be logged out of all end points (hard phones, 
soft phones, wi-fi phones, and so on) before they can be removed from the VCX 
directory.
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5. Click the Ports tab and the Internet Ports subtab. On the Internet Ports tab, click the 
Directory tab. On the Directory tab (Figure 2-3), the TCP/IP port status field must be set 
to Enabled.

Figure 2-3   Enabling the LDAP port for the Domino server

6. Click Save & Close to exit the Domino server document.

7. The LDAP task should start when the Domino server starts. If you know this is already 
happening, go to 2.2.1, “Running the Domino LDAP and i5/OS LDAP servers on the same 
system” on page 30. 

Otherwise use the Change Domino Server (CHGDOMSVR) CL command to modify the 
Domino server configuration:

a. End the Domino server by entering the following End Domino Server (ENDDOMSVR) 
CL command:

ENDDOMSVR DominoServerName

Here DominoServerName represents your Domino server name.

b. Change the Domino server configuration by entering the following Change Domino 
Server (CHGDOMSVR) CL command:

CHGDOMSVR DominoServerName

Here DominoServerName represents your Domino server name.

Tip: Press the F4 key to prompt the CHGDOMSVR command to see the parameters 
as shown in Figure 2-4 on page 30.
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c. On the Change Domino Server display (Figure 2-4), modify the Directory services 
parameter to include *LDAP and press Enter.

Figure 2-4   Change Domino Server (CHGDOMSVR) command to add the LDAP task

d. Start the Domino server by entering the following Start Domino Server (STRDOMSVR) 
CL command:

STRDOMSVR DominoServerName

Here DominoServerName represents your Domino server name.

2.2.1  Running the Domino LDAP and i5/OS LDAP servers on the same system

Both the i5/OS LDAP server and Domino LDAP server must bind to a specific TCP/IP 
address if they are to run on the system at the same time. By default, the i5/OS LDAP server 
listens on all IP interfaces, which creates a port conflict with the Domino LDAP server. To 
avoid this situation, you can choose one of the following options:

� “Binding the i5/OS LDAP server to a specific IP interface” on page 31
� “Disabling the i5/OS Directory server” on page 32 (if the directory server is not being used)

                       Change Domino Server (CHGDOMSVR)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Server name  . . . . . . . . . . > demodom                                     
                                                                                
                                                                                
                                                                                
 Additional server ID:                                                          
   ID file's password . . . . . .   *NONE                                       
 Time zone  . . . . . . . . . . .   CST           *SAME, *SYSVAL,GMT,EST ...    
 Daylight savings time  . . . . .   *YES          *SAME, *YES, *NO, *TIMEZONE   
 Web browsers . . . . . . . . . .   *HTTP         *SAME, *NONE, *ALL, *IIOP...  
                                                                                
 Internet mail packages . . . . .   *IMAP         *SAME,*NONE,*ALL,*IMAP ...    
                + for more values   *SMTP                                       
 Directory services . . . . . . .   *LDAP         Character value, *SAME...     
                                                                                
 Connection services  . . . . . .   *NONE         *SAME, *DECS, *NONE           
                                                                                
                                                                        More... 
 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display    
 F24=More keys                                                                  

If LDAP task does not start: If the LDAP task does not start after you make these 
changes, make sure the line DisableLDAPOnAdmin=1 does not exist in the Domino 
server’s notes.ini file. If you see this entry, remove it and restart the Domino server. 
To edit the notes.ini file, use the Work with Domino Server (WRKDOMSVR) CL 
command and type option 13 (Edit Notes.ini) next to your Domino server.
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Binding the i5/OS LDAP server to a specific IP interface
To bind the i5/OS LDAP server to use a specific IP interface rather than listening on all IP 
interfaces:

1. Open iSeries Navigator on the System i machine.

2. From the left navigation pane, expand Network → Servers → TCPIP. In the right pane, 
right-click TCPIP and select IBM Directory Server → Properties.

3. In the IBM Directory Server Properties window (Figure 2-5):

a. Click the Network tab. 

b. On the Network tab, click the IP Addresses button.

Figure 2-5   IBM Directory Server Properties window - Network tab
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c. In the Directory - IP Addresses window (Figure 2-6), click Use selected IP addresses. 
Select the IP address you have chosen for the i5/OS LDAP server to use and click OK.

Figure 2-6   Assigning a specific IP address to the i5/OS LDAP server

d. Click OK to close the IBM Directory Server Properties window.

4. In the right pane, right-click TCPIP and select IBM Directory Server → Stop to stop the 
i5/OS Directory server. 

5. In the right pane, again right-click TCPIP and select IBM Directory Server → Start to 
restart the i5/OS Directory server.

Disabling the i5/OS Directory server
If the i5/OS Directory server is not being used, you can end the server and set its properties 
to not automatically start when TCP/IP is started on the system:

1. Open iSeries Navigator on the System i machine.

2. In the left navigation pane, expand Network → Servers → TCPIP. 

3. In the right pane, right-click TCPIP and select IBM Directory Server → Stop.

4. In the right pane, again right-click TCPIP and select IBM Directory Server → Properties.
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5. In the Properties window (Figure 2-7), on the General tab, clear the option Start server 
when TCP/IP is started and click OK.

Figure 2-7   Disabling the i5/OS LDAP server from automatically starting

2.2.2  Modifying the Domino LDAP configuration

Before you install the System i IP Messaging software, you must have properly configured 
your Domino LDAP server. In this section, we explain the required Domino server 
configuration and Domino LDAP configuration changes.

The Global Configuration document for the Domino LDAP server must include the LDAP 
attribute types. To add the attribute types:

1. Open the Domino Administration client.

2. Click the Configuration tab.

3. In the left navigation frame, click Server → Configurations.
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4. Open the Global Configuration document, or create one if it does not already exist. The 
Global Configuration document has a server name of * - [All Servers]. To create a new 
Global Configuration document, click Add Configuration. On the Basics tab, select Use 
these settings as the default settings for all servers as shown in Figure 2-8.

Figure 2-8   Creating or modifying the Global Configuration document

5. Click the LDAP tab and click Select Attribute Types.

6. In the LDAP Attribute Type Selection window (Figure 2-9):

a. In the Object Classes field, type an asterisk (*).

b. Click the Display Attributes button.

Figure 2-9   Attribute Type Selection for IP Telephony LDAP synchronization

LDAP tab: The LDAP tab is not available until you select the Use these settings as the 
default settings for all servers option on the Basics tab.
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c. In the Selectable Attribute Types section, select the telephoneNumber attribute and 
click Add.

d. Click OK to finish adding the attribute to the Domino LDAP schema.

7. Click Save & Close.

8. End and restart the Domino server for the LDAP attribute change to take effect. You can 
do this by using either the WRKDOMSVR command or both the ENDDOMSVR and 
STRDOMSVR commands.

2.2.3  Full text indexing of the Domino Directory

You must ensure that the Domino Directory is enabled for full text search to provide adequate 
performance for LDAP services. Without the full text index created, each Domino LDAP 
search is a linear search. With a linear search, the more users there are in the directory, the 
worse the performance becomes. 

To full text index the Domino Directory:

1. Open the Domino Administration client.

2. Click the Configuration tab (Figure 2-10 on page 36).

3. In the left navigation frame, expand Directory → LDAP and click Settings.

4. Click the Edit LDAP Settings button.

5. For the Automatically Full Text Index Domino Directory? field, select Yes.

6. Click Save & Close to save your changes.

7. Stop and restart the Domino server.

Important: The telephoneNumber LDAP attribute maps to the work phone number 
field in the Person document. If this attribute type is not added to the Domino LDAP 
directory, LDAPSync will not function properly.

Tip: Our testing has shown that reloading the LDAP schema is not always sufficient. To 
be safe, stop and restart the Domino server for the LDAP schema change to take effect.

Tip: Our testing has shown that reloading the LDAP schema is not always sufficient. To 
be safe, stop and restart the Domino server to ensure that full text indexing is enabled.
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Figure 2-10   Full text indexing the Domino Directory

2.3  Configuring LDAP synchronization

In this section, we explain how to set up LDAP synchronization during the initial setup of the 
System i IP Telephony and Messaging primary server. If you plan to change the setting later, 
then follow the information in 2.4, “Reconfiguring LDAP synchronization” on page 41.

LDAP synchronization setup is done on the primary System i IP Telephony and Messaging 
server only. 

Make sure you know the following information before you start:

� Current password for user cworks on the primary System i IP Telephony server
� Host name or TCP/IP address and port number of your Domino LDAP server
� User ID and password to connect to the Domino LDAP server
� The base distinguished name (DN) for retrieving users from the Domino LDAP server

Perform the following steps to configure LDAP synchronization at the initial setup of your 
primary System i IP Telephony and Messaging server. You must run Version 7.2.5.c or later of 
this software to see the LDAP synchronization parameter. See 1.2, “Software prerequisites” 

Important: Before you install the System i IP Messaging software, you must have your 
Domino LDAP server configured properly. The required Domino server configuration and 
Domino LDAP configuration changes are explained in 2.2, “Enabling LDAP services for the 
Domino server” on page 28.

Landscape design: Discuss the design of your System i IP Telephony system landscape 
with a 3Com System i IP Telephony authorized Business Partner before you run the initial 
setup.
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on page 5, for more information. Several other parameters must be set in the setup wizard 
before and after the LDAP Synchronization parameter.

1. Open a virtual terminal session to the Linux console of your System i IP Telephony and 
Messaging server by using either of the following methods:

– Hardware Management Console (HMC) as shown in Figure 2-11

– Virtual terminal emulator of your choice (for example, PuTTY) by connecting with 
Telnet to your i5/OS partition TCP/IP address and port 2301

Figure 2-11   Opening a terminal window to the primary System i IP Telephony and Messaging partition

2. Log on as root and use the default password of pvadmin as shown in Figure 2-12.

Figure 2-12   Logging on to the System i IP Telephony and Messaging server

VCX Linux release 6.3.1
Kernel 2.6.9-34.ELvcx on an ppc64

demopri login: root
Password: pvadmin

-bash-3.00#

 

 

 

Chapter 2. LDAP synchronization 37



 

3. At the command prompt, type setup and press Enter to configure your System i IP 
Telephony and Messaging server. The configuration wizard prompts you for the network 
settings. Figure 2-13 shows the values that we used for the primary IP Telephony and 
Messaging server in our configuration.

Figure 2-13   Primary IP Telephony and Messaging server, configuring the network settings

LDAP synchronization setup: Set up LDAP synchronization at the initial installation of 
System i IP Telephony and Messaging server. However, if you plan to run, or must run, 
this setup step later, use either the steps in 2.4, “Reconfiguring LDAP synchronization” 
on page 41, or run the vcx-reconfigure command. The script reruns the same steps 
with your current settings as default values. You must stop your System i IP Telephony 
and Messaging server at that time and discontinue the replication to a secondary server 
if one is installed. After the reconfiguration, follow the guidance in the VCX 
documentation to bring all the IP Telephony servers back online and to re-establish 
replication if it was dropped.

-bash-3.00# setup
Warning: Host IP address '192.168.1.100' not found in /etc/hosts.
---------------------------------------------------------------------------
------------- Welcome to the VCX Network Configuration Wizard -------------
---------------------------------------------------------------------------

This wizard sets up networking and related services.

Configure networking now? [yes] : yes

-------------------------- Configuring Hostname ---------------------------
Enter system hostname    : demopri

--------------------- Configuring IP Interface 'eth0' ---------------------
IP Address               : 9.5.92.66
Network Subnet Mask      : 255.255.255.248
Default Gateway Address  : 9.5.92.65
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4. Complete the additional settings as prompted on the displays that follow. When you reach 
the Configuring additional parameters for Auth & Dir Service display (Figure 2-14), set the 
Enable LDAP Synchronization parameter to Y to configure LDAP synchronization. Then 
enter the LDAP server’s TCP/IP address and port number.

Figure 2-14   Configuring LDAP synchronization on the primary IP Telephony and Messaging server

Tip: If you do not see the Enable LDAP Synchronization parameter, check whether you 
are on the secondary System i IP Telephony server. You can also run the 
vcx-showversion command on your System i IP Telephony partition to check the 
installed version.

------- Configuring additional parameters for Auth & Dir Service --------

At a branch office, the password for access to the regional office system's 
'cworks' account is required.  At a regional office or on a standalone 
system, specify the 'cworks' password for access to *this* system.

Login Password                                          : cworks
Login Password (confirm)                                : cworks

VCX Authentication & Directory Services can provide support for System Speed 
Dials.  This feature must be enabled only for a single Site ID, and if 
replication is in use, the setting must be the same on the primary and 
secondary servers for that Site ID.  Note: this setting cannot be changed 
once initial setup is complete, so be certain it is set correctly.

Enable System Speed Dial Master? [N]                    : Y

The LDAP Synchronization feature automatically synchronizes user accounts on 
the VCX IP Telephony system with users retrieved from an LDAP server. To 
enable LDAP Synchronization on this system, say 'Y' here.

Enable LDAP Synchronization [N]                         : Y

LDAP Synchronization requires the host name or IP address of the LDAP Server 
with which to synchronize.

LDAP Server                                             : 9.5.92.26

What port number is used by the LDAP service on the LDAP Server?  Note that 
the default will be correct in most cases.

LDAP Server Port Number                                 : 389
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5. On the display shown in Figure 2-15, complete the following actions:

a. Provide the user name and password that are used to access the LDAP server that is 
specified in the previous step. Because we have only one LDAP directory setup, we 
use the Domino administrative user and password. This user must be stated in LDAP 
hierarchical syntax.

b. Provide the LDAP Base DN, the Synchronization Interval, and case-sensitive text to 
identify users who should not be automatically added from the LDAP directory to the 
System i IP Telephony system. 

c. Type N to continue with the next step. 

You have completed the initial setup for LDAP synchronization.

Figure 2-15   Configuring LDAP synchronization continued

What username should be used when accessing the LDAP server?

LDAP Server Username                                       : CN=Domino 
Administrator,O=ITSO       

What is the password for the LDAP server username provided previously?

LDAP Server Password                                    : itso4all
LDAP Server Password (confirm)                          : itso4all

Input the Base Distinguished Name (DN) for retrieving users from the LDAP 
server.

LDAP Base DN                                            : O=ITSO

Synchronization of information between the LDAP server and the VCX IP 
Telephony system is done on a periodic basis.  Enter the interval between 
synchronizations (in seconds).

LDAP Synchronization Interval (seconds)                 : 1800

The Non-VCX User Identifier is used to identify users which should not be 
automatically added to the VCX IP Telephony system.

LDAP Server Non-VCX User Identifier                     : non-VCX user

Do you wish to change any of the Auth & Dir Service parameters? [N] : N

Tip: To review or document your configuration, run the following command: 

vcx-config-services -show >services.txt 

Then enter the following command on your Linux partition by using the root user to 
browse the output file:

vi services.txt

Refer to Appendix B, “System i IP Telephony and Messaging server settings” on 
page 191, for the list of the parameters that we used in our test environment.
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2.4  Reconfiguring LDAP synchronization

The LDAP synchronization function must be configured and enabled in order for changes in 
the Domino LDAP directory to be synchronized to the VCX directory. The following tasks are 
involved in re-configuring LDAP synchronization:

� Configuring the LDAPSync interval
� Enabling LDAP synchronization
� Starting LDAP synchronization

The LDAPSync interval specifies how frequently changes from the Domino LDAP directory 
are synchronized to the VCX directory. The LDAPSync interval is configured through the 
Linux root access to the primary System i IP Telephony and Messaging partition. To set the 
LDAPSync interval:

1. Log into the System i IP Telephony and Messaging partition with Linux root access by 
using either of the following methods:

– Hardware Management Console

– Virtual terminal emulator of your choice (for example, PuTTY) by connecting with 
Telnet to your i5/OS partition TCP/IP address and port 2301

2. Log in by providing the appropriate user name and password. The default user name and 
password for the Linux root access are root and pvadmin respectively.

3. Change to the directory where the configLdapSync script resides:

cd /opt/3com/VCX/vcxdata/vcx-bin

4. Execute the configLdapSync script:

./configLdapSync

5. Type option b (Set LDAPSyncInterval) and press Enter if you need to change the 
LDAPSync interval. The LDAPSync interval was set in Figure 2-15 on page 40.

6. After the LDAPSync interval is set, start LDAPSync by typing option 1 (Set 
LDAPEnableStatus) and press Enter.

Important: The tool that you use for Linux root access must be enabled to use SSH.

Tip: The directory is case sensitive. Therefore, VCX must be typed in uppercase.
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7. Type Y to enable LDAP synchronization. See Figure 2-16.

Figure 2-16   Using the configLdapSync script to enable LDAPSync

8. Press Enter to return to the main menu.

9. Type option q (Exit) and press Enter to exit the configLdapSync script.

10.Now that LDAP synchronization is enabled, start LDAP synchronization by entering the 
following commands:

cd /opt/3com/components/vcxdata.version/ldapsync/bin
.vcxLdapSync start

Figure 2-17 on page 43 shows that LDAPSync has already been started on the server in 
our example.

login as: root
root@9.5.92.66's password:
Last login: Thu Aug 30 15:25:12 2007 from 9.5.92.204
-bash-3.00# cd /opt/3com/VCX/vcxdata/vcx-bin
-bash-3.00# ./configLdapSync
1) Set LDAPEnableStatus
2) Get LDAPEnableStatus
3) Set LDAPServer
4) Get LDAPServer
5) Set LDAPBaseDN
6) Get LDAPBaseDN
7) Set LDAPUsername
8) Get LDAPUsername
9) Set LDAPPassword
a) Get LDAPPassword
b) Set LDAPSyncInterval
c) Get LDAPSyncInterval
d) Set LDAPNonVCXUserID
e) Get LDAPNonVCXUserID
f) Set LDAPPortNumber
g) Get LDAPPortNumber
q) Exit

Please enter an operation:
1
Enter Y/N for LDAPEnableStatus:
Y

Tip: Replace version with the version of the LDAPSync software that is running on the 
System i IP Telephony and Messaging server. If you do not know the software version 
that is on the server, press the Tab key after you type vcxdata, and the appropriate 
version number is automatically retrieved for you.
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Figure 2-17   Starting LDAPSync by using the vcxLdapSync command

2.5  Working with the non-VCX user identifier

In this section, we explain how to add the non-VCX user identifier to a user in the Domino 
LDAP directory. We also show how you can determine the non-VCX user identifier for your 
System i IP Telephony and Messaging server.

2.5.1  Determining the non-VCX user identifier

To determine the non-VCX user identifier:

1. Log into the System i IP Telephony and Messaging partition with Linux root access by 
using either of the following methods:

– Hardware Management Console

– Virtual terminal emulator of your choice (for example, PuTTY) by connecting with 
Telnet to your i5/OS partition TCP/IP address and port 2301

2. Log in by providing the appropriate user name and password. The default user name and 
password for the Linux root access are root and pvadmin respectively.

1) Set LDAPEnableStatus
2) Get LDAPEnableStatus
3) Set LDAPServer
4) Get LDAPServer
5) Set LDAPBaseDN
6) Get LDAPBaseDN
7) Set LDAPUsername
8) Get LDAPUsername
9) Set LDAPPassword
a) Get LDAPPassword
b) Set LDAPSyncInterval
c) Get LDAPSyncInterval
d) Set LDAPNonVCXUserID
e) Get LDAPNonVCXUserID
f) Set LDAPPortNumber
g) Get LDAPPortNumber
q) Exit

Please enter an operation:
q
-bash-3.00# cd /opt/3com/components/vcxdata.7.2.74//ldapsync/bin
-bash-3.00# ./vcxLdapSync start
Copyright (C) 2006 3Com Corporation, All rights reserved.
LdapSync with those parameters already running
-bash-3.00#

Important: The tool that you use for Linux root access must be enabled to use SSH.
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3. Change to the directory where the configLdapSync script resides:

cd /opt/3com/VCX/vcxdata/vcx-bin

4. Execute the configLdapSync script:

./configLdapSync

5. Type option e (Get LDAPNonVCxUserID) and press Enter to return the 
LDAPNonVCXUserID setting. In our example, the non-VCX user identifier is non-VCX user 
as shown in Figure 2-18.

Figure 2-18   Using the configLdapSync script to determine the non-VCX user identifier

2.5.2  Applying the non-VCX user identifier in the Domino Directory

Now that the non-VCX user identifier is known, you must apply the identifier to the users in 
the Domino LDAP directory that should not be added to or should be removed from the VCX 
directory. To apply the non-VCX user identifier to users in the Domino LDAP directory:

1. Open the Domino Administration client.

2. Click the People & Groups tab.

3. Open the Person document of the user that should not be added to the VCX directory or 
should be removed if they are already synchronized to the VCX directory.

4. Click the Edit Person button to put the document in edit mode.

Note: The directory is case sensitive. Therefore, VCX must be typed in uppercase.

login as: root
root@9.5.92.66's password:
Last login: Thu Aug 30 15:39:40 2007 from 9.5.92.204
-bash-3.00# cd /opt/3com/VCX/vcxdata/vcx-bin
-bash-3.00# ./configLdapSync
1) Set LDAPEnableStatus
2) Get LDAPEnableStatus
3) Set LDAPServer
4) Get LDAPServer
5) Set LDAPBaseDN
6) Get LDAPBaseDN
7) Set LDAPUsername
8) Get LDAPUsername
9) Set LDAPPassword
a) Get LDAPPassword
b) Set LDAPSyncInterval
c) Get LDAPSyncInterval
d) Set LDAPNonVCXUserID
e) Get LDAPNonVCXUserID
f) Set LDAPPortNumber
g) Get LDAPPortNumber
q) Exit

Please enter an operation:
e
LDAPNonVCXUserID: non-VCX user
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5. Click the Miscellaneous tab (Figure 2-19).

6. Enter the non-VCX user identifier in the Comments field of the Person document.

Figure 2-19   Adding the non-VCX user identifier to the Comments field of a Person document

7. Click Save & Close to save and close the document.

2.6  Troubleshooting LDAP synchronization

Multiple areas can be the source of an LDAP synchronization failure. In this section, we 
discuss the following items that you should check to determine why LDAPSync is not working 
in your environment:

� Locating the LDAPSync log file
� Checking the status of LDAPSync
� Determining the LDAPSync synchronization interval
� User phone extension changes do not synchronize

2.6.1  Locating the LDAPSync log file

The LDAPSync log file contains error messages that are related to LDAP synchronization. 
This file is helpful when determining why LDAPSync is not working as expected. The log file is 
located in the /var/logs directory in the System i IP Telephony and Messaging Linux partition 
and is called messages.

We used a tool called WinSCP, which is a secure FTP client, to access the messages log file 
on our System i IP Telephony and Messaging server. A benefit of using a secure FTP client, 
such as WinSCP, is the ability to view the log file and to send the file by using FTP to your 
desktop to distribute to others as necessary for proper debugging.

To locate the LDAPSync log file by using the WinSCP tool:

1. Open the WinSCP tool (Figure 2-20 on page 46). Log in with root access to the Linux 
partition that is hosting the System i IP Telephony and Messaging server. Click the Login 
button to log into the Linux partition.
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Figure 2-20   Logging into the Linux partition with WinSCP

2. Navigate to the /var/logs directory and locate the messages file as shown in Figure 2-21. 
You can open the log file or send it by using FTP to your local client as necessary.

Figure 2-21   Locating the LDAPSync messages file in the /var/logs directory
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3. Open the message log file. Figure 2-22 shows an example of the contents. This example 
shows an LDAPSync conflict in adding the user MDLawn to the VCX directory because 
the phone number specified in the Domino LDAP Person document already exists in the 
VCX directory.

There are a couple of options to rectify this situation. The phone number for user MDLawn 
can be changed in their Person document in the Domino LDAP directory. Alternatively, the 
conflicting phone number in the VCX directory can be resolved. To do this, the user that 
currently has the conflicting phone number associated with their VCX account must have a 
different phone assigned to them. Refer to 2.6.4, “LDAPSync phone extension problems” 
on page 50, in which we explain both of these changes.

Figure 2-22   LDAPSync messages log file contents

2.6.2  Checking the status of LDAPSync

The status of the LDAPSync function should be checked to ensure the service is running. If 
LDAPSync is not enabled, changes in the Domino LDAP directory will not be synchronized to 
the VCX directory. Perform the following steps to check the status of the LDAPSync service:

1. Log into the System i IP Telephony and Messaging partition with Linux root access by 
using either of the following methods:

– Hardware Management Console

– Virtual terminal emulator of your choice (for example, PuTTY) by connecting with 
Telnet to your i5/OS partition TCP/IP address and port 2301

2. Log in by providing the appropriate user name and password. The default user name and 
password for the Linux root access are root and pvadmin respectively.

Sep  9 04:02:10 demopri syslog-ng[1665]: new configuration initialized
Sep  9 04:02:39 127.0.0.1 ldapsync: Adding uname = hphonenumber to VCXDATA DB
Sep  9 04:02:39 127.0.0.1 ldapsync: VcxdataDB ADD failed for username: hphonenumber
Sep  9 04:02:39 127.0.0.1 ldapsync: VcxdataDB username already exists
Sep  9 04:02:39 127.0.0.1 ldapsync: Adding uname = MDLawn to VCXDATA DB
Sep  9 04:02:39 127.0.0.1 ldapsync: VcxdataDB ADD failed for username: MDLawn
Sep  9 04:02:39 127.0.0.1 ldapsync: VcxdataDB username already exists
Sep  9 04:03:39 127.0.0.1 ldapsync: Adding uname = hphonenumber to VCXDATA DB
Sep  9 04:03:39 127.0.0.1 ldapsync: VcxdataDB ADD failed for username: hphonenumber
Sep  9 04:03:39 127.0.0.1 ldapsync: VcxdataDB username already exists
Sep  9 04:03:39 127.0.0.1 ldapsync: Adding uname = MDLawn to VCXDATA DB
Sep  9 04:03:39 127.0.0.1 ldapsync: VcxdataDB ADD failed for username: MDLawn
Sep  9 04:03:39 127.0.0.1 ldapsync: VcxdataDB username already exists
Sep  9 04:04:39 127.0.0.1 ldapsync: Adding uname = hphonenumber to VCXDATA DB
Sep  9 04:04:39 127.0.0.1 ldapsync: VcxdataDB ADD failed for username: hphonenumber
Sep  9 04:04:39 127.0.0.1 ldapsync: VcxdataDB username already exists
Sep  9 04:04:39 127.0.0.1 ldapsync: Adding uname = MDLawn to VCXDATA DB
Sep  9 04:04:39 127.0.0.1 ldapsync: VcxdataDB ADD failed for username: MDLawn
Sep  9 04:04:39 127.0.0.1 ldapsync: VcxdataDB username already exists

Important: The tool that you use for Linux root access must be enabled to use SSH.
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3. Change to the directory where the configLdapSync script resides:

cd /opt/3com/VCX/vcxdata/vcx-bin

4. Execute the configLdapSync script:

./configLdapSync

5. Type option 2 (Get LDAPEnableStatus) and press Enter to return the LDAPEnableStatus 
setting. In our example as shown in Figure 2-23, the LDAPEnableStatus returned as Y, 
meaning the LDAPSync function is running.

Figure 2-23   Using the configLdapSync script to determine the LDAPSync enabled status

Note: The directory is case sensitive. Therefore, VCX must be typed in uppercase.

login as: root
root@9.5.92.66's password:
Last login: Thu Aug 30 15:39:40 2007 from 9.5.92.204
-bash-3.00# cd /opt/3com/VCX/vcxdata/vcx-bin
-bash-3.00# ./configLdapSync
1) Set LDAPEnableStatus
2) Get LDAPEnableStatus
3) Set LDAPServer
4) Get LDAPServer
5) Set LDAPBaseDN
6) Get LDAPBaseDN
7) Set LDAPUsername
8) Get LDAPUsername
9) Set LDAPPassword
a) Get LDAPPassword
b) Set LDAPSyncInterval
c) Get LDAPSyncInterval
d) Set LDAPNonVCXUserID
e) Get LDAPNonVCXUserID
f) Set LDAPPortNumber
g) Get LDAPPortNumber
q) Exit

Please enter an operation:
2
LDAPEnableStatus: Y
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6. If the LDAPEnableStatus setting that is returned is N, type option 1 (Set 
LDAPEnableStatus) and press Enter to set the LDAPEnableStatus. Then type Y to enable 
the function. An example is shown in Figure 2-24.

Figure 2-24   Setting the LDAPEnableStatus setting to Yes

2.6.3  Determining the LDAPSync interval

If you do not know the LDAPSync interval that is being used for your System i IP Telephony 
and Messaging server, you can use the configLdapSync script to determine the setting of the 
synchronization interval:

1. Log into the System i IP Telephony and Messaging partition with Linux root access by 
using either of the following methods:

– Hardware Management Console

– Virtual terminal emulator of your choice (for example, PuTTY) by connecting with 
Telnet to your i5/OS partition TCP/IP address and port 2301

2. Log in by providing the appropriate user name and password. The default user name and 
password for the Linux root access are root and pvadmin respectively.

3. Change to the directory where the configLdapSync script resides:

cd /opt/3com/VCX/vcxdata/vcx-bin

-bash-3.00# ./configLdapSync
1) Set LDAPEnableStatus
2) Get LDAPEnableStatus
3) Set LDAPServer
4) Get LDAPServer
5) Set LDAPBaseDN
6) Get LDAPBaseDN
7) Set LDAPUsername
8) Get LDAPUsername
9) Set LDAPPassword
a) Get LDAPPassword
b) Set LDAPSyncInterval
c) Get LDAPSyncInterval
d) Set LDAPNonVCXUserID
e) Get LDAPNonVCXUserID
f) Set LDAPPortNumber
g) Get LDAPPortNumber
q) Exit

Please enter an operation:
1
Enter Y/N for LDAPEnableStatus:
Y

Important: The tool that you use for Linux root access must be enabled to use SSH.

Note: The directory is case sensitive. Therefore, VCX must be typed in uppercase.

 

 

 

Chapter 2. LDAP synchronization 49



 

4. Execute the configLdapSync script:

./configLdapSync

5. Type option c (Get LDAPSyncInterval) to return the LDAPSyncInterval setting. In our 
example, the LDAP synchronization interval is set to 1800 as shown in Figure 2-25.

Figure 2-25   Using the configLdapSync script to determine the LDAPSync interval

2.6.4  LDAPSync phone extension problems

LDAP synchronization problems that are associated with phone extensions normally happen 
when a new user who is registered in the Domino LDAP directory is provided a phone 
extension that has already been assigned to another user. In this case, the phone extension 
is locked in the VCX directory, causing LDAPSync to fail because of a conflict with the phone 
extension.

There are two options for working around this scenario:

� Change the phone extension for the new user in the Domino LDAP directory. See 
“Changing the phone extension for a user in the Domino LDAP directory” on page 51.

� Assign a different phone extension to the user in the VCX directory that currently has the 
desired phone extension assigned to them. See “Assigning a different phone extension to 
the VCX user” on page 51.

login as: root
root@9.5.92.66's password:
Last login: Thu Aug 30 15:39:40 2007 from 9.5.92.204
-bash-3.00# cd /opt/3com/VCX/vcxdata/vcx-bin
-bash-3.00# ./configLdapSync
1) Set LDAPEnableStatus
2) Get LDAPEnableStatus
3) Set LDAPServer
4) Get LDAPServer
5) Set LDAPBaseDN
6) Get LDAPBaseDN
7) Set LDAPUsername
8) Get LDAPUsername
9) Set LDAPPassword
a) Get LDAPPassword
b) Set LDAPSyncInterval
c) Get LDAPSyncInterval
d) Set LDAPNonVCXUserID
e) Get LDAPNonVCXUserID
f) Set LDAPPortNumber
g) Get LDAPPortNumber
q) Exit

Please enter an operation:
c
LDAPSyncInterval: 1800
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Changing the phone extension for a user in the Domino LDAP directory
In the majority of situations, you choose this solution to solve an LDAPSync issue associated 
with a phone extension. If a user is already registered with a specific phone number, you will 
want to provide a phone number that is not in use to the newly registered Domino user:

1. Open the Domino Administration client.

2. Click the People & Groups tab.

3. Click People in the left navigation frame to list the users in the Domino LDAP directory.

4. Edit the Person document for the user with the conflicting phone number.

5. Click the Work/Home tab and the Work subtab.

6. On the Work subtab (Figure 2-26), change the phone number in the Office phone field.

Figure 2-26   Changing the user’s phone number in the Person document of the Domino Directory

7. Save and close the Person document.

The Domino LDAP user should be properly synchronized into the VCX directory now that the 
phone number conflict has been removed.

Assigning a different phone extension to the VCX user
The other option to resolve an LDAP synchronization issue related to a phone number is to 
change the phone number for the user in the VCX directory that is currently using the phone 
number that you want to assign to the new user. 

To unassign a phone from a user and assign a new phone to the user in the VCX directory:

1. Make sure the user is logged out of the phone that is currently assigned to them.

2. Log into the Central Manager Console for the System i IP Telephony and Messaging 
partition. The default user ID and password are admin and besgroup respectively.

 

 

 

Chapter 2. LDAP synchronization 51



 

3. On the Central Manager Global Directory page (Figure 2-27), click the Site Name link for 
the Central Manager Global Directory. In our example, the Site Name is HQ.

Figure 2-27   Selecting the Site Name link in the Central Manager Global Directory
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4. As shown in Figure 2-28, click the Phones link under the Phones column for the user to 
whom you want to unassign a phone number. 

Figure 2-28   Selecting the Phones link under the Phones column for the user

5. Select the user you for whom want to change the phone number and click the Unassign 
Selected button as shown in Figure 2-29.

Figure 2-29   Unassigning a phone for a VCX user

6. In the window that prompts you to confirm the action to unassign the phone for the user, 
click OK.
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The LDAPSync function is now able to add the newly registered user in the Domino LDAP 
directory that was assigned the same phone number as the existing user in the VCX directory. 
You will also want to assign a new phone to the user that had the desired phone extension 
previously assigned to them.
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Chapter 3. Sametime integration

In this chapter, we describe the steps that are necessary to enable the System i IP Telephony 
capabilities in the Lotus Sametime Connect client when the Sametime server is running on 
i5/OS V5R3 or later. We discuss the following topics:

� “IP Telephony collaboration functions in Sametime” on page 56
� “Installing and setting up IP Telephony integration with Sametime” on page 58
� “Installing the IP Telephony presence plug-in in the Sametime Connect client” on page 72
� “Verifying Sametime integration with System i IP Telephony” on page 84
� “Troubleshooting Sametime integration with IP Telephony” on page 106

3
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3.1  IP Telephony collaboration functions in Sametime

Sametime is real-time collaboration software that consists of client and server applications 
that enable a community of users to collaborate in real-time online meetings over an intranet 
or the Internet. Sametime users can run collaborative activities such as online awareness, 
presence, chat, screen sharing, a shared whiteboard, and real-time audio and video 
capabilities to meet, converse, and work together in instant or scheduled meetings.

Figure 3-1 illustrates the functions that Lotus Domino and Sametime integration with System i 
Telephony Solution provides to the user.

Figure 3-1   IP Telephony integration with Domino and Sametime

The integration of Sametime and System i IP Telephony offers the following features:

� Telephony presence

Telephony presence allows a Sametime user to know in real time the contact status of a 
person they want to reach. Specifically, it indicates whether a person is currently on the 
phone. This information is collected by the Sametime Connect client user interface from 
the System i IP Telephony solution. A user does not have to be logged into Sametime for 
their telephone presence to be available.

� Click-to-dial feature

The click-to-dial feature allows Sametime users to call a phone number simply by clicking 
it. This feature is pervasive across the Sametime Connect client and is available within a 
chat window. It helps Sametime users to avoid the following actions: 

– Searching a contact’s phone number, because it is looked up automatically
– Dialing the number from the desktop hard phone

Sametime users can start (dial) the call from the Sametime Connect client and then use 
their desktop telephone to talk to and finish the conversation.

Click-to-dial feature: The click-to-dial feature from the Lotus Notes client is available with 
Domino 8, which includes Sametime version 7.5.1.
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� Click-to-call feature

The click-to-call feature allows online users to change easily from the context of their 
Sametime Connect user interface to the desktop hard phone or PC-based Voice over 
Internet Protocol (VoIP) client. Users can either place a call over the computer by using 
VoIP technology or request an immediate callback by entering a phone number.

IBM Sametime 7.5.1 requires a System i IP Telephony solution in order to provide this 
capability. It also requires telephone devices to carry out the call.

� Click-to-talk feature

The click-to-talk feature is quite different from the click-to-call feature. The click-to-talk 
feature provides the ability for instant messaging users to click an icon or menu option and 
talk to the contact they choose in real time over the Internet in a peer-to-peer basis 
communication. This feature uses mainly the PC audio and voice-based capabilities, as 
speakers, microphones, and headsets, instead of hard phone devices that the click-to-call 
function can use.

IBM Sametime 7.5 provides the click-to-talk feature without any additional product 
requirements. We do not include this function in our discussion in this book.

� Click-to-conference feature

Conference features are becoming an integral part of many new communication services. 
Next generation conference systems, such as the System i IP Telephony solution, must 
smoothly integrate with other third-party applications such as Sametime. Part of this 
integration allows you to perform the following functions:

– Select a list of participants in a Web conference session and invite them into a 
conference call managed by the IP-PBX. There is no need to look up phone numbers 
or dial them and permit to control specific aspects of individual conference participants.

– Add more attendees or remove them one at a time as you need.

– Create, schedule, and manage collaboration sessions that involve, among other 
resources, a telephone audio feature.

Important: For correct operation of these functions with the System i IP Telephony 
solution and the integration with Sametime, you are required to use 3Com telephones.
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Figure 3-2 shows the functions of integrating Sametime and System i IP Telephony.

Figure 3-2   IP Telephony Collaboration functions with Sametime

3.2  Installing and setting up IP Telephony integration with 
Sametime

In this section, we explain how you enable 3Com IP Telephony integration for Sametime. We 
provide step-by-step instructions for the installation and configuration of the Telephony 
Service Provider Interface (TCSPI) in order to permit the integration between Sametime and 
System i IP Telephony.

For more information regarding TCSPI, see IBM Lotus Sametime 8.0 Telephony 
Conferencing Service Provider Interface (TCSPI) Implementer Guide, SC23-8704.

3.2.1  Planning

There are several environmental characteristics and resources that you should have 
available, as explained in this section, in order to install and configure the IP Telephony 
collaboration services. In addition, you must have all of the prerequisites that are discussed in 
1.2, “Software prerequisites” on page 5.

Assumptions
In planning for the integration, we assume that you have the following components and 
configurations:

� You have already installed and configured the following products:

– Domino 7.0 or later in an i5/OS partition
– Sametime 7.5.1 or later in an i5/OS partition
– System i IP Telephony software in its own Linux partition on the System i machine
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� You have configured and activated Lightweight Directory Access Protocol (LDAP) 
synchronization between the System i IP Telephony solution and the Domino server. See 
2.3, “Configuring LDAP synchronization” on page 36, and 2.4, “Reconfiguring LDAP 
synchronization” on page 41, for details.

� You are using 3Com hard phones.

Required information
You must provide the following information for the TCSPI software installation and 
configuration scripts:

� IP address for the primary System i IP Telephony logical partition (LPAR)
� IP address for the secondary System i IP Telephony LPAR
� Conference bridge number
� IP address and host name for the Domino LDAP server
� IP address and host name for the System i IP Conferencing LPAR
� Password for the Domino Administrator user in the Sametime server

Network configuration
If the Domino server and any System i IP Messaging LPARs reside on the same System i 
machine, the Domino server might encounter a problem trying to access the System i IP 
Messaging partition. The problem may occur if the System i IP Messaging partition is using 
virtual networking and the i5/OS partition in which the Domino server is running performs 
proxy Address Resolution Protocol (ARP) for the virtual network. 

To prevent this problem, perform the following steps:

1. Start an SSH session and log in as root (default password is pvadmin) to each System i IP 
Messaging partition that is configured for virtual networking and resides on the same 
System i machine as the Domino server.

Tip: See 4.3.4, “Adding Domino and SMTP to the System i IP Telephony configuration” 
on page 134, for information about how to install Cygwin and start an SSH session to a 
System i IP Messaging partition.
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2. On the Linux command line of the SSH session, modify the firewall ipm_table_sock as 
shown in figure Figure 3-3 by entering the following command:

modfw -p ipm_table_sock allow i5/OS_virtual_LAN_IP_address 

In our example, 9.5.92.65 is the i5/OS virtual LAN IP address:

modfw -p ipm_table_sock allow 9.5.92.65

Figure 3-3   Modifying ipm_table_sock using Cygwin SSH session

3.2.2  Installing the TCSPI software on the i5/OS partition

In this section, we explain how to install the TCSPI software into the i5/OS partition from the 
3Com VCX software media. This procedure entails the following tasks:

� “Installing TCSPI” on page 60
� “Ending the Sametime server” on page 64
� “Configuring TCSPI” on page 65
� “Enabling TCSPI on the Sametime server” on page 68
� “Restarting the Sametime server” on page 69

Installing TCSPI
To install the TCSPI software:

1. Load the 3Com VCX IP Telephony and Messaging DVD into the System i DVD player. 
Alternatively, mount the proper image volume in the image catalog of your System i 
machine where the Sametime server is already installed and configured.

ISO image: You can create an ISO image for this DVD and mount it to a virtual optical 
device in i5/OS. For more information regarding this i5/OS feature, see Appendix A, 
“Virtual CD library” in Implementing POWER Linux on IBM System i Platform, 
SG24-6388.
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2. Locate the integration package file, IPTelephonySPI-7.2.74.1.tar, on the 3Com IP 
Telephony and Messaging DVD in the I5OS folder by using iSeries Navigator as shown in 
Figure 3-4.

Figure 3-4   IPTelephony SPI file location

3. Start an i5/OS 5250 emulation session and sign on with a user profile that has *ALLOBJ 
authority.

4. Create a directory in the i5/OS integrated file system. For our example, we created a 
directory called /iptcollab by using the following Create Directory (CRTDIR) CL command:

CRTDIR DIR(iptcollab)

IPTelephonySPI file: Be aware that the IPTelephonySPI file name depends on the 
software version. In this case, we use version 7.2.74.1.
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5. Copy the IPTelephonySPI-7.2.74.1.tar file to the directory that you created in the previous 
step. By using iSeries Navigator, you can copy and paste the file as shown in Figure 3-5.

Figure 3-5   Copying the IPTelephonySPI-7.2.74.1.tar file to the i5/OS directory

6. Start an i5/OS Qshell command entry by typing the STRQSH CL command and pressing 
Enter.

i5/OS CL command alternative: You can also copy the IPTelephonySPI-7.2.74.1.tar 
file from an i5/OS 5250 emulation session by using the following Copy (CPY) CL 
command:

CPY OBJ('/QOPT/VCXINSTALLER-7.2.5C/I5OS/IPTelephonySPI-7.2.74.1.tar') 
TODIR('/iptcollab') 

Attention: If your QCCSID system value is different from 37 (USA), you must change it 
for your current job by using the following Change Job (CHGJOB) CL command:

CHGJOB CNTRYID(US) CCSID(37)
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7. On the QSH Command Entry display (Figure 3-6), change directory to your selected 
directory, which is /iptcollab in our example, and unpack the IP Telephony SPI services by 
using the pax command.

Figure 3-6   Unpacking the IPTelephonySPI-7.2.74.1.tar file

After the pax command ends, you see messages like those that are shown in Figure 3-7.

 

Figure 3-7   IPTelephonySPI-7.2.74.1.tar successfully unpacked

Important: You must use the -C parameter with code 819.

                              QSH Command Entry                             

> cd /iptcollab
   $                                                                                                                                
 > ls                                                                                                                               
   IPTelephonySPI-7.2.74.1.tar                                                                                                      
   $                                                                                                                                
                                                                                                                                    
===> pax -rv -C 819 -f IPTelephonySPI-7.2.74.1.tar                                                                                 
                                                                                                                                                                                                                                                                                                                                                                                                            
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                                                                      
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 

Tip: You can check the unpacked files by using iSeries Navigator or NetServer™ 
services and displaying the contents of the directory.

                                QSH Command Entry                                    
                                                                                                                                    
   config.sh                                                                                                                        
   install.sh                                                                                                                       
   lib/IPTelephonyClient.jar                                                                                                        
   lib/IPTelephonySPI.jar                                                                                                           
   lib/WSSecurity.jar                                                                                                               
   lib/XmlSchema.jar                                                                                                                
   lib/axiom.jar                                                                                                                    
   lib/axis.jar                                                                                                                     
   lib/backport-util-concurrent.jar                                                                                                 
   lib/commons.jar                                                                                                                  
   lib/stax-api.jar                                                                                                                 
   lib/wstx-asl.jar                                                                                                                 
   lib/xercesImpl.jar                                                                                                               
   lib/xml-apis.jar                                                                                                                 
   pax: 001-2298 For archive file IPTelephonySPI-7.2.74.1.tar and volume 1, 19 
files were processed with 0 bytes read and 4188160 bytes written. 
   $                                                                                                                                
                                                                                                                                    
 ===>
                                                                                                                                    
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                                                                      
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 

 

 

 

Chapter 3. Sametime integration 63



 

Ending the Sametime server
After you unpack the IP Telephony SPI services file and before you configure it, you must shut 
down the Sametime server:

1. From iSeries Navigator, click Network → Servers → Domino to retrieve a list of Domino 
servers configured on your system.

2. In the right pane, right-click the Sametime server and select Stop → Server as shown in 
Figure 3-8.

Figure 3-8   Stopping the Sametime server

i5/OS CL command alternative: You can also stop the Sametime server from a 5250 
emulation session by using the following End Domino Server (ENDDOMSVR) CL 
command:

ENDDOMSVR SERVER(demost) OPTION(*CNTRLD) 

In this example, the Sametime server is called demost.
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Configuring TCSPI
To configure the TCSPI software:

1. Start an i5/OS Qshell command entry by typing the STRQSH CL command and pressing 
Enter.

2. In the QSH Command Entry display, change to the directory where you unpacked the 
TCSPI software, which is /iptcollab in our example, and call the install.sh script as shown 
in Figure 3-9.

Figure 3-9   Running the TCSPI installation script

Important: You must repeat this procedure for each Sametime server that you want to 
connect to the System i IP Telephony solution.

Attention: You must run this install procedure only once because the install.sh script 
copies several Java archive (JAR) files into the /QIBM/ProdData/LOTUS/Sametime/
telephony_ext directory. 

In addition, the install.sh script uses the default SDK Toolkit Web services user ID 
(wsuser) and password (wspwd). Therefore, if you change the default SDK Toolkit Web 
services user and password, you must first follow the instructions in this section. Then 
follow the steps in 3.2.3, “(Optional) Reconfiguring and enabling the Sametime server” 
on page 70. Finally complete the steps in “Enabling TCSPI on the Sametime server” on 
page 68.

                              QSH Command Entry                      
                                                                                                                                    
   config.sh                                                                                                                        
   install.sh                                                                                                                       
   lib/IPTelephonyClient.jar                                                                                                        
   lib/IPTelephonySPI.jar                                                                                                           
   lib/WSSecurity.jar                                                                                                               
   lib/XmlSchema.jar                                                                                                                
   lib/axiom.jar                                                                                                                    
   lib/axis.jar                                                                                                                     
   lib/backport-util-concurrent.jar                                                                                                 
   lib/commons.jar                                                                                                                  
   lib/stax-api.jar                                                                                                                 
   lib/wstx-asl.jar                                                                                                                 
   lib/xercesImpl.jar                                                                                                               
   lib/xml-apis.jar                                                                                                                 
   pax: 001-2298 For archive file IPTelephonySPI-7.2.74.1.tar and volume 1, 19 
files were processed with 0 bytes read and 4188160 bytes written. 
                                                                                                                                    
 ===> ./install.sh                                                                                                                  
                                                                                                                                                                                                                                                                       
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                                                                      
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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3. The install.sh script prompts you for following information:

– Primary Web Service Server

This is the host name associated with primary System i IP Messaging LPAR in your 
Domain Name System (DNS) server. If you do not use a DNS server, you can enter the 
IP address.

– Secondary Web Service Server

This is the host name associated with secondary System i IP Messaging LPAR in your 
DNS server. If you do not use a DNS server, you can enter the IP address.

– Conference bridge number

This number is used in the Sametime Web Conference graphical user interface (GUI). 
You use the number when you create an Instant Meeting conference (see “Clicking to 
instant meeting conference from the Sametime contact list” on page 96) or in a 
schedule conference (see “Clicking to conference from a Sametime meeting invitation” 
on page 101).

In our specific environment, this number matches the number that is defined in the 
System i IP Telephony Messaging partition as the Conference Attendant extension 
(7777) in route plans, but it could be other extensions, a different conference service 
provider, or an external number. In Figure 3-10, the Conference Attendant is 
associated with port 5092 in the System i IP Conferencing module as shown in 
Figure 3-11 on page 67.

Figure 3-10   Route Plans - Conference Attendant

DNS host name versus IP address: If you use DNS host names instead of IP 
addresses, the integration between Sametime and System i IP Telephony depends 
on the reliability and availability of the DNS server.
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Figure 3-11   System i IP Conferencing port for Conference Attendant

Figure 3-12 shows an example of the install.sh script answers based on our test 
environment.

Figure 3-12    Installing and configuring TCSPI

4. With this input data, the install.sh script creates the IPTelephonyProperties.xml file. You 
can see this file and verify the information by using the Display File (DSPF) CL command: 

DSPF STMF('/Domino/demost/IPTelephonyProperties.xml')

If the data values in this file are correct, continue to next section. If not, and you must 
change any value or change the default SDK Toolkit Web services user ID and password, 
go to 3.2.3, “(Optional) Reconfiguring and enabling the Sametime server” on page 70. 

                              QSH Command Entry 
                                                                                                                                    
   lib/xercesImpl.jar                                                                                                               
   lib/xml-apis.jar                                                                                                                 
   pax: 001-2298 For archive file IPTelephonySPI-7.2.74.1.tar and volume 1, 19 
files were processed with 0 bytes read and 4188160 by
   tes written.                                                                                                                     
   $                                                                                                                                
 > ./install.sh                                                                                                                     
   Copying files to ProdData ...                                                                                                    
                                                                                                                                    
   Updating server: DEMOST                                                                                                          
   Enter the Primary Web Service Server :                                                                                           
 > 9.5.92.66                                                                                                                        
   Enter the Secondary Web Service Server :                                                                                         
 > 9.5.92.67                                                                                                                        
   Enter the Conference Bridge Number :                                                                                             
 > 7777 
   1 servers updated                                                                                                                
   $                                                                                                                                
                                                                                                                                    
 ===>                                                                                                                               
F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                                                                      
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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Then return to the following section, “Enabling TCSPI on the Sametime server”, and 
complete the steps there.

Enabling TCSPI on the Sametime server
After you install and configure the TCSPI services, you must enable the services on the 
Sametime server. Perform the following steps on each Sametime server that you want to 
connect to the System i IP Telephony solution:

1. From iSeries Navigator, click Network → Servers → Domino to retrieve a list of Domino 
servers configured on your system. Right-click the Sametime server and select Start.

2. From a Web browser, enter the Sametime Center URL, for example:

http://demost.iptdemo.com/stcenter.nsf

3. In the left pane of the Welcome page (Figure 3-13), click Administer the server and sign 
in with the Domino Administrator user ID and password.

Figure 3-13   Administering the Sametime server

4. In the left navigation frame, under Configuration, click Meeting Services.

i5/OS CL command alternative: You can also start the Sametime server by entering 
the following Start Domino Server (STRDOMSVR) CL command:

STRDOMSVR SERVER(demost)

In this example, the Sametime server is called demost.
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5. In the Configuration - Meeting Service pane (Figure 3-14), select the Allow people to 
schedule a telephone conference call for web conference. A telephony services 
provider is required check box. 

Figure 3-14   Enabling Web conferencing with System i IP Telephony

6. Scroll down to the bottom of the page and click the Update button (Figure 3-15).

Figure 3-15   Updating the Sametime configuration

Restarting the Sametime server
You must restart the Sametime server in order to update the configuration settings. Then you 
can verify whether the TCSPI service is activated. 

1. Stop and start the Sametime server.

2. From a Web browser, go to Sametime Center administration Web page. In our example, 
we go to the following Web page:

http://demost.iptdemo.com/stcenter.nsf

3. Click the Administer the server link and sign in with the Domino Administrator user ID 
and password.
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4. Confirm that the TCSPI service is running by verifying that the status of Telephony 
Services (sttelephny) is Running as shown in Figure 3-16.

Figure 3-16   Telephony services running in the Sametime server

If you reach this point successfully, the Sametime server and System i IP Telephony have 
been configured and enabled to collaborate. Continue with 3.3, “Installing the IP Telephony 
presence plug-in in the Sametime Connect client” on page 72.

3.2.3  (Optional) Reconfiguring and enabling the Sametime server

You must follow the instructions as explained in this section if you need to change information 
in the TCSPI services in regard to any of the following items:

� Primary Web Service server
� Secondary Web Service server 
� Conference Bridge Number values
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You must also follow these steps in the following situations:

� You previously changed the default user ID or password of the SDK Toolkit Web services 
in the primary and secondary System i IP Messaging partitions.

� You decide to configure the TCSPI services with a SDK Toolkit Web services user or 
password different from the default when you are running this script. 

In this case, after you complete the steps, you must change the user ID and password by 
using the axis2cfg script in the primary and secondary System i IP Messaging partitions. 
This file is located in the /opt/3com/VCX/axis2/scripts/ directory of each partition.

To reconfigure and enable the Sametime server:

1. Start an i5/OS 5250 emulation session with a user profile that has *ALLOBJ authority.

2. Start an i5/OS Qshell command entry by typing the STRQSH CL command and pressing 
Enter.

3. In the QSH Command Entry display (Figure 3-17), change to the directory in which you 
unpacked the TCSPI software (which is /iptcollab in our example) and run the config.sh 
script.

Figure 3-17   Reconfiguring the TCSPI with the config.sh script

4. The config.sh script prompts you for following information:

– Primary Web Service Server

This is the host name that is associated with primary System i IP Messaging LPAR in 
your DNS server. Alternatively, if you do not use a DNS server, you can enter the IP 
address.

– Secondary Web Service Server

This is the host name that is associated with secondary System i IP Messaging LPAR 
in your DNS server. Alternatively, if you do not use DNS server, you can enter the IP 
address.

– Conference Bridge Number

This is the number that is used in the Sametime Web Conference GUI.

– Web Service Admin User

This is the admin user name that is used in the Sametime Web Conference GUI. The 
default user is wsuser.

                           QSH Command Entry                                
                                                                                
 > cd /iptcollab                                                                
   $                                                                            
                                                                                
                                                                                                                                                                
                                                                                
 ===> ./config.sh                                                               
                                                                                                                                                                                                                                                
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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– Web Service Admin password

This is the admin password that is used in the Sametime Web Conference GUI. The 
default password is wspsw.

5. With the input data, the config.sh script updates the IPTelephonyProperties.xml file. You 
can display this file and verify the information by entering the following Display File (DSPF) 
CL command:

DSPF STMF('/Domino/demost/IPTelephonyProperties.xml')

If the data values in this file are not correct, run the config.sh script again with the proper 
input data.

If the data values are correct, but you are installing and configuring the Sametime server 
for the first time and you are doing this step because you are using a different user or 
password for the SDK Toolkit Web services, return to “Enabling TCSPI on the Sametime 
server” on page 68. 

3.3  Installing the IP Telephony presence plug-in in the 
Sametime Connect client

After the Sametime and System i IP Telephony and Messaging servers are configured and 
enabled for collaboration, you must install the Sametime client presence plug-in called the 
Sametime LineStatus Plugin for 3Com IP Telephony. You install the plug-in into the Sametime 
Connect client on each of your user’s PC workstations in order to take advantage of the IP 
Telephony integration features.

The Sametime LineStatus Plugin for 3Com System i IP Telephony is packaged as an Eclipse 
plug-in that allows administrators to choose the way they want to deliver this software to 
users. Users do not need to do any special configuration for access to the IP Telephony 
presence and collaboration features. They download the plug-in directly from the System i IP 
Telephony and Messaging server by using the Sametime plug-in management tools.

Administrators also have the option to deploy the Sametime presence plug-in on a separate 
update server. This option is useful to customers who maintain setup policies that force or 
restrict the download of the plug-in to any or all members of their Sametime community. They 
do this by using centralized update servers for all their custom and third-party Eclipse or 
Sametime updates.

Important: The admin user name and password must match the SDK Toolkit Web 
services user name and password.

Important: If the Web services user name (wsuser) and password (wspsw) settings are 
modified with the axis2cfg script, those changes are reflected in the Sametime presence 
plug-in package on the server. Clients that have already received and downloaded the 
plug-in must remove it and reinstall it, so that they can pick up the new configuration 
parameters. Meanwhile, IP Telephony status for their Sametime contacts is displayed as 
unknown, because the plug-in is unable to authenticate with the System i IP Telephony and 
Messaging server.
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3.3.1  Installing the plug-in

In this section, we explain how to install and configure the Sametime presence plug-in in a 
Sametime Connect client from the System i IP Telephony and Messaging primary partition. 

To install and configure the Sametime presence plug-in:

1. Start the Sametime Connect client on your workstation. 

2. From the menu bar, select Tools → Plug-Ins → Install Plug-Ins (Figure 3-18).

Figure 3-18   Selecting the Sametime plug-in installer

IPTelephonyPlugin.jar file: You might not want the plug-in to be downloadable from one 
of the System i IP Telephony and Messaging servers, but would rather have it be made 
available from a different server. In this case, you can obtain the IPTelephonyPlugin.jar file 
from the System i IP Telephony and Messaging server in the /opt/3com/VCX/ipwservice
/vcx-html/linestatus directory. You can extract the file into a directory on a different update 
server by using the jar tool. To use this option, administrators must be familiar with setting 
up update sites.

Important: The contents of update site must be updated if there is a new version of the 
plug-in or its initialization parameters are changed on the System i IP Telephony and 
Messaging server. The initialization parameters include the System i IP Telephony address 
or the SDK Toolkit Web services user or password.
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3. In the Feature Updates window (Figure 3-19), select Search for new features to install 
and click Next.

Figure 3-19   Sametime plug-in installer
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4. In the Update sites to visit window (Figure 3-20):

a. Click the New Remote Site button.

b. In the New Update Site window (inset in Figure 3-20):

i. For Name, type the name of the server that hosts the plug-in.

ii. For URL, type the URL of the download location on the System i IP Telephony and 
Messaging server in the following format:

http://ip_address_or_host_name_of_System i IP Messaging_server/linestatus

In our example demopri.iptdemo.com is the name of System i IP Telephony and 
Messaging primary partition.

iii. Click OK.

c. Back in the Update sites to visit window, click Finish.

Figure 3-20   Selecting the server where the Sametime presence plug-in is located
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5. In the Search Results window (Figure 3-21), expand the server that contains the 
Sametime presence plug-in and select the check box of the feature. Click Next.

Figure 3-21   Selecting the Sametime presence IP Telephony plug-in
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6. In the Feature License window (Figure 3-22), read the license agreement. If you 
understand it, select I accept the terms in the license agreement and click Next.

Figure 3-22   License agreement

 

 

 

Chapter 3. Sametime integration 77



 

7. In the Installation window (Figure 3-23), click Finish.

Figure 3-23   Installation directory of the Sametime IP Telephony presence plug-in
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8. In the Feature Verification window (Figure 3-24), click Install.

Figure 3-24   Plug-in feature verification

9. In the Install/Update window (Figure 3-25), you are prompted to restart your Sametime 
client. Click Yes.

Figure 3-25   Restarting the Sametime client
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You should now see IP Telephony presence icons in your Sametime Connect client as shown 
in Figure 3-26.

Figure 3-26   IP Telephony presence icons in the Sametime Connect client

You need to add yourself to your contact list to see your line status being updated. The line 
status is only updated for contacts who have a reachable phone number. As you can see in 
Figure 3-26, the line status is visible regardless of the Sametime status (logged in, logged 
out, or busy). Three states are available for IP Telephony line status:

Line Free Green telephone icon next to the Sametime status icon.

Line Busy Green telephony icon with a stop sign through it next to the Sametime status 
icon.

Line Status Unknown
A telephone icon next to the Sametime status icon that is unavailable.

3.3.2  Setting the Sametime Connect client preferences

From the Sametime Connect client, you can configure the phone numbers of how you want to 
be reached. In this section, we explain how to configure the following preferences:

� “Conference preferences” on page 81
� “Notification preferences” on page 82
� “Geographic location preferences” on page 84
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Conference preferences
To configure the number at which you will want to join in a conference: 

1. From the Sametime Connect client, select File → Preferences.

2. From the Preferences window (Figure 3-27), in the left navigation frame, click Telephony.

3. In the Telephony pane on the right:

a. Confirm that IP Telephony Service is displayed in the Conference Call Settings, 
Service Location field. 

b. Under Conference Options, for Number at which I will join the call field, enter your 
telephone number to receive call conferences.

For example, if you receive your conference calls from a telephone different from your 
office extension, you enter that telephone number here. In our example, we use the 
same number for the internal extension and conference calls (1707). This value can be 
an external number. In any case, be sure the number fulfills the dialing plan rules that 
are configured in the IP Telephony solution. 

c. Click Apply and then click OK.

Figure 3-27   IP Telephony preference in the Sametime Connect client
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Notification preferences
Notification preferences help you to define how Sametime informs you when a telephone call 
or conference call is initiated. To configure your notification preferences:

1. From the Sametime Connect client, select File → Preferences.

2. In the Preferences window (Figure 3-28), in the left navigation frame, click Notifications.

3. In the Notifications pane on the right, click the Event Settings tab.

a. Under Event specific notifications, click One-on-one phone conferences. 

b. Under Notification options, select your preferences. For example, if you want a hard 
phone to ring when someone tries to reach you without any message in your computer, 
choose Ring phone. 

Figure 3-28   Notification preferences in the Sametime Connect client, one-on-one conference options

 

 

 

82 IBM System i IP Telephony and Integrated Collaboration



 

c. Under Event specific notifications, click Invitations to multi-party conferences. Then 
under Notification options, select your preferences (Figure 3-29).

Figure 3-29   Notification preferences in the Sametime Connect client, multi-party conference options

d. Click Apply and then click OK.
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Geographic location preferences
You also should define the geographic location preferences to define the phone number 
where you can be reached when any Sametime member calls you. To configure the 
geographic location preferences:

1. From the Sametime Connect client, select File → Preferences.

2. In the Preferences window (Figure 3-30):

a. In the left navigation frame, click Geographic Location.
b. In the right pane, enter the Primary phone number.
c. Click Apply and then click OK.

Figure 3-30   Setting the Geographic Location preferences

You are now ready to use the new IP Telephony presence, click-to-dial, click-to-call, and 
click-to-conference integration features that are enabled by the integration of Sametime and 
the System i IP Telephony solution.

3.4  Verifying Sametime integration with System i IP Telephony

After you install, configure, and enable the Sametime integration with System i IP Telephony, 
you can perform the following functions:

� View telephony users presence
� Click to dial
� Click to call
� Click to conference

In this section, we show you how to take advantage of these new capabilities in your 
Sametime Connect client.
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3.4.1  Telephony presence

Telephony presence is automatically activated with the TCSPI plug-in. Line status is only 
updated for contacts who have a reachable phone number. As you can see in Figure 3-26 on 
page 80, line status is visible regardless of the Sametime status (logged in, logged out, or 
busy). Three states are available for IP Telephony line status:

Line Free Green telephone icon next to the Sametime status icon.

Line Busy Green telephony icon with a stop sign through it next to the Sametime status 
icon.

Line Status Unknown
A telephone icon next to the Sametime status icon that is unavailable.

3.4.2  Click to dial

In order to verify the click-to-dial function, you should generate a call to a member of the 
Sametime community. In this section, we show you two different ways to do this, from a 
contact list and from a text chat.

From a contact list
From your Sametime Connect client, select a person listed from the contact list, right-click, 
and select Call → Start a Call as shown in Figure 3-31. This action dials the telephone 
number or extension that the person (in this example Rob Haviland) defined for their 
Geographic Location preference as described in “Geographic location preferences” on 
page 84. 

You also can change the telephone number where you will attend the call. For example, you 
might be in an office in your home, on your mobile, or in a meeting room and need to originate 
the call there. In this case, use the Call me at option and provide the other telephone number. 
This phone number must fulfill the dialing plan that is defined in the System i IP Telephony 
solution. For example, in the System i IP Telephony solution, if you configured that your users 
must first dial the number 9 before they dial an external number, then here you must enter a 9 
and the external phone number where you want to be reached.

Figure 3-31   Testing click to dial
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A window (Figure 3-32) opens that informs you that your call is in progress.

Figure 3-32   Waiting response to the phone call

In this example, a window (Figure 3-33) opens for Rob Haviland at extension 1704 that 
prompts him to accept a call from Jairo Reyes, who was the originator of the call. Rob clicks 
the Join Call button to answer the phone call.

Again, the first option for the phone number in the Number at which I will join the call field is 
the number that your partner has defined for the Geographic Location preference. See 
“Geographic location preferences” on page 84 for more information.

Figure 3-33   Incoming call window

Tip: You can avoid this message if you choose the Ring phone parameter in the 
Notification preferences as shown in Figure 3-28 on page 82. 
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If you are calling someone who is out of the office, that person can accept the phone call from 
a number that is different from their extension, which is 1704 in this example. The person 
changes the number in the Number at which I will join the call field by selecting the Add 
number option as shown in Figure 3-34. The number can be an external phone number.

Figure 3-34   Adding a different phone number from which to join a call

When the call is accepted, both hard phones ring and are ready to start the call. During the 
call progress, you see a status, such as Connected, as shown in Figure 3-35.

Figure 3-35   Call in progress

While the call is in progress, as the call originator or moderator, you can add new users to the 
call (creating a conference), disconnect participants, or end the call from this window.

Moderator: As the moderator, if you close your conference status window during the call, 
the call ends and all the participants are disconnected.
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Regarding telephony presence, all Sametime users who have these two users, Jairo and Rob, 
in their contact list will see a busy status by their names because they are using their 
telephones (Figure 3-36). 

Figure 3-36   IP Telephony presence - busy status

After the call ends, the Line status icons return to the Line free status (green telephone).

From a text chat
You also have the option to reach a person with whom you already have a text chat session 
started. To click to dial from a text chat session:

1. Start a chat session in the Sametime Connect client. 

2. Select the person you want to call, right-click, and select Chat (Figure 3-37). 

Figure 3-37   Starting a Sametime text chat session
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3. In the active text chat window (Figure 3-38), click the Telephone icon to start a phone call 
with one or more people.

Figure 3-38   Click to dial from a text chat session
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3.4.3  Click to conference

The click-to-conference feature supports three types of conferencing modes. In this section, 
we explain each of these modes and how to access the conference service.

Conferencing modes
The System i IP Telephony solution supports the following types of conferencing modes:

� Conferences that consist of no more than three participants

In this case, the conferencing and audio mixing is done on the 3Com phones, and no IP 
Telephony conferencing server is used. By using this option, you can have unlimited 
conferences of up to three participants. In addition, you can create networks of 
conferences where the telephones connect groups of up to three participants in order to 
create bigger conferences. Figure 3-39 illustrates this mode.

Figure 3-39   Conferencing based on hard phones
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� Ad hoc conferences of up to six participants, which work in conjunction with the previous 
mode of phone conferencing

When a fourth party is added to a conference, the entire conference is shifted to the ad 
hoc conference server that is part of every standard System i IP Telephony bundle. The 
System i IP Telephony solution has 30 ports available to support ad hoc conferences. At a 
maximum, it is possible to have up to five conferences of up to six individuals. Figure 3-40 
illustrates this mode.

Figure 3-40   Ad hoc conferences
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� For a conference over six participants, the System i IP Conferencing mode 

This mode must be used with an additional price and capabilities (Figure 3-41). The 
following conference types are supported by this mode:

– Scheduled conference
– Meet me conference
– Ad hoc conference
– Instant conference
– Emergency conference

For more information about the IP Conferencing module, refer to the IP Conferencing 
Module Administration Guide:

http://support.3com.com/infodeli/tools/vcx/71/IPCM_7.1_Admin_Guide.pdf

Figure 3-41   Conferencing based on the System i IP Conferencing mode

Verifying the click-to-conference service
A Sametime user can access the conference service that is provided by the integration of 
Sametime and the System i IP Telephony solution in several ways. In this section, we explain 
how to perform the following tasks:

� “Clicking to conference from a click-to-call instance” on page 93
� “Clicking to conference from the contact list” on page 95
� “Clicking to instant meeting conference from the Sametime contact list” on page 96
� “Clicking to conference from a Sametime meeting invitation” on page 101
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More than six 3Com telephones

. . . . .
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. . . . .

. . . . .
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Clicking to conference from a click-to-call instance
To click to conference from a click-to call instance:

1. Follow the steps in 3.4.2, “Click to dial” on page 85. 

2. When a call is in progress, click the Invite others icon to invite a new user (Figure 3-42).

Figure 3-42   Conference invitation icon

In the window that opens, you can choose to invite more Sametime community members. 
When they accept the invitation, you see the status in the window status like the example in 
Figure 3-35 on page 87.

IP Telephony presence rules apply as shown in Figure 3-43. In this example, we cannot 
connect with Markus Neuhold because he is using the phone. However, he is available for a 
text chat, so that we can reach him by a normal Sametime text chat session.

Figure 3-43   IP Telephony presence status in an conference invitation

Moderator: As the moderator, if you close your conference status window during the call, 
the call ends, and all the participants become disconnected.
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Another rule that applies is resource use regarding the number of participants in a call as 
explained earlier in this section.

Figure 3-44   Status window in a conference with a seventh participant

Important: As the moderator, you cannot connect more than six phones in this way 
because you are using the ad hoc function of System i IP Telephony solution. If you try to 
connect a seventh phone, the moderator telephone (if it has a display) shows the following 
message:

No more users allowed.

Then in the Sametime status window, the seventh user has a status of Connecting as 
shown for Markus Neuhold in Figure 3-44.
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Clicking to conference from the contact list
Another way to create an ad hoc conference is to select the participants from the Sametime 
contact list and then use the Start a call or Call me at option as shown in Figure 3-45. For 
this type of conference, you cannot connect more than six people in a conference.

Figure 3-45   Click to conference from the Sametime contact list

All of the people who are selected in the contact list receive an invitation window like the one 
that is shown in Figure 3-33 on page 86. As long as your invitees accept or decline the 
invitation, you and your participants should see the conference status window as shown in 
Figure 3-46 on page 96. Only you as the call originator have Moderator options to disconnect 
a participant or to completely finish the call.

After each invitee accepts to attend the call, the hard phone rings, which the invitee must 
answer in order to join the telephone conference.

Moderator: As the moderator, if you close your conference status window during the call, 
the call ends, and all the participants become disconnected.
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Figure 3-46   Conference status window

Clicking to instant meeting conference from the Sametime contact list
To use this method, you must have the System i IP Conferencing module installed and 
configured. To start an instant meeting conference from the Sametime contact list:

1. From a Web browser, go to the System i IP Conferencing Module administration Web 
page, for example:

http://democonf.iptdemo.com/

2. Sign in with the user ID and password. The default user and password are both root.
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3. Create a conference. You can choose between creating a Meet me Conference or an 
Instant Conference. In this example, we create an Instant Conference:

a. Click Create Instant Conference and enter the required parameters. Figure 3-47 
shows the values for our example. It is important to remember the numeric conference 
name (7130 in our example) because conference participants will dial in to the 
telephony service with this number to access the conference meeting. 

b. Click Submit.

Figure 3-47   Configuring an Instant Conference
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4. After you create the conference in your System i IP Conferencing module, start a 
Sametime Connect client session and select several people from your Sametime contact 
list. You can press the Ctrl key while clicking each contact that you want to invite. You are 
allowed to select more than six people for this type of conference.

Then right-click and select Instant Meeting as shown in Figure 3-48.

Figure 3-48   Starting an instant meeting
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5. In the Start an Instant Meeting window (Figure 3-49), the Invitees field lists the people that 
you previously selected. You have the opportunity to remove any of them if you need. 

a. In the Topic field, enter the purpose of the meeting.
b. Under Additional tools, select the Telephone services check box. 
c. Click Send.

Figure 3-49   Starting an instant meeting

After you send the invitation, each invitee receives a Meeting Invitation window like the 
one shown in Figure 3-50 prompting them to join the meeting in a virtual telephone 
conference room (7130 in this example).

Figure 3-50   Invitation to join the instant meeting

Conference number: In the Topic message, include the conference number, which is 
7130 in our example, to inform participants of which number to dial when the Assistant 
conference message prompts them.

 

 

 

Chapter 3. Sametime integration 99



 

6. When an invitee accepts the invitation, a Web browser window (Figure 3-51) opens that 
shows the connection status to both the virtual Sametime meeting room and of each 
participant. The moderator is allowed to manage the Sametime meeting. 

In the right panel, participants click the Join the call button in order to join the 
teleconference. In this window, any participant can invite more participants to the 
Sametime meeting room.

Figure 3-51   Sametime meeting room
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7. Just after each invitee accepts the conference invitation, the invitee’s hard phone rings, 
which they must answer. If any of the participants do not answer the phone, their name is 
shown with a status of not connected.

When the participant answers the phone, a message from the IP Telephony Conference 
module is played that prompts the user for the conference number. In the example that we 
configured in Figure 3-12 on page 67, the Conference Bridge Number is the Conference 
Assistant Number (7777). The participants must dial the conference number, which is 
7130 in our example (see Figure 3-47 on page 97). Then they are forwarded to the 
telephone conference.

8. Each conference member must follow the instructions on the welcome message of the 
virtual telephone conference room to join the telephone conference.

During the conference, the participants can use all the resources that the Sametime 
Meeting Room provides plus the options that the System i IP Telephony solution provides. 
If any participant, even the moderator, closes their Web browser, they continue to be 
connected to the telephone conference, but not to the Sametime meeting. Additional 
people who dial directly to the conference extension (in this example 7130) can connect to 
the telephone conference.

All participants must hang up their hard phone in order to close the entire telephone 
conference.

Clicking to conference from a Sametime meeting invitation
In this example, we show you how to connect to a telephone conference from a Sametime 
scheduled meeting in the Sametime Web interface. As in the previous section, first you must 
set up and schedule a conference in the System i IP Telephony Conference module. Then 
follow these steps:

1. From a Web browser, go to the System i IP Conferencing Module administration Web 
page, for example:

http://democonf.iptdemo.com/

For more information about the IP Conferencing Module, refer to the IP Conferencing 
Module Administration Guide:

http://support.3com.com/infodeli/tools/vcx/71/IPCM_7.1_Admin_Guide.pdf

2. Sign in with the user ID and password. The default user and password are both root.

Conference extension: You have the option to configure the Conference Bridge 
Number (see 3.2.3, “(Optional) Reconfiguring and enabling the Sametime server” on 
page 70) with a conference extension (in our example between 7100 and 7199). This 
way, your participants can go directly to the telephone conference without hearing the 
assistant message.
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3. Click Create Scheduled Conference and enter the required parameters. Figure 3-52 
shows the values that we entered for our example.

It is important to remember the numeric conference name (7140 in our example) because 
conference participants will dial in to the telephony service with this number to access the 
conference meeting. Also take note of the date and time of the conference because you 
will use the same parameters to set up the Sametime meeting. 

Click Submit.

Figure 3-52   Creating a scheduled conference in System i IP Telephony
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4. Create a scheduled meeting in Sametime:

a. From a Web browser, go to Sametime Center administration Web page, which is the 
following page in our example:

http://demost.iptdemo.com/stcenter.nsf

b. Log in with your Sametime user ID.

c. On the Welcome page (Figure 3-53), click Schedule a Meeting.

Figure 3-53   Scheduling a Sametime meeting
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d. In the New Meeting window (Figure 3-54), set up your Sametime meeting by entering 
the required parameters: 

i. Specify the meeting name, date, and time. The date and time should match the 
date and time that were specified in the telephone conference meeting in 
Figure 3-52 on page 102. 

ii. Select the Use the phone number provided by my telephone service option. 

iii. Click Save.

Figure 3-54   Setting up a new Sametime meeting 
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After you book the resources (IP Telephony resources and Sametime resources), wait until 
the scheduled date and time of the meeting. You also can copy the meeting link and send it by 
e-mail it to your invitees. At conference time, each invitee can use the Sametime Meeting 
Web interface to attend to the conference.

If your invitees use the Sametime Connect client to access and attend the meeting, they must 
perform the following steps. However, if you sent the invitation by adding the meeting Web 
link, your invitees can click the link and go to step 3:

1. Start a Sametime Connect client session.

2. From the Sametime Connect client, select Tools → Meetings → Attend Meeting 
(Figure 3-55).

Figure 3-55   Attending a scheduled meeting from the Sametime Connect client

3. Sign in to the Sametime Meeting Center.

4. Ensure that your meeting is in progress and click Attend the Meeting. Meeting invitees 
should see a Web browser window as shown Figure 3-51 on page 100.

5. Follow steps 6 through 8 on page 101 of “Clicking to instant meeting conference from the 
Sametime contact list” on page 96 to complete the steps for joining the meeting.
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6. Verify the Sametime presence status of participants in the Sametime Connect client 
during the telephone conference as shown in Figure 3-56.

Figure 3-56   IP Telephony presence during a teleconference

3.5  Troubleshooting Sametime integration with IP Telephony

In this section, we discuss problem areas that we discovered while writing this book that can 
generate a failure when enabling System i IP Telephony capabilities in the Sametime Connect 
client. We also present the solution or workaround to solve each issue.

For additional information regarding log files and problem determination, refer to Appendix C, 
“Location of log files” on page 205.

3.5.1  Problems with running the install.sh or config.sh scripts

When running the install.sh or config.sh scripts to integrate IP Telephony into Sametime, you 
might experience the following problems:

� Problem: Error messages such as those shown in Figure 3-57 on page 107 are displayed 
during the installation and configuration procedure when running the install.sh or config.sh 
scripts.

– Description: The QCCSID system value in i5/OS is different than 37 (USA).

– Workaround: Run the following Change Job (CHGJOB) CL command and run the 
script again:

CHGJOB CNTRYID(US) CCSID(37)

– Comments: Be sure that you are using the CCSID value of 37. Also, specify the value 
of -C 819 when you run the pax command.
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Figure 3-57    CCSID error when running the install.sh script

� Problem: The following message is displayed during the installation and configuration 
procedure when running the install.sh or config.sh scripts:

The installing user profile needs *ALLOBJ authority.

– Description: The current i5/OS user profile does not have enough authority.

– Solution: Sign off and change your i5/OS user profile to one that has *ALLOBJ 
authority.

� Problem: The following message is displayed during installation when running the 
install.sh script:

Sametime is not at a compatible version.  Check the product prerequisites.

– Description: Your version of Sametime is invalid or the i5/OS integrate file system 
directory of /QIBM/ProdData/LOTUS/Sametime/telephony_ext was deleted.

– Solution: Update the Sametime server to a supported version or create the missing 
directory.

– Comments: If your directory was deleted, verify the integrity of your Sametime 
product. You can run the following Check Product Option (CHKPRDOPT) CL command 
to do an initial verification:

CHKPRDOPT PRDID(5724J23) RLS(*ALL) OPTION(*ALL) DETAIL(*FULL)

                              QSH Command Entry 
                                                                                                                                    
   
> cd iptcollab                                                                                                                     
   
> install.sh                                                                                                                       
   Copying files to ProdData ...                                                                                                    
                                                                                                                                    
   grep: 001-2110 Error found processing regular expression: [] imbalance..                                                         
   grep: 001-2110 Error found processing regular expression: [] imbalance..                                                         
   grep: 001-2110 Error found processing regular expression: [] imbalance..                                                         
   grep: 001-2110 Error found processing regular expression: [] imbalance..                                                         
   £: 001-0062 Syntax error evaluating expression: primary not found.                                                               
   0 servers updated                                                                                                                
   ¢                                                                                                                                

                                                                                                                                    
===>                                                                                                                               

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                                                                      
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 
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3.5.2  Problems with Sametime phone calls

You might encounter the following problems when working with the IP Telephony integration in 
the Sametime Connect client:

� Problem: Sometimes the call options in Sametime Connect client are missing as shown in 
Figure 3-58.

– Description: This is an occasional failure of the Sametime Connect client.

– Workaround: Restart the Sametime Connect client.

Figure 3-58   Sametime call options missing

� Problem: In an incoming phone call window as shown Figure 3-34 on page 87, you 
cannot edit the current phone number.

– Description: The Sametime Connect client uses the Geographic Location preference 
to accept a call.

– Solution: Set up the primary phone number in your Geographic Location preference. 
See Figure 3-30 on page 84.

– Comments: Ensure that this phone number satisfies the dialing plan that is defined in 
the System i IP Telephony solution.

 

 

 

108 IBM System i IP Telephony and Integrated Collaboration



 

3.5.3  Problems with Sametime meetings

You might encounter the following problems when working with Sametime meetings and IP 
Telephony:

� Problem: During startup of the Sametime meeting room, a message, such as the one 
shown in Figure 3-59 is displayed.

– Description: The Java version on the PC workstation is lower than required.

– Solution: Update the Java version from the following Web site and try again to connect 
the user to the meeting:

http://java.com/download

– Comments: At the time of writing this book, we used the latest Java version that was 
available, which was Java Runtime Environment (JRE™) version 1.6.0_02 
(jre-6u2-windows-i586-p-s.exe).

Figure 3-59   Java error message when starting a Sametime meeting

� Problem: When creating a conference from a Sametime contact list, some people do not 
connect.

– Description: After selecting several people in the Sametime contact list and then 
selecting the Start a Call option, some people do not appear in the status window.

– Solution: Be sure that you are not inviting more than five participants to the meeting. 
Remember that the call originator counts as one person in the limit of six people in an 
ad hoc conference call.

– Comments: Use the Instant meeting option to invite more than six people to the 
meeting. If you do not have the System i IP Conferencing module configured to create 
an Instant meeting, ask the current participants in the conference to connect more 
participants through their hard phones.
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Chapter 4. Domino integration

In this chapter, we explain the steps to enable System i IP Telephony capabilities on a Domino 
server to create a unified inbox solution. The discussion includes the installation and 
configuration processes as well as examples of use. We discuss the following topics:

� “Unified inbox” on page 112
� “Installing the IP Telephony integration with Domino” on page 113
� “Configuring the unified inbox” on page 124
� “Examples of integration” on page 150
� “Outbound fax messages” on page 158
� “Troubleshooting the unified inbox” on page 160

4

More information: For detailed information about how to install and configure Domino on 
i5/OS, refer to IBM Lotus Domino 6 for iSeries Implementation, SG24-6592, or 
Implementing IBM Lotus Domino 7 for i5/OS, SG24-7311.
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4.1  Unified inbox

With a unified inbox, a Domino user can receive voice mail, faxes, and e-mail in their Domino 
mail database. A unified inbox is possible by integrating System i IP Telephony with Domino. 
This integration provides real-time synchronization between the Domino server and System i 
IP Telephony. It supports multiple methods of e-mail integration with a Domino server:

� E-mail auto delivery

The System i IP Telephony server automatically forwards all voice mail and fax messages 
to an external Domino e-mail account.

� Domino mail integration

Domino users read voice mail and fax messages directly from their inbox by using either of 
the following methods:

– The Lotus Notes client and Domino native routing protocol, which is called the Notes 
Remote Procedure Call (NRPC)

– Domino Web Access, which is the Web browser-based client that uses HTTP

� E-mail synchronization

The voice mail and fax messages are synchronized between Domino and System i IP 
Telephony message stores to give the appearance of a unified messaging store with the 
advantages of each. This method works with Post Office Protocol (POP3) or Internet 
Message Access Protocol (IMAP4). IMAP4 provides full message waiting indicator (MWI) 
synchronization.

With this integrated solution, the user uses Domino mail and automatically receives new voice 
mail and fax messages as they are deposited by callers. By using Domino mail, users can 
listen to voice messages as WAV files and view fax messages as TIF files. The Domino user 
can forward voice mail and fax messages that are received from System i IP Telephony back 
to other System i IP Telephony mailbox users or to other e-mail destinations that are 
supported by the Domino server. Domino users have the option to use the Lotus Notes client 
or Domino Web Access as a client. Figure 4-1 illustrates this unified inbox solution.

Figure 4-1   Unified inbox solution with Domino and System i IP Telephony
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This integrated solution is an event-based architecture. The messages that are received by 
System i IP Messaging are sent to the Domino server by using Simple Mail Transfer Protocol 
(SMTP). Message activity on the Domino server generates events that are sent back to 
System i IP Messaging. Message activity on System i IP Messaging generates poll sessions 
that connect to the Domino server and manipulate inbox messages using IMAP.

A typical message between the System i IP Messaging server and a Domino server follows 
this sequence of actions:

1. The System i IP Messaging server receives a voice mail or fax and activates the MWI.

2. The System i IP Messaging server sends a message to the Domino server via SMTP.

3. The Domino server sends an event (InboxAdd) to the System i IP Messaging server.

4. The System i IP Messaging server initiates an IMAP poll that retrieves the IMAP unique 
identifier (UID) of the message and stores it on the System i IP Messaging server.

5. The user opens the message on the Domino server.

6. The Domino server sends an event (MarkRead) to the System i IP Messaging server.

7. The System i IP Messaging server updates the message status and MWI.

8. The user deletes the message on the Domino server.

9. The Domino server sends an event (Delete) to the System i IP Messaging server.

10.The System i IP Messaging server deletes the message and updates the MWI.

For more information about how this integrated solution works between the System i IP 
Messaging server and the Domino server, see “IMAP” on page 212.

4.2  Installing the IP Telephony integration with Domino

In this section, we explain how you can install the 3Com IP Telephony Integration for Domino. 
We provide step-by-step instructions for planning and installation in order to enable the 
integration between the Domino server and System i IP Telephony.

4.2.1  Planning

You should have available the environmental characteristics and resources that are presented 
in the following sections, so that you can install and configure the unified inbox solution.

Assumptions
In planning for the installation, we assume that you have the following components and 
configurations:

� You already installed and configured the following products:

– Domino 6.5.6 or later in an i5/OS partition

– System i IP Telephony software on its own Linux partition on the System i machine

� You have configured and activated Lightweight Directory Access Protocol (LDAP) 
synchronization between the System i IP Telephony solution and the Domino server. See 

Important: Make sure that e-mail accounts exist on the Domino server.

 

 

 

Chapter 4. Domino integration 113



 

2.3, “Configuring LDAP synchronization” on page 36, and 2.4, “Reconfiguring LDAP 
synchronization” on page 41, for details.

Required information
You must provide the following information for the installation script:

� IP address of the primary System i IP Telephony logical partition (LPAR) 
� IP address of the Domino server that is running on the i5/OS partition

Network configuration
Consider a situation where the Domino server and any System i IP Messaging LPAR reside 
on the same System i machine. In addition, the System i IP Messaging partition is using 
virtual networking, and the i5/OS partition in which the Domino server is running performs 
proxy Address Resolution Protocol (ARP) for the virtual network. In this situation, the Domino 
server might encounter a problem when it tries to access the System i IP Messaging partition. 
To prevent this problem, perform the following steps:

1. Start an SSH session and log in as root (with a default password of pvadmin) to each 
System i IP Messaging partition that is configured for virtual networking and resides on the 
same System i machine as the Domino server.

2. On the Linux command line of the SSH session, modify the firewall ipm_table_sock as 
shown in Figure 4-2 by entering the following command:

modfw -p ipm_table_sock allow i5/OS_virtual_LAN_IP_address 

In our example, 9.5.92.65 is the i5/OS virtual LAN IP address:

modfw -p ipm_table_sock allow 9.5.92.65

Figure 4-2   Modifying ipm_table_sock by using the Cygwin SSH session

Tip: See 4.3.4, “Adding Domino and SMTP to the System i IP Telephony configuration” 
on page 134, for information about how to install Cygwin and start an SSH session to a 
System i IP Messaging partition.
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4.2.2  Installing the IP Telephony integration package

In this section, we explain step-by-step how to install the necessary integration package in 
order to create a unified inbox solution on the Domino server. We also explain how to verify 
the installation.

You install the integration package into the i5/OS partition from the 3Com software media by 
using a Qshell command prompt. You can use these instructions when you install the 
System i IP Messaging software for the first time or for an already installed system. 

This task entails the following actions:

� “Installing the integration package in the i5/OS partition” on page 115
� “Ending the Domino server” on page 118
� “Configuring the 3Com IP Telephony software” on page 119
� “Restarting the Domino server and activating the IPMADDIN server task” on page 120
� “Verifying the installation” on page 121

Installing the integration package in the i5/OS partition
To install the integration package in the i5/OS partition:

1. Load the 3Com VCX IP Telephony and Messaging DVD into the System i DVD player. 
Alternatively, mount the proper image volume in the image catalog of your System i 
machine where the Domino server is already installed and configured.

ISO image: You can create an ISO image for this DVD and mount it to a virtual optical 
device in i5/OS. For more information regarding this i5/OS feature, see Appendix A, 
“Virtual CD library” in Implementing POWER Linux on IBM System i Platform, 
SG24-6388.
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2. Locate the integration package file, ipmmail_i5.tar, on the 3Com IP Telephony and 
Messaging DVD in the I5OS folder by using iSeries Navigator as shown in Figure 4-3.

Figure 4-3   IP Messaging file location

3. Start an i5/OS 5250 emulation session and sign on with a user profile that has *ALLOBJ 
authority.

4. Create a directory in the i5/OS integrated file system. For our example, we created a 
directory called /iptcollab by using the following Create Directory (CRTDIR) CL command:

CRTDIR DIR(iptcollab)
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5. Copy the ipmmail_i5.tar file to the directory that you created in the previous step. By using 
iSeries Navigator, you can copy and paste the file as shown in Figure 4-4.

Figure 4-4   Copying the ipmmail_i5.tar file to the i5/OS directory

6. Start an i5/OS Qshell command entry by typing the STRQSH command and pressing Enter.

i5/OS Cl command alternative: You can also copy the ipmmail_i5.tar file from an 
i5/OS 5250 emulation session by using the following Copy (CPY) CL command:

CPY OBJ('/QOPT/VCXINSTALLER-7.2.5C/I5OS/ipmmail_i5.tar') TODIR('/iptcollab')

Attention: If your QCCSID system value is different from 37 (USA), you must change it 
for your current job by using the following Change Job (CHGJOB) CL command:

CHGJOB CNTRYID(US) CCSID(37)
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7. On the QSH Command Entry display (Figure 4-5), change directory to your selected 
directory, which is /iptcollab in our example, and unpack the ipmail_i5.tar file by using the 
pax command.

Figure 4-5   Unpacking the ipmmail_i5.tar file in the /iptcollab directory

Ending the Domino server
After you unpack the file and before you continue with the installation, shut down the Domino 
server:

1. In the left navigation pane of iSeries Navigator (Figure 4-6 on page 119), expand 
Network → Servers → Domino to retrieve a list of Domino servers configured on your 
system.

2. In the right pane, right-click the Domino server and select Stop → Server.

Important: You must use the -C parameter with code 819 regardless of the language 
that you are using on your system.

                              QSH Command Entry                                
                                                                                
   $                                                                            
 > cd /iptcollab                                                        
   $                                                                            
 > ls                                                                           
   ipmmail_i5.tar                                                               
   $                                                                            
 > pax -rv -C 819 -f ipmmail_i5.tar                                             
   ipmmail_i5.qsh                                                               
   ipmmail_i5.readme                                                            
   ipmmail_i5_install.qsh                                                       
   COMSIPM.SAVF                                                                 
   pax: 001-2298 For archive file ipmmail_i5.tar and volume 1, 4 files were 
processed with 0 bytes read and 675840 bytes written.                            
   $                                                                            
                                                                                
 ===>                                                                           

 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry 

i5/OS CL command alternative: You can also stop the Domino server from a 5250 
emulation session using the following End Domino Server (ENDDOMSVR) CL 
command:

ENDDOMSVR SERVER(demodom) OPTION(*CNTRLD) 

In this example the Domino server is called demodom.
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Figure 4-6   Stopping the Domino server

Configuring the 3Com IP Telephony software
After the Domino server stops, complete the following steps:

1. Change to the directory where you unpacked the files:

cd /iptcollab

2. Call the ipmmail_i5_install.qsh script (Figure 4-7):

./ipmmail_i5_install.qsh

Figure 4-7   Executing the ipmmail_i5_install.qsh script

                              QSH Command Entry                                 
                                                                                                                                                           
 > cd /iptcollab                                                        
   $   
 > ./ipmmail_i5_install.qsh
   creating COMSSAVF library
   CPC2102:  Library COMSSAVF created.                                          
   creating COMSSAVF/COMSIPM                                                    
   CPC7301:  File COMSIPM created in library COMSSAVF.                          
   Updating comssavf/comsipm ...                                                
   Restoring COMSIPM ...                                                        
   CPC3703:  4 objects restored from COMSIPM to COMSIPM.                        
   creating ipmaddin link                                                       
   creating ipmmail link                                                        
                                                                                
   Enter the Notes server name or L to select from a list                       
 >                                                                                  
 ===>                                                                           
                                                                                                                                                                                                                                                                                                                                 
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            
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3. On the QSH Command Entry display (Figure 4-8), type the name of the Domino server 
that will run the server task IPMADDIN or type L to select from a list of Domino servers.

Figure 4-8    Selecting the Domino server that will run the IPMADDIN server task 

4. Press F12 (Disconnect) to exit Qshell.

Restarting the Domino server and activating the IPMADDIN server task
Restart the Domino server to activate the newly installed IPMADDIN server task. From 
iSeries Navigator, in the left navigation pane, click Network → Servers → Domino to retrieve 
a list of Domino servers configured on your system. In the right pane, right-click the Domino 
server and select Start.

Tip: When the operation is successful, you receive the following message:

1 servers updated

                               QSH Command Entry                                
                                                                                                                                                                
   Enter the Notes server name or L to select from a list                       
 > L                                                                            
   Select one of the following Notes servers:                                   
   1. DEMODOM                                                                   
   2. DEMOST                                                                    
   Select a server (1 to 2) or Q to quit:                                       
 > 1                                                                            
   Updating server: DEMODOM                                                     
   creating ipm_mail link in /QIBM/PRODDATA/LOTUS/DOMINO702                     
   Updating /domino/demodom/notes.ini                                           
   Enabling extension manager                                                   
   1 servers updated                                                            
   $                                                                            
                                                                                
 ===>                                                                           
                                                                                                                                                                                                                                                
 F3=Exit   F6=Print F9=Retrieve F12=Disconnect                                  
 F13=Clear F17=Top  F18=Bottom  F21=CL command entry                            

i5/OS CL command alternative: You can also start the Domino server by entering the 
following Start Domino Server (STRDOMSVR) CL command:

STRDOMSVR SERVER(demodom)

In this example, the Domino server is called demodom.
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Verifying the installation
You must verify the installation of the integration package by analyzing the notes.ini file of the 
Domino server and the messages in the Domino server console. In this section, you verify the 
following items:

� The notes.ini file of the Domino server
� The Domino server console messages
� The Domino IPMADDIN server task status

To verify the installation:

1. From an i5/OS 5250 emulation session, verify the corresponding Domino server notes.ini 
file and the existence of the IPMADDIN task on the ServerTasks= line (see Figure 4-9). 
Enter the following Display File (DSPF) CL command:

DSPF STMF('/domino_directory/domino_data_directory/NOTES.INI')

In our example, we enter the following command: 

DSPF STMF('/domino/demodom/NOTES.INI')

Figure 4-9   Verifying the notes.ini file and the IPMADDIN task on the ServerTasks line

 Browse : /domino/demodom/NOTES.INI                                             
 Record :       1   of      84 by  14            Column :    1    106 by  79    
 Control :                                                                      
                                                                                
....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+.... 
[Notes]                                                                         
Directory=/domino/demodom                                                       
KitType=2                                                                       
NPN=1                                                                           
UNICODE_DISPLAY=1                                                               
FaultRecovery_Build=Release 7.0.2FP1                                            
SHARED_MAIL=0                                                                   
DisableLDAPOnAdmin=0                                                            
Passthru_LogLevel=0                                                             
Console_LogLevel=2                                                              
DefaultMailTemplate=mail7.ntf                                                   
Preferences=32                                                                  
ServerTasks=IMAP,COLSRV400,Update,HTTP,LDAP,Replica,Router,SMTP,ipmaddin        
ServerTasksAt1=Catalog,Design                                                   
ServerTasksAt2=UpdAll                                                           
                                                                                
 F3=Exit   F10=Display Hex   F12=Exit  F15=Services  F16=Repeat find            
 F19=Left   F20=Right                                                                                                                                           
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2. Press the Page Down key and verify the existence of the EXTMGR_ADDINS=IPMMAIL line as 
shown in Figure 4-10. Press F3 to exit the notes.ini file.

Figure 4-10   Verifying the EXTMGR_ADDINS line in the notes.ini file

3. Start a Domino server console session by entering the following Work with Domino 
Console (WRKDOMCSL) CL command:

WRKDOMCSL dominoserver

In our example, demodom is the name of the Domino server:

WRKDOMCSL demodom

 Browse : /domino/demodom/NOTES.INI                                             
 Record :      71   of      84 by  14            Column :    1     59 by  79    
 Control :                                                                      
                                                                                
....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+.... 
CLEANUP_EVENTS4_STATS_VIEW=0                                                    
EventSetup=700200                                                               
DELETE_DUPLICATE_PUID_NOTES=0                                                   
DDMSetup=700200                                                                 
WebAdminSetup=710                                                               
DominoConfigLevel=1                                                             
CATALOG_UPDATED_BY_BUILD=510                                                    
ADMINP_LAST_SAVED_POLICY_TIME=08/31/2007 13:28:40                               
ADMINP_LAST_SAVED_USER_TIME=09/05/2007 11:25:16                                 
ADMINP_LAST_SAVED_DIRECTORY_TIME=09/05/2007 11:26:12                            
EXTMGR_ADDINS=IPMMAIL                                                           
IPMServer=9.5.92.66,9.5.92.67:2298                                              
DominoControllerCurrentLog=dcntrlr200709050000.log                              
JrnlEnbld=0                                                                     
 ************End of Data********************                                    
                                                                                
 F3=Exit   F10=Display Hex   F12=Exit  F15=Services  F16=Repeat find            
 F19=Left   F20=Right                                                                                                                                                                                                                                                           
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4. In the Domino server console, verify that the IPMADDIN Domino server task started 
correctly as shown in Figure 4-11.

Figure 4-11    Verifying that the IPMADDIN task started successfully in the Domino server console

Tip: You can press F5 to refresh the display. In addition, you can press the Page Up 
and Page Down keys to scroll through the display.

                          Work with Domino Console                              
                                                Server: DEMODOM                 
 Previous subcommands and messages:                                                                              
08/22/2007 15:02:34   SchedMgr: Validating schedule database                 
08/22/2007 15:02:34   Admin Process: DEMODOM/ITSO is the Administration Server 
of the Domino Directory.                                                   
08/22/2007 15:02:34   Calendar Connector started                             
08/22/2007 15:02:34   Rooms and Resources Manager started                    
08/22/2007 15:02:34   LDAP Server: Starting...                               
08/22/2007 15:02:34   Administration Process started                         
08/22/2007 15:02:35   Listen to non-blocking socket 6 on port 2281           
08/22/2007 15:02:35   ipmaddin: Initialization complete.                     
08/22/2007 15:02:35   ipmaddin: After EventQueueAlloc.                       
08/22/2007 15:02:35   IMAP Server: Starting...                               
08/22/2007 15:02:35   ipmaddin: After EventRegister.                         
08/22/2007 15:02:35   LDAP Server: Serving directory names.nsf in the 
iptdemo.com Internet domain 
                                                        
 Enter a Domino subcommand.                                                    
 ===>                                                                           
                                                                                
 F3=Exit   F5=Refresh   F6=Print   F9=Retrieve                                  
 F17=Top   F18=Bottom   F21=Command line                                                                                                                        
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5. Verify that the IPMADDIN task is running as shown in Figure 4-12 by entering the following 
Domino server console command:

show tasks

Figure 4-12   Verifying the IPMADDIN task status in the Domino server console

6. Press F3 (Exit) to close the Domino server console session.

4.3  Configuring the unified inbox

On the Domino server, you must enable the SMTP and IMAP services and specify an Internet 
password and Internet e-mail address in the Domino Directory Person documents. On the 
System i IP Messaging side, you must define the Domino server and SMTP service and add 
a new external e-mail account to existing users.

4.3.1  Running the Domino and i5/OS SMTP services

If you configure more than one server on your system with SMTP enabled, each server must 
have a separate TCP/IP address. Otherwise, the servers compete for the same 
communications port and create a port conflict. You have the following options: 

� Bind the i5/OS SMTP to a specific TCP/IP address to support both Domino SMTP and 
i5/OS SMTP at the same time. See “Binding the Domino SMTP and i5/OS SMTP on the 
same system” on page 125.

� Disable the i5/OS SMTP service before you enable the Domino SMTP. See “Disabling 
i5/OS SMTP” on page 128.

                          Work with Domino Console                              
                                                Server: demodom                 
 Previous subcommands and messages:                                             
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Listen for connect requests on TCP Port:389            
    LDAP Server          Utility task                                           
    SMTP Server          Listen for connect requests on TCP Port:25             
    SMTP Server          Utility task                                           
    IMAP Server          Listen for connect requests on TCP Port:143            
    IMAP Server          Utility task                                           
    Agent Manager        Executive '1': Idle                                    
    IPMADDIN             Idle                                                   
    SMTP Server          Control task                                           
    Rooms and Resources  Idle                                                   
    IMAP Server          Control task                                           
    Calendar Connector   Idle

 Enter a Domino subcommand.                                                     
 ===>                                                                           
                                                                                
 F3=Exit   F5=Refresh   F6=Print   F9=Retrieve                                  
 F17=Top   F18=Bottom   F21=Command line 
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Binding the Domino SMTP and i5/OS SMTP on the same system
The i5/OS SMTP server and Domino SMTP server must bind to a specific TCP/IP address. 
After you configure this, the Domino SMTP server can send and receive mail with the i5/OS 
SMTP server, as though they were communicating over the Internet. Figure 4-13 illustrates 
this configuration.

Figure 4-13   Configuring multiple SMTP instances on the same i5/OS partition

To configure multiple instances of SMTP, you must ensure that Domino partitioning is 
enabled, and each instance must bind to a specific TCP/IP address. To bind your servers to 
specific TCP/IP addresses for configuring multiple SMTP servers on the same system:

1. Obtain all of the necessary TCP/IP addresses that are required for the configuration. One 
address is required for the Domino SMTP server, and one is required for the i5/OS SMTP 
server.

2. Start a 5250 emulation session and sign on with a user profile that has *ALLOBJ authority.

3. Type the Configure TCP/IP (CFGTCP) CL command and press Enter.

Note: With Domino 7 for i5/OS, you have the option to configure multiple Domino SMTP 
servers and one i5/OS SMTP server on the same system. 

Complex network environment: The following steps do not explain how to set up a 
complex network environment. You must understand your network and plan your 
environment accordingly. For help with setting up a complex network environment, see the 
Networking section of the IBM Systems Information Center:

http://www.ibm.com/eserver/iseries/infocenter

i5/OS TCP/IP

Internet

Domino SMTP
TCPIP_TcpIpAddress = 0,9.5.92.26

i5/OS SMTP
9.5.92.16

Optional third-party mail application

Users Users
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4. On the Configure TCP/IP display (Figure 4-14), type option 10 (Work with TCP/IP host 
table entries) and press Enter.

Figure 4-14   Configure TCP/IP menu

5. On the Work with TCP/IP Host Table Entries display (Figure 4-15), change the host table 
entries for System i TCP/IP according to your configuration. In Figure 4-15, we show that 
our Domino server (DEMODOM) is added to the System i host table.

Figure 4-15   Work with TCP/IP Host Table Entries display

 CFGTCP                         Configure TCP/IP                                
                                                             System:   
RCHAS10  
 Select one of the following:                                                   
                                                                                
      1. Work with TCP/IP interfaces                                            
      2. Work with TCP/IP routes                                                
      3. Change TCP/IP attributes                                               
      4. Work with TCP/IP port restrictions                                     
      5. Work with TCP/IP remote system information                             
                                                                                
     10. Work with TCP/IP host table entries                                    
     11. Merge TCP/IP host table                                                
     12. Change TCP/IP domain information                                       
                                                                                
     20. Configure TCP/IP applications                                          
     21. Configure related tables                                               
     22. Configure point-to-point TCP/IP                                        
                                                                                
                                                                                
 Selection or command                                                           
 ===> 10                                                                          
                                                                                
 F3=Exit   F4=Prompt   F9=Retrieve   F12=Cancel 

                      Work with TCP/IP Host Table Entries                       
                                                           System:   RCHAS10  
 Type options, press Enter.                                                     
   1=Add   2=Change   4=Remove   5=Display   7=Rename                           
                                                                                
      Internet         Host                                                     
 Opt  Address          Name                                                     
                                                                                
      9.5.92.16        RCHAS10.RCHLAND.IBM.COM                                  
                       RCHAS10                                                  
      9.5.92.26        DEMODOM.IPTDEMO.COM                                      
                       DEMODOM                                                  
      9.5.92.39        DEMODOM8.IPTDEMO.COM                                     
                       DEMODOM8                                                 

                                                                    More... 

 F3=Exit   F5=Refresh   F6=Print list   F12=Cancel   F17=Position to                                                                                            
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6. Update the TCP/IP Domain information for the system according to your configuration, as 
shown in Figure 4-16, by using the Change TCP/IP Domain (CHGTCPDMN) CL 
command. 

Figure 4-16   Change TCP/IP Domain display

7. Edit the notes.ini file for the Domino server by using the following Edit File (EDTF) CL 
command:

EDTF STMF('/domino_directory/domino_data_directory/NOTES.INI')

In our example, we enter the following command:

EDTF STMF('/domino/demodom/NOTES.INI')

                        Change TCP/IP Domain (CHGTCPDMN)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Host name  . . . . . . . . . . .   'RCHAS10'                                   
                                                                                
 Domain name  . . . . . . . . . .   'RCHLAND.IBM.COM'                           
                                                                                
                                                                                
                                                                                
 Domain search list . . . . . . .   *DFT                                        
                                                                                
                                                                                
                                                                                
 Host name search priority  . . .   *LOCAL        *REMOTE, *LOCAL, *SAME        
 Domain name server:                                                            
 Internet address . . . . . . .   '9.10.244.100'                              
                                   '9.10.244.200'                              
                                                                                
                                                                                

Bottom 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys                                                                                                               
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8. Set the variable TCPIP_TcpIpAddress to the assigned TCP/IP address according to your 
configuration as shown in Figure 4-17. In our example, 9.5.92.26 is the IP address of the 
Domino SMTP server. Press F2 to save the changes.

Figure 4-17   Changing the TCPIP_TcpIpAddress notes.ini variable

9. Bind the i5/OS SMTP server to a specific IP address by using the Add SMTP List Entry 
(ADDSMTPLE) CL command. Enter the following two commands in which you substitute 
your TCP/IP address for the one that is used in your configuration:

ADDSMTPLE TYPE(*SVRBIND) INTNETADR('9.5.92.16')
ADDSMTPLE TYPE(*CLTBIND) INTNETADR('9.5.92.16')

In our example, 9.5.92.16 is the IP address of the i5/OS SMTP server.

Disabling i5/OS SMTP
Both Domino SMTP and i5/OS SMTP can be configured to work on the same system as 
shown in the previous section. You can also decide to disable the SMTP service on i5/OS 
because is not being used or to resolve a port conflict with Domino SMTP.

To disable i5/OS SMTP:

1. Start a 5250 emulation session and sign on with an user profile that has *ALLOBJ 
authority.

2. Stop the i5/OS SMTP service by typing the following End TCP/IP Server (ENDTCPSVR) 
CL command:

ENDTCPSVR SERVER(*SMTP)

3. Type the Change SMTP Attributes (CHGSMTPA) CL command and press F4 to prompt the 
command.

 Edit File: /domino/demodom/NOTES.INI                                           
 Record :      32   of      84 by   8            Column :    1     36 by  74    
 Control :                                                                      
                                                                                
CMD 
....+....1....+....2....+....3....+....4....+....5....+....6....+....7....+ 
    ServerKeyFileName=server.id                                                 
    Domain=ITSO                                                                 
    Admin=CN=Domino Administrator/O=ITSO                                        
    Timezone=6                                                                  
    DST=1                                                                       
    FaultRecovery=1                                                             
    TemplateSetup=700200                                                        
    Setup=700200                                                                
    ServerSetup=700100                                                          
    TCPIP_TcpIpAddress=0,9.5.92.26                                              
    ServerName=DEMODOM/ITSO                                                     
    PhoneLog=2                                                                  
    Log=log.nsf, 1, 0, 7, 40000                                                 
    CleanSetup=1                                                                
    DB2_DBS_PER_SCHEMA=10                                                       
                                                                                
 F2=Save   F3=Save/Exit   F12=Exit   F15=Services   F16=Repeat find             
 F17=Repeat change  F19=Left  F20=Right                                                                                                                         
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4. On the Change SMTP Attributes (CHGSMTPA) display (Figure 4-18), change the 
Autostart server parameter to *NO.

Figure 4-18   Changing the autostart parameter of the i5/OS SMTP attributes

                        Change SMTP Attributes (CHGSMTPA)                       
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Autostart server . . . . . . . .   *NO           *SAME, *YES, *NO              
 Retries by minute:                                                             
   Number of retries  . . . . . .   3             0-99, *SAME, *DFT             
   Time interval  . . . . . . . .   30            0-99, *SAME, *DFT             
 Retries by day:                                                                
   Number of retries  . . . . . .   0             0-9, *SAME, *DFT              
   Time interval  . . . . . . . .   0             0-9, *SAME, *DFT              
 Retries by hour:                                                               
   Number of retries  . . . . . .   0             0-99, *SAME, *DFT             
   Time interval  . . . . . . . .   0             0-99, *SAME, *DFT             
 Retry remote name server . . . .   *NO           *SAME, *YES, *NO              
 Automatic registration . . . . .   *NO           *SAME, *NO, *YES              
   User ID prefix . . . . . . . .   QSM           Name, *SAME, *DFT             
   Address  . . . . . . . . . . .   QSMRMTAD      Name, *SAME, *DFT             
   System name  . . . . . . . . .   TCPIP Character value, *SAME, *DFT
   Alias table type . . . . . . .   *SYSTEM       *SAME, *SYSTEM, *PERSONAL     
                                                                        

More... 
 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display    
 F24=More keys                                                                                                                                                  
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4.3.2  Enabling Domino for SMTP and IMAP

You must configure the Domino server that will support the unified inbox solution for SMTP 
and IMAP support:

1. Start a 5250 emulation session and sign on with a user profile that has *ALLOBJ authority.

2. To set up SMTP and IMAP support on a Domino server, enter the following Change 
Domino Server (CHGDOMSVR) CL command as shown in Figure 4-19:

CHGDOMSVR SERVER(demodom) MAIL(*SMTP *IMAP)

Figure 4-19   Enabling the SMTP and IMAP tasks on the i5/OS Domino server

3. Start the Domino server console by entering the following Work with Domino Console 
(WRKDOMCSL) CL command:

WRKDOMCSL dominoserver

In our example, demodom is the name of the Domino server:

WRKDOMCSL demodom

4. Start the Domino SMTP task on the Domino server console:

load smtp

5.  Start the Domino IMAP task on the Domino server console:

load imap

                        Change Domino Server (CHGDOMSVR)                        
                                                                                
 Type choices, press Enter.                                                     
                                                                                
 Server name  . . . . . . . . . . > demodom                                     
                                                                                
                                                                                
                                                                                
 Additional server ID:                                                          
   ID file's password . . . . . .   *NONE                                       
 Time zone  . . . . . . . . . . .   CST           *SAME, GMT,EST,CST,MST ...    
 Daylight savings time  . . . . .   *YES *SAME, *YES, *NO              
 Web browsers . . . . . . . . . .   *HTTP *SAME, *NONE, *ALL, *IIOP...  
                                                                                
 Internet mail packages . . . . . > *SMTP         *SAME,*NONE,*ALL,*IMAP ...    
                + for more values > *IMAP                                       
 Directory services . . . . . . .   *LDAP         Character value, *SAME...     
                                                                                
 Connection services  . . . . . .   *NONE         *SAME, *DECS, *NONE           
                                                                                

More... 
 F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters   F12=Cancel      
 F13=How to use this display        F24=More keys 
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6. Verify that the SMTP and IMAP tasks are running as shown in Figure 4-20 by using the 
following Domino server console command:

show tasks

Figure 4-20   Verifying the SMTP and IMAP server tasks are running on the Domino server console

7. Press F3 (Exit) to close the Domino server console session.

                          Work with Domino Console                              
                                                Server: demodom                 
 Previous subcommands and messages:                                             
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Providing service for 9.5.92.26                        
    LDAP Server          Listen for connect requests on TCP Port:389            
    LDAP Server          Utility task                                           
    SMTP Server          Listen for connect requests on TCP Port:25             
    SMTP Server          Utility task                                           
    Agent Manager        Executive '1': Idle                                    
    IPMADDIN             Idle                                                   
    SMTP Server          Control task                                           
    IMAP Server          Listen for connect requests on TCP Port:143            
    IMAP Server          Utility task                                           
    Schedule Manager     Idle                                                   
    HTTP Server          Listen for connect requests on TCP Port:80             
 Enter a Domino subcommand.                                                     
 ===>                                                                           
                                                                                
 F3=Exit F5=Refresh F6=Print F9=Retrieve                                        
 F17=Top F18=Bottom F21=Command line 
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4.3.3  Configuring the Domino environment

In the Domino environment, you must access the Domino Directory and specify an Internet 
password and Internet e-mail address in each of the user’s Person documents:

1. Start the Lotus Notes Administration client.

2. Click the People & Groups tab (Figure 4-21) to update the user’s Person document.

Figure 4-21   Accessing the Lotus Notes user’s Person document

3. Select the user and click Edit Person. 
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4. In the Person document (Figure 4-22), click the Enter Password button to populate the 
Internet password. In the Enter HTTP Password window (inset in Figure 4-22), enter the 
password and click OK.

Figure 4-22   Entering the Notes user’s HTTP or Internet password

5. Back in the Person document, specify the Internet e-mail address by changing the Internet 
address field (Figure 4-23).

Figure 4-23   Entering the Notes user’s Internet address

6. Click the Save & Close button to save the changes to the Person document.
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4.3.4  Adding Domino and SMTP to the System i IP Telephony configuration

On the System i IP Telephony side, you must define the Domino server and SMTP service. 
Graphical user interface (GUI) administration access is required to the System i IP Telephony 
Messaging server.

To have GUI administration access to the System i IP Telephony server, you must use a 
terminal emulator for the X Window System (xterm). In the Windows environment, you can 
have xterm by using the Cygwin software. Cygwin is a Linux-like environment. It provides a 
dynamic link library (DLL) that acts as a Linux application programming interface (API) 
emulation layer on a collection of tools that provide a Linux look and feel. You can download a 
copy of the Cygwin software from the Cygwin Web site at the following address:

http://www.cygwin.com

Perform the following steps to configure and use GUI administration access to the System i IP 
Telephony server by using the Cygwin software. Then define the Domino server and the 
SMTP service to the System i IP Telephony Messaging server:

1. From a Windows command prompt, create the cygwin_installation directory:

md c:\cygwin_installation

2. Extract the contents of the cygwin.zip file to the c:\cygwin_installation directory.

3. Run the setup.exe file that is located in C:\cygwin_installation directory:

c:\cygwin_installation\setup.exe

xterm software: You can use other xterm software to access System i IP Telephony. The 
xterm software must support the SSH protocol.

Files in cygwin.zip: In the following steps, we assume that the files in cygwin.zip are 
extracted to the C:\cygwin_installation directory and the Cygwin application is installed in 
the C:\cygwin directory.

Administrative rights: You must have administrative rights in your Windows 
workstation to install Cygwin.
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4. On the Cygwin Setup window (Figure 4-24), click Next to start the Cygwin installation.

Figure 4-24   Main Cygwin Setup window

5. On the Cygwin Setup - Choose Installation Type window (Figure 4-25), select the Install 
from Local Directory option and click Next.

Figure 4-25   Cygwin Setup - Choose Installation Type window
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6. On the Cygwin Setup - Choose Installation Directory window (Figure 4-26), in the Root 
Directory field, type c:\cygwin and click Next.

Figure 4-26   Cygwin Setup - Choose Installation Directory window

7. On the Cygwin Setup - Select Local Package Directory window (Figure 4-27), in the Local 
Package Directory field, type C:\cygwin_installation and click Next.

Figure 4-27   Cygwin Setup - Select Local Package Directory window

Default Text File Type: Do not change the Default Text File Type option of Unix.
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8. On the Cygwin Setup - Select Packages window (Figure 4-28), in the first line next 
to + All, click Default. Then you see that all of the defaults turn to Install. After the 
defaults change to Install, click Next.

Figure 4-28   Cygwin Setup - Select Packages window

9. The installation process begins. During the Cygwin installation process, you see the 
installation progress on the Cygwin Setup window (Figure 4-29).

Figure 4-29   Cygwin installation progress
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10.(Optional) On the Cygwin Setup - Create Icons window (Figure 4-30), create Cygwin icons 
on the Windows Desktop and Start Menu by selecting the corresponding options. Click 
Finish to end the Cygwin setup.

Figure 4-30   Cygwin Setup - Create Icons window

11.Start the Cygwin program (cygwin.bat). Either click the icon that was created on the 
desktop, or from the Windows Start menu, select Start → All Programs → Cygwin → 
Cygwin Bash Shell. 

12.Type startx in the Cygwin window to start the X Windows System (Figure 4-31).

Figure 4-31   Cygwin - startx command
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13.On the Cygwin window (Figure 4-32), start an SSH session to the System IP Telephony 
Messaging server as user app by typing the following command:

ssh app@IP_Messsaging_system

Figure 4-32   Cygwin - SSH session

14.After you receive information about the RSA key fingerprint, type yes in response to the 
question: “Are you sure you want to continue connecting (yes/no)?” (Figure 4-33). 

Figure 4-33   Cygwin - RSA key message

15.When prompted for the app user password, enter the correct value and press Enter. The 
default password is nice.

SSH session: You must start the SSH session on the primary System i IP Telephony 
server. In our configuration, 9.5.92.66 is the System i IP Messaging primary server.
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16.After you log on to the System i IP Telephony Messaging server, set the DISPLAY 
environment variable as shown in Figure 4-34 by entering the following command:

 setenv DISPLAY IP_address_of_PC_workstation:0.0

Figure 4-34   Cygwin - setenv DISPLAY command

17.Start the System i IP Telephony GUI by entering the following command (Figure 4-35):

xattach app

Figure 4-35   Cygwin - xattach command

18.To access to the main menu, select Utilities → VM Admin as shown in Figure 4-36.

Figure 4-36   Accessing the VM Admin menu
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19. When prompted for a user ID and password as shown in Figure 4-37, enter the correct 
values. The default for Login is root and the default for Password is secret. Press Enter.

Figure 4-37   Administrator login display

20.From the Main Menu (Figure 4-38), click System Configuration to access the System i IP 
Telephony Messaging system configuration.

Figure 4-38   Accessing the System i IP Telephony Messaging system configuration

Tip: After you enter the Login information, press Enter to access the Password field. 
After you type the password, press Enter again.
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21.On the System Configuration window (Figure 4-39), click the Srvs button to add servers.

Figure 4-39   System i IP Telephony Messaging system configuration

22.As shown in Figure 4-40, for Type, select Domino to define the Domino server. Select the 
corresponding TCP/IP address of your Domino server, accept the default port of 2281, 
and use the TCP/IP address of the i5/OS VLAN. Click Save to save the changes.

Figure 4-40   Defining the Domino server to the System i IP Telephony Messaging server
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23.On the next display (Figure 4-41), for Type, select SmtpSrv to define the SMTP server. 
For Machine Address, enter the corresponding TCP/IP address of your Domino server 
that is running the SMTP service. Click Save, and then click Exit.

Figure 4-41   Defining the SMTP server to the System i IP Telephony Messaging server

4.3.5  Configuring the System i IP Messaging mailbox

If you use LDAP synchronization, System i IP Messaging user information should be already 
populated from the Domino Directory. Make sure that Firstname and Lastname of the 
System i IP Messaging mailbox are the same as for the Domino user. By using the System i 
IP Messaging Web interface, you can edit the user mailbox and add a new external e-mail 
account. For information about LDAP synchronization, see Chapter 2, “LDAP 
synchronization” on page 25.

To access to the System i IP Messaging Web interface and edit a user mailbox to create a 
new external e-mail session and password:

1. From a Web browser, enter the following URL to access the System i IP Messaging Web 
interface:

http://primary_server_IP_address

Primary System i IP Telephony Messaging server: You must have access to the 
primary System i IP Telephony Messaging server. In our example, 9.5.92.66 is the 
primary System i IP Telephony Messaging server.
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2. On the main System i IP Messaging Web page, click the IP Messaging Web 
Provisioning link as shown in Figure 4-42.

Figure 4-42   Access to the IP Messaging Web provisioning

3. On the Welcome page (Figure 4-43), enter the correct values for user name and 
password. The default User Name or Phone Number is sockroot, and the default 
Password is secret. Then click Submit.

Figure 4-43   Welcome login page
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4. On the Welcome to 3Com IP Messaging page (Figure 4-44), click Edit A Mailbox in the 
left navigation area.

Figure 4-44   Welcome to 3Com IP Messaging page

5. On the Edit Mailbox page (Figure 4-45), to configure an System i IP Messaging mailbox, 
enter the user’s mailbox number and click Submit.

Figure 4-45   Selecting a mailbox to edit
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6. On the Mailbox Preferences page (Figure 4-46), access the external e-mail options for the 
user by clicking the External Email link in the left navigation frame.

Figure 4-46   Accessing the External Email option

 

 

 

146 IBM System i IP Telephony and Integrated Collaboration



 

7. On the External Email page (Figure 4-47), click Add New to create a new external e-mail 
session for the user.

Figure 4-47   Adding a new external e-mail session
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8. On the External Email page (Figure 4-48), complete the password fields and click Save.

Figure 4-48   Entering the external e-mail password

Passwords: User passwords are not populated during LDAP synchronization. You 
must use the same password that is used in the Domino Directory Internet Password 
field of the Person document as explained in 4.3.3, “Configuring the Domino 
environment” on page 132. If you change the Internet password in the Domino 
Directory, you must change the External Email password again.
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9. After you enter and save the external e-mail password, on the External Email page 
(Figure 4-49), click View/Edit to confirm the current user’s external e-mail.

Figure 4-49   Clicking View/Edit to confirm the user’s external e-mail

10.On the External Email page (Figure 4-50), ensure that the Account Validated field is set to 
YES.

Figure 4-50   External Email Account Validated field

Account Validated field: The Account Validated field is set to NO if you did not enter 
the same password that is used in the Domino Directory Internet Password field of the 
Person document. In this case, you must retype the password. 
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4.4  Examples of integration

When integrating System i IP Telephony Messaging with Domino, no configuration is required 
on the client side to receive a voice mail or fax message. In this section, we present examples 
of integration by using the Lotus Notes client. The same integration is also possible by using 
Domino Web Access as a client.

4.4.1  E-mail of a voice mail message

To receive an e-mail of a voice mail message:

1. When receiving voice mail messages in Domino, the From field of the e-mail message 
contains the name of the caller that sent the voice mail. In addition, the Subject field 
contains the corresponding extension of the sender. See Figure 4-51. 

You must open the e-mail message to listen the voice mail. After you open the message 
for reading in the Notes client, the voice mail message is marked as listened to in the 
System i IP Messaging environment.

Figure 4-51   Received voice mail message in the Domino inbox

2. The e-mail message contains an attached WAV file with the name of message.wav as 
shown in Figure 4-52. To listen to the message, double-click the attachment icon and 
select Open.

Figure 4-52   Opening the voice mail message in Domino
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3. The operating system plays the WAV file by starting the default application that is 
associated with WAV files. As Figure 4-53 shows, the Windows system uses the Windows 
Media® Player program to play the message.wav file.

Figure 4-53   Playing the voice mail message
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4. By default, voice mail messages are marked as Unread (red color). You can change the 
status of selected read messages to unread by selecting Edit → Unread Marks → Mark 
Selected Unread as shown in Figure 4-54. Since this is a real-time synchronized solution, 
this change affects the message status in the System i IP Messaging environment. A 
message is now displayed as a new voice mail message that has not been not listened to.

Figure 4-54   Marking selected voice mail messages as unread
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5. The same real-time synchronization occurs with deleted messages. If you delete a voice 
mail message in Domino, it is deleted on the System i IP Messaging server. To delete a 
voice mail message, right-click the selected e-mail message and click Delete as shown in 
Figure 4-55.

Figure 4-55   Deleting a voice mail message

4.4.2  E-mail of an inbound fax message

In our example, we created a Lotus Notes user who is associated with a Fax extension 
(1730). We also set up a Voice over IP (VoIP) Gateway that logs into the System i IP 
Messaging server by using the fax extension number. The VoIP Gateway is connected to an 
analog fax machine, so that faxes can be routed to the user inbox by dialing the user 
extension number as the fax destination from the fax machine. 

Follow these steps:

1. When receiving fax messages in Domino, the From field contains the name of the fax 
sender, and the Subject field contains the corresponding extension of the sender as 
shown in Figure 4-56. Open the e-mail message to read the fax.

Figure 4-56   Received fax messages
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2. The e-mail message contains an attached TIF file with the name image.tif as shown in 
Figure 4-57. To see the content of the file, double-click the icon that corresponds to the 
attachment and select Open.

Figure 4-57   Opening a fax message

3. The PC workstation operating system shows the image file by starting the default 
application that is associated with TIF files. As shown in Figure 4-58, the Windows system 
is using the Windows Picture and Fax Viewer program to show the image.tif file.

Figure 4-58   Viewing a fax message
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4. Real-time synchronization occurs with deleted fax messages as well. If you delete a fax 
message in Domino, the message is deleted on the System i IP Messaging server. To 
delete a fax message, right-click the selected e-mail message and click Delete as shown 
in Figure 4-59.

Figure 4-59   Deleting a fax message

4.4.3  Domino server console messages

From the Domino server console, you can verify the integration between the Domino server 
and the System i IP Telephony Messaging server from the Domino server console:

1. The System i IP Messaging server receives a voice mail or fax and sends a message to 
the Domino server via SMTP. Domino then sends an IPMADDIN event (InboxAdd) to the 
System i IP Messaging server as shown in Figure 4-60.

Figure 4-60   Receiving a voice mail or fax message on the Domino server

                          Work with Domino Console                              
                                                Server: demodom                 
 Previous subcommands and messages:                                             
09/17/2007 11:53:57   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 11:54:57   IMAP Server: 9.5.92.66 connected                       
09/17/2007 11:54:57   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66  
09/17/2007 11:54:57   IMAP Server: Kim Greene/ITSO logged out                
09/17/2007 11:54:57   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 11:55:56   IMAP Server: 9.5.92.66 connected                       
09/17/2007 11:55:56   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66  
09/17/2007 11:55:57   IMAP Server: Kim Greene/ITSO logged out                
09/17/2007 11:55:57   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 11:56:25   SMTP Server: DEMOPRI.IPTDEMO.COM (9.5.92.66) connected 
09/17/2007 11:56:25   SMTP Server: Message 00000000 (MessageID: ) received   
09/17/2007 11:56:25   SMTP Server: DEMOPRI.IPTDEMO.COM (9.5.92.66) 
disconnected. 1 message[s] received                                                    
09/17/2007 11:56:26   Router: Message 005D0E5D delivered to Jose Faisca/ITSO 
09/17/2007 11:56:27   ipmaddin event: InboxAdd:Jose Faisca:2394:####228      
 Enter a Domino subcommand.                                                     
 ===>                                                                           
                                                                                
 F3=Exit F5=Refresh F6=Print F9=Retrieve                                        
 F17=Top F18=Bottom F21=Command line 
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2. After a message is received, the System i IP Messaging server initiates an IMAP poll with 
the Domino server. The Domino server retrieves the IMAP UID of the message and stores 
it on the System i IP Messaging server as shown in Figure 4-61.

Figure 4-61   IMAP poll

                          Work with Domino Console                              
                                                Server: demodom                 
 Previous subcommands and messages:                                             
09/17/2007 12:07:57   IMAP Server: 9.5.92.66 connected                       
09/17/2007 12:07:57   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66  
09/17/2007 12:07:57   IMAP Server: Kim Greene/ITSO logged out                
09/17/2007 12:07:57   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 12:08:57   IMAP Server: 9.5.92.66 connected                       
09/17/2007 12:08:57   IMAP Server: Markus Neuhold/ITSO logged in from 9.5.92 
09/17/2007 12:08:57    IMAP Server: Markus Neuhold/ITSO logged out                
09/17/2007 12:08:57   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 12:08:58   Accept socket connection:8                             
09/17/2007 12:08:59   IMAP Server: 9.5.92.66 connected                       
09/17/2007 12:08:59   IMAP Server: Jose Faisca/ITSO logged in from 9.5.92.66 
09/17/2007 12:09:00   IMAP Server: Jose Faisca/ITSO logged out               
09/17/2007 12:09:00   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 12:09:57   IMAP Server: 9.5.92.66 connected                       
09/17/2007 12:09:57   IMAP Server: Jairo Reyes/ITSO logged in from 9.5.92.66 
 Enter a Domino subcommand.                                                     
 ===>                                                                           
                                                                                
 F3=Exit F5=Refresh F6=Print F9=Retrieve                                        
 F17=Top F18=Bottom F21=Command line 
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3. The user opens the voice mail or fax message on the Domino server, and the Domino 
server sends an IPMADDIN event (MarkRead) to the System i IP Messaging server as 
illustrated in Figure 4-62.

Figure 4-62   User opening a voice mail or fax message on the Domino server

                          Work with Domino Console                              
                                                Server: demodom                 
 Previous subcommands and messages:                                             
09/17/2007 14:04:17   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 14:04:22   IMAP Server: 9.5.92.66 connected                       
09/17/2007 14:04:23   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66 
09/17/2007 14:04:23   IMAP Server: Kim Greene/ITSO logged out               
09/17/2007 14:04:23   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 14:05:02   Opened session for Jose Faisca/ITSO (Release 7.0.2)    
09/17/2007 14:05:17   IMAP Server: 9.5.92.66 connected                       
09/17/2007 14:05:17   IMAP Server: Jose Faisca/ITSO logged in from 9.5.92.66 
09/17/2007 14:05:18   IMAP Server: Jose Faisca/ITSO logged out               
09/17/2007 14:05:18   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 14:05:43   ipmaddin event: MarkRead:Jose Faisca:2390:####226      
09/17/2007 14:05:43   IMAP Server: 9.5.92.66 connected                       
09/17/2007 14:05:43   IMAP Server: Jairo Reyes/ITSO logged in from 9.5.92.66 
09/17/2007 14:05:43   IMAP Server: Jairo Reyes/ITSO logged out               
09/17/2007 14:05:43   IMAP Server: 9.5.92.66 disconnected                    
 Enter a Domino subcommand.                                                     
 ===>                                                                           
                                                                                
 F3=Exit F5=Refresh F6=Print F9=Retrieve                                        
 F17=Top F18=Bottom F21=Command line 
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4. The user deletes a voice mail or fax message the Domino server. The Domino server 
sends an IPMADDIN event (Delete) to the System i IP Messaging server as illustrated in 
Figure 4-63.

Figure 4-63   Deleting a voice mail or fax message in Domino

4.5  Outbound fax messages

The integration of System i IP Telephony Messaging with the Domino server only allows for 
inbound faxes. However, both inbound and outbound faxes are possible when using the IBM 
Integrated Domino Fax for i5/OS (5733-FXD) product. By using both System i IP Telephony 
Messaging and Integrated Domino Fax for i5/OS, users can receive inbound faxes via both 
systems in the same unified inbox.

The Integrated Domino Fax software enables Lotus Notes users to send and receive faxes 
directly from their Notes client by using their current telephone system and Domino 
infrastructure. Upon specifying the intended recipients in the Fax To field, it is possible to fax 
Notes messages that contain rich text and graphics or fax files that are attached to a Lotus 
Notes e-mail.

Notes users can also send faxes directly from most Windows-based applications by using the 
Print-to-Fax driver. With the Print-to-Fax driver, users can address outgoing faxes by using 
their Personal Address Books or the Domino Directory. As an alternative to sending a fax, 
Notes users can also use Domino Web Access.

                          Work with Domino Console                              
                                                Server: demodom                 
 Previous subcommands and messages:                                             
09/17/2007 14:07:08   Closed session for Jairo Reyes/ITSO Databases accessed: 1   
Documents read:     0   Documents written:     0                    
09/17/2007 14:07:35   Opened session for Kim Greene/ITSO (Release 8.0)       
09/17/2007 14:07:35   Closed session for Kim Greene/ITSO Databases accessed: 
0   Documents read:   0   Documents written:     0                     
09/17/2007 14:08:18   Opened session for Kim Greene/ITSO (Release 8.0)       
09/17/2007 14:10:41   IMAP Server: 9.5.92.66 connected                       
09/17/2007 14:10:41   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66  
09/17/2007 14:10:42   IMAP Server: Kim Greene/ITSO logged out                
09/17/2007 14:10:42   IMAP Server: 9.5.92.66 disconnected                    
09/17/2007 14:11:44   ipmaddin event: Delete:Jose Faisca:2390:####226        
09/17/2007 14:13:04   IMAP Server: 9.5.92.66 connected                       
09/17/2007 14:13:04   IMAP Server: Jairo Reyes/ITSO logged in from 9.5.92.66 
09/17/2007 14:13:05   IMAP Server: Jairo Reyes/ITSO logged out               
09/17/2007 14:13:05   IMAP Server: 9.5.92.66 disconnected                    
 Enter a Domino subcommand.                                                     
 ===>                                                                           
                                                                                
 F3=Exit F5=Refresh F6=Print F9=Retrieve                                        
 F17=Top F18=Bottom F21=Command line 
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Figure 4-64 illustrates the components of a Domino Fax deployment for an inbound and 
outbound fax.

Figure 4-64   Domino fax deployment

Domino Fax system
The Domino Fax software runs as an application on a Domino server. The Domino Fax 
system must have a fax device installed, which the Domino Fax server uses to send faxes or 
receive them from fax machines at other locations.

When a user specifies that a Notes e-mail should be sent to one or more recipients as a fax, 
the message is routed to the Domino Fax server for processing. When a fax is received on a 
System i fax device that has been configured for use with Domino Fax, the Domino Fax server 
receives the fax. The Domino Fax configuration determines where and how the fax server 
delivers the incoming faxes.

Fax Windows Services system
Before the Domino Fax server can send an e-mail as a fax, the message must be converted 
to a faxable format. This is the job of the Fax Windows Services system. The Domino Fax 
server first routes the memo to the Fax Windows Services system, where the message is 
converted to a faxable format and sent back to the Domino Fax server.

Similarly, when the Domino Fax server receives a fax, the fax must first be routed to the Fax 
Windows Services system for conversion to an appropriate format. The message is sent back 
to the Domino Fax server for final delivery.

The Fax Windows Services system is normally a stand-alone Windows workstation or server. 
If you prefer, you can use an Integrated xSeries® Server (IXS) instead.

Administrator 
workstation

Windows workstation,
manages a Domino Fax server

FAX Windows  
Services system

Windows workstation or server,
converts documents to or from 
a faxable format as request by 

the fax server

Domino Fax system  
IBM System i machine
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User perspective
After you configure these components, their existence is transparent to the user. The Domino 
Fax application on the Domino server automatically communicates with the Fax Windows 
Services system for formatting documents and with the fax hardware for sending and 
receiving documents. The user simply makes a request to send a fax.

See the IBM Integrated Domino Fax for i5/OS Web site for more information: 

http://www.ibm.com/servers/eserver/iseries/domino/related/fxd/

4.6  Troubleshooting the unified inbox

To troubleshoot the Domino unified inbox operation, you can access the following log files. 
You can use Cygwin or a Secure File Transfer Protocol (SFTP) client software to read the log 
files.

� System i IP Messaging log files

The System i IP Messaging server creates a daily log file with all message activity. The log 
files are named by date, YYYYMMDD. For example, a log file with the name 20070821 
corresponds to the log of August 21 2007.

The daily log files of the System i IP Messaging server can be found in the corresponding 
System i IP Messaging partition in the /usr/app/app.dir/vmlog.dir/ directory.

� IMAP session log file

The IMAP session log file vmpopcli.out is in the corresponding System i IP Messaging 
partition in the /usr/app/gen/ directory.

� SMTP session log file

The SMTP session log file eml_client.out is in the corresponding System i IP Messaging 
partition in the /usr/app/gen/ directory.

� Domino event log file

The Domino event log file app.out is in the corresponding System i IP Messaging partition 
in the /usr/app/gen/ directory. The Domino event log files are also displayed in the 
administration interface of the System i IP Messaging GUI.

Reading the log files
To read the log files using Cygwin:

1. Start the Cygwin program (cygwin.bat). Either click the icon that was created on the 
desktop, or from the Windows Start menu, select Start → All Programs → Cygwin → 
Cygwin Bash Shell. 

2. On the Cygwin window, start an SSH session to the System i IP Telephony Messaging 
server as user root:

ssh root@System i IP Messaging address

3. When prompted for the root user password, enter the correct value and press Enter. The 
default password is pvadmin.

More information: See 4.3.4, “Adding Domino and SMTP to the System i IP Telephony 
configuration” on page 134, for information about how to install and configure Cygwin.
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4. Read the log files by using the Linux vi editor. Enter the following command:

vi /directory of log files/name of log file

For example, to read the System i IP Messaging log file 20070821 as shown in 
Figure 4-65, enter the following command:

vi /usr/app/app.dir/vmlog.dir/20070821

Figure 4-65   Reading a log file in Cygwin

5. To quit the Linux vi editor, type :q as shown in Figure 4-66 and press Enter.

Figure 4-66   Ending the Linux vi editor
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Chapter 5. VCX IP Telephony Web Services 
SDK for System i

In this chapter, we provide guidance on using the VCX IP Telephony Web Services SDK for 
System i in the context of a Lotus Domino environment on i5/OS. We discuss the following 
topics:

� “SDK overview” on page 164
� “Testing the IP Telephony Web services” on page 170
� “Using the SDK toolkit in Domino Designer” on page 176

5
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5.1  SDK overview

With the VCX IP Telephony Web Services SDK for System i, systems integrators, 
independent software vendors (ISVs), and application developers can embed IP Telephony 
logic into their business and collaboration applications by using the available application 
programming interface (API). This SDK toolkit allows the development of simple code 
enhancements for phone call control and configuration tasks without complex Computer 
Telephony Integration (CTI) middleware or detailed knowledge of protocols, phone 
infrastructure, or telecommunications networks.

The SDK toolkit includes the following components:

� VCX Web Services API
� SDK User’s Guide
� W3C standards-based Web Service Definition Language (WSDL) documentation
� Samples of commented code in Java and .Net

Web services are the basis of distributed computing across the Internet. They provide a 
standard method of communicating between diverse software applications running on 
different platforms. The VCX Web Services API provides a platform-neutral and programming 
language-independent approach to application integration. Developers can interact with the 
IP Telephony system from any programming language that can initiate Web services requests 
by using the provided 3CW open standard WSDL document.

With the VCX Web Services API, you have high-level access to a set of communications 
functions such as phone status, call control, and phone configuration, which enable business 
and telephony applications to work together to deliver business process improvements. For 
example, a Lotus Notes agent can be initiated from within an existing business application by 
using telephone contact information that stored in a Domino database.

All requests to the interface require client applications to present their authentication 
credentials in a valid security header. The applications do this by using the Web services 
security standard to ensure that only authorized applications can invoke telephony features.

The System i IP Telephony software is installed and runs on a dedicated System i Linux 
partition, allowing remote applications to use the Web Services API. The request types 
supported by this API fall into three categories:

� Call control

– Initiate a phone call
– Transfer a call
– Conference call
– Hold call
– End call

� Phone configuration

– Enable hands free operation
– Mute phone
– Enable/disable do not disturb (DND)
– Enable/disable forward of voice mail

� Phone status

– Get phone state
– Get DND state
– Get voice mail state
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5.1.1  Obtaining the SDK toolkit

Access to the SDK toolkit is managed from the following 3Com Open Network Web site, 
which provides support to developers using these tools:

http://open.3com.com

On the 3Com Open Network Web site, you must register in order to log in. After you log in, 
click the Developer ToolKit link in the left navigation frame and then click the VCX IP 
Telephony Web Services SDK for IBM System i link in the right pane (Figure 5-1). 

Figure 5-1   Obtaining the SDK toolkit from the 3Com Open Network Web site

Download the SDK .zip file to a directory that is accessible to your workstation and extract the 
file. The SDK toolkit includes the following contents:

� /lib folder with the Web Services API Java archive (JAR) files

� /samples folder with the source files and the class files of the sample application and its 
corresponding build files

� /docs folder with the PDF of the user guide and a wsdldoc.zip file that contains the 
applicable reference documentation for the WSDL

� /resources folder with the WSDL files

� /RunSample.bat file that runs the Java sample application
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5.1.2  Prerequisites

To fully benefit from the information provided in this chapter, you must have this environment:

� A working System i IP Telephony solution installed and available with IP Telephony phones 
and hardware

� Domino Designer 8 as an integrated development environment (IDE) for running, 
examining, and modifying the example

� Java Runtime Environment version 1.5 or later

� soapUI version 1.75 or later

� VCX IP Telephony Web Services SDK for System i version 7.2.72.1 or later

5.1.3  SDK documentation

The SDK documentation includes the PDF file of the user guide and HTML files that describe 
each Web service endpoint with the required input and output parameters. To access and use 
this documentation:

1. Navigate to the /docs directory that you extracted on your workstation, extract the 
wsdldoc.zip file, and open the expanded index.html file. The document tree is displayed for 
all the Web service capabilities that are included in the SDK toolkit as shown in Figure 5-2.

Figure 5-2   HTML Web Services documentation
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2. To understand the Web service parameters that are needed to execute a call control 
request, in the left navigation frame, click callControlRequest of the index.html page, and 
then in the right pane, click the callControlRequest link as shown in Figure 5-3. 

Figure 5-3   Parameters for a call control request
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3. The documentation shows the parameters that are required to invoke a call control 
request of the Web service. You can see that the first parameter is the actionType, the 
second parameter is credentials, the third parameter is destinationNumber, and the fourth 
parameter is serviceValidator. 

To further determine the action types that are available, click the CallControlActionType 
link in the main frame (Figure 5-4).

Figure 5-4   Selecting CallControlActionType
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Figure 5-5 shows all the allowable action types, including makeCall and transferCall.

Figure 5-5   The allowed action types

By using the SDK toolkit, a programmer can access the specific capabilities that are exposed 
such as controlling the calls. These capabilities are exposed externally through the WSDL 
Web services definition language XML file. By using this documentation, the programmer can 
determine the parameters that are required for any of the Web service endpoints that are 
provided by the IP Telephony Web service.
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5.2  Testing the IP Telephony Web services

In this section, we describe the steps to test the IP Telephony Web Services by using the 
sample Java program that is provided by the SDK toolkit and by using the soapUI program.

5.2.1  Testing by using the SDK Java sample program

A sample Java program with source code is included as part of the SDK toolkit. The test client 
demonstrates usage of the generated Java stubs and basic interaction with the IP Telephony 
Web Service.

Perform the following steps:

1. Download and extract the SDK .zip file to a directory that is accessible to your workstation. 

The sample code is located in the IPTelephonySDK\Samples\java\src\com\coms
\ws\IPTelephonySample directory. The client Java stubs have been compiled in the 
IPTelephonyServiceClient.jar and WSSecurity.jar files and placed into the 
IPTelephonySDK\lib directory.

2. To run the sample program, execute the RunSample.bat file that is provided as part of the 
SDK toolkit and located at the SDK root directory.

3. In the IP Telephony Sample App window (Figure 5-6 on page 171), you must have entered 
all the required parameters before you can invoke a call control request, a phone 
configuration request, or a phone state request. If the required parameters are not entered 
or incorrect values are entered, then appropriate error messages are displayed in the 
Messages area.

Change the Web Service URL field to be the URL of your System i IP Telephony service. 
Replace the following URL with the host name of your System i IP Telephony:

http://localhost/axis2/services/IPTelephonyService

In our example, we enter the following URL:

http://9.5.92.66/axis2/services/IPTelephonyService

The URI portion remains the same as /axis2/services/IPTelephoneService. For the 
Security Header fields of Username and Password, the shipped defaults are wsuser and 
wspwd respectively. Enter the Origination Number, Phone Password, and Destination 
Number that are specific to your configuration. In our example, we tested the originator 
number 1703 by calling destination number 1705.

4. Click the Make Call button to invoke a call control request (makeCall). A call is established 
between the originator number and the destination number. A success message is 
displayed in the Messages area.
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Figure 5-6   GUI of the Java SDK toolkit sample program

5.2.2  Testing by using the soapUI program

The soapUI program is a software testing tool for the software developer to use in the 
service-oriented architecture (SOA). A free software version is available and is distributed 
under the terms of the GNU Lesser General Public License. We used this software to inspect, 
invoke, and test the IP Telephony Web Services. You can obtain the soapUI software from the 
following Web address:

http://www.soapui.org/

To test IP Telephony Web services by using the soapUI program:

1. Download and install the open source version of the soapUI software.

2. Start the soapUI software.

3. Modify the IP Telephony WSDL file. The WSDL file (/resources/IPTelephonyService.wsdl) 
for the Web service is available in the SDK .zip file. The SDK toolkit comes with the 
service endpoint set to the following URL:

http://localhost/axis2/services/IPTelephonyService/
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You can change URL to be the URL of your System i IP Telephony system:

a. Edit the IPTelephony.wsdl file by using a text editor and find the section that starts with 
<wsdl:service name="IPTelephonyService">.

b. Change the line that starts with <soap:address location="http://…". Change the 
value of the location property to contain your IP Telephony server address, for example: 

<soap:address location="http://9.5.92.66/axis2/services/IPTelephonyService/"/>

c. Save the WSDL file changes in a new file called iptdemo_IPTelephonyService.wsdl.

4. In the soapUI program, create a new WSDL project by selecting File → New WSDL 
Project as shown in Figure 5-7.

Figure 5-7   soapUI - Creating a new WSDL project
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5. In the New WSDL Project window (Figure 5-8):

a. For Project Name, type iptdemo. 

b. Click Browse to open the newly created iptdemo_IPTelephonyService.wsdl file.

Figure 5-8   soapUI - Opening the WSDL file

c. In the New WSDL Project window (Figure 5-9), select the Create sample requests for 
all operations option and click OK.

Figure 5-9   soapUI- Create request option
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6. In the Create Project window (Figure 5-10), save the project as 
iptdemo_IPTelephony-soapui-project.xml, so that you can reuse the project.

Figure 5-10   sopaUI - Saving the WSDL project

7. On the project Request Properties details tab (Figure 5-11), enter the Web Services user 
name and password. The default for Username is wsuser, and the default for Password is 
wspwd. Select PasswordText as the WSS-Password Type.

Figure 5-11   soapUI - Request properties
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8. On the iptdemo project (Figure 5-12), click CallControlRequest → Request 1.

Figure 5-12   soapUI - Selecting CallControlRequest

9. In the CallControlRequest - Request 1 window, on the SOAP Request tab, change the 
SOAP message by changing the content of the actionType, originNumber, 
destinationNumber, and serviceValidator fields as shown in Figure 5-13.

In this example, we invoke a call control request (makeCall). We tested the originator 
number 1703 by calling destination number 1705.

Figure 5-13   soapUI - SOAP request message

Originator number: The originator number password is optional. If you do not use it, 
you must remove any space or character from the field.

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:ipt="http://ws.coms.com/iptelephony/">
   <soapenv:Header/>
   <soapenv:Body>
      <ipt:callControlRequest>
         <ipt:actionType>makeCall</ipt:actionType>
         <ipt:credentials>
            <ipt:originNumber>1703</ipt:originNumber>
            <!--Optional:-->
            <ipt:password></ipt:password>
         </ipt:credentials>
         <!--Optional:-->
         <ipt:destinationNumber>1705</ipt:destinationNumber>
         <ipt:serviceValidator APIVersion="?">V1</ipt:serviceValidator>
      </ipt:callControlRequest>
   </soapenv:Body>
</soapenv:Envelope>
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10.After you enter the correct values in the SOAP message content, click the Submit button 
(green arrow icon) on the SOAP Request tab (Figure 5-14) to submit the request to the 
specific endpoint URL.

Figure 5-14   soapUI - Submitting the SOAP request

11.A call is established between the originator number and the destination number. You see 
Success on the SOAP Response tab as shown in Figure 5-15.

Figure 5-15   soapUI - SOAP response message

5.3  Using the SDK toolkit in Domino Designer

In this section, we explain how to get the SDK toolkit into the Domino Designer 8 development 
environment so that you can programmatically integrate and build applications to exploit the 
IP Telephony services. 

Domino version 7.0 introduced the Web Service design element, so that you can write a Web 
service and host it on your Domino server in order for it to be called from other computers.

Domino version 8.0 introduced Web service consumers, so that you can call Web services that 
are hosted elsewhere. A Web service consumer does not use a Web Service design element, 

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
   <soapenv:Header/>
   <soapenv:Body>
      <ns646:callControlResponse 
xmlns:ns646="http://ws.coms.com/iptelephony/">Success</ns646:callControlRespons
e>
   </soapenv:Body>
</soapenv:Envelope>
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which is only used for hosting Web services. Instead, it employs a special kind of script library 
by using either LotusScript® or Java. To call the Web service, an agent or other code must 
“use” that script library.

A Web service consumer uses standard Web protocols, such as XML, SOAP, and HTTP, to 
connect to a Web service provider and invoke the functionality that it provides. The ability to 
define a Web service consumer enables application developers to use and reuse common 
Web service-based components in their applications. This can help speed the time to develop 
applications and eliminate duplication of code that provides identical functionality.

A Lotus Notes agent client (Web service consumer) sends service requests to the server of 
the System i IP Telephony Web service. An example of a request is to make a call. To make a 
request, the Notes agent calls a method, such as makeCall, on the client-side service stub 
that was generated by the SOAP toolkit. The client-side SOAP framework then sends a SOAP 
request to the service. Each request is processed by the service. After the request is 
completed, the service sends either a response (with a “success” or any other message 
returned) or a SOAP fault.

Each service request is acknowledged with a service response. The results of the request are 
reported in the service response. In some cases, response to a request may result in an error. 
Theses errors are indicated through SOAPs faults. Service responses are returned in the 
form of objects by the service request method on the client-side stubs that are generated by 
your SOAP framework.

5.3.1  Creating a Web service-enabled Java script library with WSDL

By using a Java script library, you can define common classes that you can then access from 
any Java agent. Each created Web service-enabled script library, or Web service consumer, 
contains a single Web service, as defined by a single WSDL document. To create a Web 
service-enabled Java script library from the SDK WSDL document, perform the following 
steps:

1. Change the provided SDK WSDL document according to the URL of your System i IP 
Telephony system as explained in 5.2.2, “Testing by using the soapUI program” on 
page 171.

2. From the Domino Designer client, click Create → Design → Script Library.

3. Select Java Library. The programmer’s pane displays the empty script in the Work pane.

4. To name the library, right-click and select Script Library Properties.

5. Click the WSDL button, which is available in both Web service-enabled script libraries and 
the newly created script libraries. After you Web enable a script library, you cannot 
unenable it.

6. Select Import WSDL and click OK to overwrite the script library.

Web service consumers: In Domino version 7.0 and earlier versions, you can write your 
own Web service consumers in Java, but Domino Designer does not assist you in doing so.

Unique library name: Each library in a database must have a unique name. 
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7. Select the WSDL document to be imported as shown in Figure 5-16. In our example, the 
WSDL file is iptdemo_IPTelephonyService.wsdl. Click Open.

Figure 5-16   Domino Designer - selecting WSDL file to import

8. Select File → Save, and then select File → Close to save and close the library.

After the WSDL file is imported into a script library, you can use it in a Lotus Notes application 
as shown in the Java code example in Figure 5-17 on page 179. 

The Import WSDL operation creates the Java code that represents the service that is 
described in the WSDL document. The code that is generated, including the names of 
classes, fields, their types, and functions or substitutes are all derived from the WSDL 
document. The Import WSDL operation generates one or more PortType classes and can 
generate any number of Value type classes.

In the IP Telephony scenario, the Web service provider has methods to interact with the 
telephony system. Note that the script library contains only back-end classes. The Web 
service messages have no UI implementation. Therefore, the script library can be used with 
the Lotus Notes 8 client and the Domino 8 server. Also the Web service location may be part 
of the WSDL that you imported as in our example.

More information: See 5.3.2, “Creating a Web service consumer using Web Services API 
JAR files” on page 179, to learn how to create a Java agent and incorporate the Java script 
library. 
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Figure 5-17   Lotus Notes agent Java code example using a generated WSDL Java script library

5.3.2  Creating a Web service consumer using Web Services API JAR files

As an alternative to creating the Java script library with the WSDL, you have the option to 
create the Java script library by using the Web Services API JAR files and program a Web 
service consumer from there. In this section, we present the following tasks:

� “Creating a Java script library” on page 180
� “Creating a Java agent” on page 181
� “Incorporating the Java script library into the Java agent” on page 184
� “Compiling and saving the Java agent” on page 185
� “Running the Java agent” on page 186

Note: In the code example, locator.getIPTelephonyService() represents the URL of the 
System i IP Telephony Web services, for example:

http://9.5.92.66/axis2/services/IPTelephonyService

You need to see the contents of the IPTelephonyService_Port.java file in the Java script 
library that is generated by the WSDL for methods that you can call.

import lotus.domino.*;
import lotus.domino.types.PortTypeBase;
import com.coms.ws.iptelephony.*;
import com.coms.ws.wssecurity.*;

public class JavaAgent extends AgentBase {

public void NotesMain() {

try {
Session session = getSession();
AgentContext agentContext = session.getAgentContext();

IPTelephonyService_ServiceLocator locator = new 
IPTelephonyService_ServiceLocator();

IPTelephonyService_Port service = locator.getIPTelephonyService();
     

// Your code goes here... 

} catch(Exception e) {
e.printStackTrace();

}
}

}

 

 

 

Chapter 5. VCX IP Telephony Web Services SDK for System i 179



 

Creating a Java script library
To create a Java script library in Domino:

1. From the Domino Designer client, click Create → Design → Script Library.

2. Select Java Library. The programmer’s pane displays the empty script in the Work pane.

3. To name the library, right-click and choose Script Library Properties. For example, use 
IPTelePhonySDK as the library name.

4. Click the Edit Project button.

5. In the Organize Script Library Files window (Figure 5-18):

a. Navigate to the SDK \lib base directory that contains the JAR files. 
b. For Show file types, select the All option to show all file types.
c. Click the Add/Replace All button. 
d. Click OK.

Figure 5-18   Domino Designer - Adding the JAR files

6. Select File → Save and then select File → Close to save and close the library.
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Creating a Java agent
To create a Java agent in Domino:

1. From the Domino Designer client, select Create → Design → Agent.

2. In the Agent Properties window (Figure 5-19), for Name, type mCall, and for the Runtime 
Target option, select None.

Figure 5-19   Agent properties tab

3. In the Agent Properties window, click the Security tab (Figure 5-20). For Set runtime 
security level, select option 2. Allow restricted options. Close the Agent properties 
window.

Figure 5-20   Agent security properties
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4. The programmer’s pane shows the empty script in the Work pane. Select Java as the 
agent type and code the example as shown in Figure 5-21 and Figure 5-22 on page 183.

Figure 5-21   Notes agent Java code example using the SDK JAR files library (part 1 of 2)

import lotus.domino.*;
import lotus.domino.types.PortTypeBase;
import com.coms.ws.iptelephony.*;
import com.coms.ws.iptelephony.IPTelephonyServiceStub;
import com.coms.ws.iptelephony.IPTelephonyServiceStub.*;
import com.coms.ws.wssecurity.*;
import org.apache.axis2.client.ServiceClient;

public class JavaAgent extends AgentBase {
public void NotesMain() {

try {
Session session = getSession();
AgentContext agentContext = session.getAgentContext();

// * Variables * // 
Database db = agentContext.getCurrentDatabase();
DateTime dt = session.createDateTime("Today");
String u = session.getUserName();  
String ipAddress = "http://9.5.92.66/axis2/services/IPTelephonyService/";
String username = "wsuser";
String appPasswd = "wspwd";
String origination = "1703";
String phonePasswd = null;
String destination = "1705";    
//   * Send the Call Control request *  //   
// build request body
ActionCredentials cred = new ActionCredentials();
cred.setOriginNumber(origination);
cred.setPassword(phonePasswd);
ServiceType ver = new ServiceType();
ver.setString("Version");
ver.setAPIVersion("V1");
CallControlRequest req = new CallControlRequest();
req.setActionType(CallControlActionType.makeCall);
req.setCredentials(cred);
req.setDestinationNumber(destination);
req.setServiceValidator(ver);
// init the client
IPTelephonyServiceStub stub = new IPTelephonyServiceStub (ipAddress);
ServiceClient serviceClient = stub._getServiceClient();
// build security header
SecurityType sec = new SecurityType(username, appPasswd);
serviceClient.addHeader(sec.toElement());
// execute the request
CallControlResponse response = stub.callControlRequest(req);
ActionResultType resultType = response.getCallControlResponse();
//*  print  *//
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Figure 5-22   Notes agent Java code example using the SDK JAR files library (part 2 of 2)

System.out.println("Date = " + dt);
System.out.println("User name = " + u);
System.out.println("Database = " + db);
System.out.println("Web Service URL =  " + ipAddress);
System.out.println();
System.out.println("Security Header :");
System.out.println("Username =  " + username);
System.out.println("Password =  " + appPasswd);
System.out.println();
System.out.println("Payload Body :");
System.out.println("Origination Number =  " + origination);
System.out.println("Phone Password =  " + phonePasswd);
System.out.println("Destination Number =  " + destination);
System.out.println();
System.out.println("Messages :");
System.out.println(resultType);
System.out.println();

} catch(Exception e) {
e.printStackTrace();

}
}

}
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Incorporating the Java script library into the Java agent
To use the Java script library in the Java agent:

1. From the Java agent programmer’s pane, click Edit Project.

2. In the Organize Java Agent Files window (Figure 5-23):

a. In the Browse field, select Shared Java Libraries. 
b. Select IPTelephonySDK as the library you want to include. 
c. Click Add/Replace File(s) and the library displays in the Current Agent Files list. 
d. Click OK.

Figure 5-23   Incorporating the Java script library
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Compiling and saving the Java agent
To compile and save the Java agent:

1. From the Java agent programmer’s pane (Figure 5-24), click Compile and select Compile 
JavaAgent.java to compile the Java agent.

2. Verify the error messages. If the compilation had no problems, you see a “Successful 
compile” message.

3. Select File → Save and then File → Close to save and close the Java agent.

Figure 5-24   Compiling the Java agent
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Running the Java agent
To run the Java agent:

1. From the Domino Designer client, select Tools → Show Java Debug Console.

2. In the agent’s database list (Figure 5-25), right-click the saved agent mCall and select 
Run.

Figure 5-25   Running the Java agent

3. In the Java Console window (Figure 5-26), you see the messages of the Java agent. Click 
Close after you read the messages.

Figure 5-26   Java Console messages
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When you run the application, the Java code calls the specified method in the script library, 
passing it the value from the defined variables (ipAddress, username, appPasswd, 
origination, destination, phonePasswd, and destination).

The Web service consumer sends a request to the Web service provider. The request is a 
SOAP message that is transported through HTTP and includes the variables. The System i IP 
Telephony Web service performs its operations and provides the response to the Web service 
consumer as a SOAP message that contains the return value of the operation. The return 
value is that of the method in the script library.

In our example we invoke the makeCall method. This method attempts to place a call from an 
origination phone to a destination phone (extension 1703 calling extension 1705). The origin 
phone (the invoker) must be a supported 3Com handset connected to a System i IP 
Telephony system. The destination phone can be any telephony (IP/PSTN) endpoint. 
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Appendix A. Default passwords for the 
System i IP Telephony server

In Table A-1 of this appendix, we list the default passwords that are used by the System i IP 
Telephony, Messaging, and Conferencing servers and the SDK Toolkit Web services 
software. 

Table A-1   Default passwords for System i IP Telephony, Messaging, and Conferencing users

A

Tip: In a production environment, always change the default passwords. The best time to 
do this is at the initial setup of your servers and services.

User name Default 
password

Description

root pvadmin Linux root access

oracle oracle Oracle® Database administration access

tomcat tomcat Web server administration access

cworks cworks System i IP Telephony, Messaging, and Conferencing maintenance

vcx vcx System i IP Telephony, Messaging, and Conferencing maintenance

app nice System i IP Messaging application access

admin besgroup System i IP Telephony central management Web console access

sockroot secret System i IP Messaging Web root access

root (VM admin) secret System i IP Messaging Voice Mail administration (Xterminal interface) access

root root System i IP Conferencing Web administration access

17xx 12345 Phone extensions phone logins

Weblogin user name 12345 System i IP Messaging Web user interface

wsuser wspwd SDK Toolkit Web services access
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Appendix B. System i IP Telephony and 
Messaging server settings

In this appendix, we describe the server configuration of the IBM System i IP Telephony test 
environment that we used to test IBM System i IP Telephony and Integrated Collaboration. 
Refer to 1.5, “Solution architecture” on page 18, for more detail. We describe the following 
servers for the configuration:

� DEMOPRI, the primary System i IP Telephony and Messaging server
� DEMOSEC, the secondary System i IP Telephony and Messaging server

B
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Settings for DEMOPRI, the primary System i IP Telephony and 
Messaging server

In Figure B-1 through Figure B-13 on page 197, we show the configuration settings of the 
primary server, DEMOPRI, which was used in our test environment. Several configuration 
steps are run only on the primary System i IP Telephony server including call record services, 
global voice mail, and Lightweight Directory Access Protocol (LDAP) synchronization.

To display your configuration, log on to your primary System i IP Telephony and Messaging 
partition by using the root user. Use the following commands to prompt the settings and 
display the output file:

vcx-config-services -show >services.txt 
vi services.txt

Common parameters

Figure B-1   Common parameters on the primary System i IP Telephony server

Accounting service parameters

Figure B-2   Accounting service parameters on the primary System i IP Telephony server

---------------------- Displaying Common Parameters -----------------------
Configuration Type                                      : all_pri             
Site Identifier                                         : 1                   
Site Name                                               : HQ                  
Customer Name                                           : 3Com Customer       
European Date Order                                     : N                   
Global Messaging In Use                                 : N                   
Enable Adhoc Conference Service                         : Y                   
SIP Default Dialing Domain                              : 1.1.1.1             
Secondary Call Processor                                : 9.5.92.67           
Secondary Provisioning/Web Services                     : 9.5.92.67           
Secondary Auth & Dir Service                            : 9.5.92.67           
Secondary IP Messaging Service                          : 9.5.92.67           
Primary Media Gateway                                   : 9.5.92.68           
Secondary Media Gateway                                 : (none)              
Enable Call Records Service                             : Y 

---------------------- Displaying Accounting Service ----------------------
Local IP Address                                        : 9.5.92.66           
Site Type                                               : rocsa 
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Adhoc conference service parameters

Figure B-3   Adhoc conference service parameters on the primary System i IP Telephony server

Call records service parameter

Figure B-4   Call records services parameter on the primary System i IP Telephony server

Call processor parameters

Figure B-5   Call processor parameters on the primary System i IP Telephony server

------------------- Displaying Adhoc Conference Service -------------------
Enable Adhoc Conference Service                         : Y                   
Adhoc IP Address                                        : 9.5.92.66           
Port reservation per conference                         : 4                   
Maximum number of conference ports                      : 30                  
Prefer G.711 codec                                      : Y                   
Adhoc IP port                                           : 5062                
Adhoc min RTP port                                      : 20000               
Adhoc max RTP port                                      : 20100 

--------------------- Displaying Call Records Service ---------------------
Enable Call Records Service                             : Y 

Hidden lines: Lines 6 to 22 are for trusted addresses and are not displayed as shown in 
Figure B-5.

------------------------ Displaying Call Processor ------------------------
Table 'CcCfg':
   SignallingIpAddr  
 1 9.5.92.66         
Table 'CcTrusted':
   TrustedAddress     Netmask           
 1 9.5.92.66          255.255.255.255   
 2 9.5.92.67          255.255.255.255   
 3 9.5.92.68          255.255.255.255   
 4 (none)             255.255.255.255   
 5 (none)             255.255.255.255   
 :
23 (none)             255.255.255.255   
24 (none)             255.255.255.255   
Table 'AcctServer':
   IpAddress         
 1 9.5.92.66         
 2 9.5.92.67         
Table 'AuthServer':
   IpAddress         
 1 9.5.92.66         
 2 9.5.92.67         
Table 'AdhocServer':
   ConferenceServerIp Adhoc Conf Port   
 1 9.5.92.66          5062 
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Common agent parameters

Figure B-6   Common agent parameters on the primary System i IP Telephony server

Phone downloader parameters

Figure B-7   Phone downloader parameters on the primary System i IP Telephony server

Firewall parameters

Figure B-8   Firewall parameters on the primary System i IP Telephony server

IP Telephony Web services parameters

Figure B-9   IP Telephony Web services parameters on the primary System i IP Telephony server

------------------------- Displaying Common Agent -------------------------
Local IP Address                                        : 9.5.92.66           
Site Type                                               : rocsa               
Trap Destination                                        : (none)              
Trap Community String                                   : public              
Table 'addonCaCfgTrapDestTable':
   Trap Destination   caCfgTrapDestCommu
 1 (none)             public            
 2 (none)             public            
 3 (none)             public            
Write Community String                                  : private             
Read Community String                                   : public              
Enable management station authentication?               : N                   
Table 'caCfgAuthAccTable':
   Authorized Address Netmask           
 1 (none)             255.255.255.255   
 2 (none)             255.255.255.255   
 3 (none)             255.255.255.255   
 4 (none)             255.255.255.255 

----------------------- Displaying Phone Downloader -----------------------
Local Interface Name                                    : eth0                
Local Ip Address                                        : 9.5.92.66 

--------------------------- Displaying Firewall ---------------------------
Primary Call Processor IP Address                       : (none)              
Secondary Call Processing IP Address                    : (none)              
Primary Provisioning/WebServices IP Address             : (none)              
Secondary Provisioning/WebServices IP Address           : 9.5.92.67           
Secondary Auth & Dir IP Address                         : 9.5.92.67 

------------------ Displaying IP Telephony Web Services -------------------
Primary Call Processor IP Address                       : 9.5.92.66           
Secondary Call Processing IP Address                    : 9.5.92.67           
Primary Auth & Dir IP Address                           : 9.5.92.66           
Secondary Auth & Dir IP Address                         : 9.5.92.67           
Local IP Address                                        : 9.5.92.66           
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Provisioning services parameters

Figure B-10   Provisioning service parameters on the primary System i IP Telephony server

System accounts

Figure B-11   System accounts on the primary System i IP Telephony server

--------------------- Displaying Provisioning Service ---------------------
Authentication & Directory Hostname                     : 9.5.92.66           
Site Identifier                                         : 1 

---------------------------- Displaying System ----------------------------
Table 'Accounts':
   Account            Enabled            Password           Shell             
 1 root               Y                  (encrypted)        /bin/bash         
 2 oracle             Y                  (encrypted)        /bin/bash         
 3 tomcat             Y                  (encrypted)        /bin/bash         
 4 cworks             Y                  (encrypted)        /bin/bash         
 5 vcx                Y                  (encrypted)        /bin/bash         
 6 app                Y                  (encrypted)        /bin/tcsh 
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IP Messaging service parameters

Figure B-12   IP Messaging service parameters on the primary System i IP Telephony server

--------------------- Displaying IP Messaging Service ---------------------
IPMS IP address                                         : 9.5.92.66           
IPMSG System Type                                       : primary             
Site Id                                                 : 1                   
Number of VoIP ports                                    : 120                 
Is this a Global Messaging configuration?               : N                   
Outbound call processor IP address                      : 9.5.92.66           
Secondary outbound call processor IP address            : 9.5.92.67           
Name of the SIP DDD                                     : 1.1.1.1             
TCP/UDP Port on which the IPMS will receive SIP messages: 5065
Alias for hostname                                      : demopri             
Is Intelligent Mirroring enabled?                       : Y                   
Hostname of peer IP Messaging system                    : demosec             
IP address of peer IP Messaging system                  : 9.5.92.67           
Is this host the primary or the secondary?              : P                   
Should European date order be used?                     : N                   
Customer name                                           : Customer ABC
Is Global Voicemail enabled?                            : N                   
Is this a Central Server for Global Voicemail?          : N                   
Table 'GlobalVMCentralServers':
   GlobalVMServIp    
 1 (none)            
Is Message Archival enabled?                            : N                   
Archival Server IP address                              : (none)              
User name for sftp to Archival Server                   : (none)              
Password for sftp to Archival Server                    : (none)              
Archival Server directory                               : (none)              
Enable data backup server for IPMS?                     : N                   
Backup Server IP address                                : (none)              
User name for sftp to Backup Server                     : (none)              
Password for sftp to Backup Server                      : (none)              
Backup Server Directory                                 : (none)              
Enable VCX subscriber bulk import?                      : Y                   
VCX Auth & Dir Service IP address                       : 9.5.92.66           
User name for access to Auth & Dir Server               : cworks              
Password for access to Auth & Dir Server                : cworks              
Enable NBX subscriber bulk import?                      : N                   
Is Text To Speech (TTS) enabled?                        : N                   
Table 'TtsServers':
   IP Address        
 1 (none)            
 :
4 (none)            
TTS port number                                         : 1722                
Will this system support IPMSG client systems?          : N                   
Table 'IPMsgClients':
   Client IP Address  Client Hostname   
 1 (none)             (none)            
:
20 (none)             (none) 
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Authentication and directory service parameters

Figure B-13   Authentication and directory service parameters on the primary System i 
IP Telephony server

Settings for DEMOSEC, the secondary System i IP Telephony 
and Messaging server

In Figure B-14 on page 198 through Figure B-26 on page 203, we show the configuration 
settings of the secondary server, DEMOSEC, which was used in our test environment.

To display your configuration, log on to your secondary System i IP Telephony and Messaging 
partition by using the root user. Use the following commands to prompt the settings and 
display the output file:

vcx-config-services -show >services.txt 
vi services.txt

---------------------- Displaying Auth & Dir Service ----------------------
Local IP Address                                        : 9.5.92.66           
Site Identifier                                         : 1                   
Site Name                                               : HQ                  
Site Type                                               : rocsa               
Primary Call Processor IP Address                       : 9.5.92.66           
Secondary Call Processor IP Address                     : 9.5.92.67           
Is IPMS configured for Global Messaging?                : N                   
Primary IP Messaging service IP Address                 : 9.5.92.66           
Secondary IP Messaging service IP Address               : 9.5.92.67           
Enable Replication                                      : Y                   
Is this the Master Definition Site?                     : Y                   
ROCSA IP Address                                        : (none)              
Login Username                                          : cworks              
Login Password                                          : (encrypted)         
Enable System Speed Dial Master?                        : Y                   
Enable LDAP Synchronization                             : Y                   
LDAP Server                                             : 9.5.92.26           
LDAP Server Port Number                                 : 389                 
LDAP Server Username                                    : CN=Domino 
Administrator,O=ITSO            
LDAP Server Password                                    : (encrypted)         
LDAP Base DN                                            : O=ITSO              
LDAP Synchronization Interval (seconds)                 : 1800
LDAP Server Non-VCX User Identifier                     : non-VCX user        
---------------------------------------------------------------------------
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Common parameters

Figure B-14   Common parameters on the secondary System i IP Telephony server

Accounting service parameters

Figure B-15   Accounting service parameters on the secondary System i IP Telephony server

Adhoc conference service parameters

Figure B-16   Adhoc conference service parameters on the secondary System i IP Telephony server

Call records service parameter

Figure B-17   Call records service parameter on the secondary System i IP Telephony server

---------------------- Displaying Common Parameters -----------------------
Configuration Type                                      : all_sec             
Site Identifier                                         : 1                   
Site Name                                               : HQ                  
Customer Name                                           : 3Com Customer       
European Date Order                                     : N                   
Global Messaging In Use                                 : N                   
Enable Adhoc Conference Service                         : Y                   
SIP Default Dialing Domain                              : 1.1.1.1             
Primary Call Processor                                  : 9.5.92.66           
Primary Provisioning & Web Services                     : 9.5.92.66           
Primary Auth & Dir Service                              : 9.5.92.66           
Primary IP Messaging Service                            : 9.5.92.66           
Primary Media Gateway                                   : 9.5.92.68           
Secondary Media Gateway                                 : (none)              
Enable Call Records Service                             : N 

---------------------- Displaying Accounting Service ----------------------
Local IP Address                                        : 9.5.92.67           
Site Type                                               : rocsa 

------------------- Displaying Adhoc Conference Service -------------------
Enable Adhoc Conference Service                         : Y                   
Adhoc IP Address                                        : 9.5.92.67           
Port reservation per conference                         : 4                   
Maximum number of conference ports                      : 30                  
Prefer G.711 codec                                      : Y                   
Adhoc IP port                                           : 5062                
Adhoc min RTP port                                      : 20000               
Adhoc max RTP port                                      : 20100 

--------------------- Displaying Call Records Service ---------------------
Enable Call Records Service                             : N 
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Call processor parameters

Figure B-18   Call processor parameters on the secondary System i IP Telephony server 

Hidden lines: Lines 6 to 22 are for trusted addresses and are not displayed as shown in 
Figure B-18.

------------------------ Displaying Call Processor ------------------------
Table 'CcCfg':
   SignallingIpAddr  
 1 9.5.92.67 
Table 'CcTrusted':
   TrustedAddress     Netmask           
1 9.5.92.67          255.255.255.255   
 2 9.5.92.66          255.255.255.255   
 3 9.5.92.68          255.255.255.255 
4 (none)             255.255.255.255   
 5 (none)             255.255.255.255   
 :
23 (none)             255.255.255.255   
24 (none)             255.255.255.255   
Table 'AcctServer':
   IpAddress         
 1 9.5.92.67         
 2 9.5.92.66         
Table 'AuthServer':
   IpAddress         
 1 9.5.92.67         
 2 9.5.92.66         
Table 'AdhocServer':
   ConferenceServerIp Adhoc Conf Port   
 1 9.5.92.67          5062 
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Common agent parameters

Figure B-19   Common agent parameters on the secondary System i IP Telephony server

Phone downloader parameters

Figure B-20   Phone downloader parameters on the secondary System i IP Telephony server

Firewall parameters

Figure B-21   Firewall parameters on the secondary System i IP Telephony server

IP Telephony Web services parameters

Figure B-22   IP Telephony Web services parameters on the secondary System i IP Telephony server

------------------------- Displaying Common Agent -------------------------
Local IP Address                                        : 9.5.92.67           
Site Type                                               : rocsa               
Trap Destination                                        : (none)              
Trap Community String                                   : public              
Table 'addonCaCfgTrapDestTable':
   Trap Destination   caCfgTrapDestCommu
 1 (none)             public            
 2 (none)             public            
 3 (none)             public            
Write Community String                                  : private             
Read Community String                                   : public              
Enable management station authentication?               : N                   
Table 'caCfgAuthAccTable':
   Authorized Address Netmask           
 1 (none)             255.255.255.255   
 2 (none)             255.255.255.255   
 3 (none)             255.255.255.255   
 4 (none)             255.255.255.255 

----------------------- Displaying Phone Downloader -----------------------
Local Interface Name                                    : eth0                
Local Ip Address                                        : 9.5.92.67 

--------------------------- Displaying Firewall ---------------------------
Primary Call Processor IP Address                       : (none)              
Secondary Call Processing IP Address                    : (none)              
Primary Provisioning/WebServices IP Address             : 9.5.92.66           
Secondary Provisioning/WebServices IP Address           : (none)              
Secondary Auth & Dir IP Address                         : 9.5.92.66 

------------------ Displaying IP Telephony Web Services -------------------
Primary Call Processor IP Address                       : 9.5.92.67           
Secondary Call Processing IP Address                    : 9.5.92.66           
Primary Auth & Dir IP Address                           : 9.5.92.67           
Secondary Auth & Dir IP Address                         : 9.5.92.66           
Local IP Address                                        : 9.5.92.67 
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Provisioning services parameters

Figure B-23   Provisioning services parameters on the secondary System i IP Telephony server

System accounts

Figure B-24   System accounts on the secondary System i IP Telephony server

--------------------- Displaying Provisioning Service ---------------------
Authentication & Directory Hostname                     : 9.5.92.67 
Site Identifier                                         : 1 

---------------------------- Displaying System ----------------------------
Table 'Accounts':
   Account            Enabled            Password           Shell             
 1 root               Y                  (encrypted)        /bin/bash         
 2 oracle             Y                  (encrypted)        /bin/bash         
 3 tomcat             Y                  (encrypted)        /bin/bash         
 4 cworks             Y                  (encrypted)        /bin/bash         
 5 vcx                Y                  (encrypted)        /bin/bash         
 6 app                Y                  (encrypted)        /bin/tcsh 
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IP Messaging service parameters

Figure B-25   IP Messaging service parameters on the secondary System i IP Telephony server

--------------------- Displaying IP Messaging Service ---------------------
IPMS IP address                                         : 9.5.92.67 
IPMSG System Type                                       : seondary 
Site Id                                                 : 1                   
Number of VoIP ports                                    : 120                 
Is this a Global Messaging configuration?               : N                   
Outbound call processor IP address                      : 9.5.92.67 
Secondary outbound call processor IP address            : 9.5.92.66 
Name of the SIP DDD                                     : 1.1.1.1             
TCP/UDP Port on which the IPMS will receive SIP messages: 5065
Alias for hostname                                      : demosec 
Is Intelligent Mirroring enabled?                       : Y                   
Hostname of peer IP Messaging system                    : (none) 
IP address of peer IP Messaging system                  : 9.5.92.66 
Is this host the primary or the secondary?              : S
Should European date order be used?                     : N                   
Customer name                                           : Customer ABC
Is Global Voicemail enabled?                            : (none)
Is this a Central Server for Global Voicemail?          : (none)
Table 'GlobalVMCentralServers':
   GlobalVMServIp    
 1 (none)            
Is Message Archival enabled?                            : N                   
Archival Server IP address                              : (none)              
User name for sftp to Archival Server                   : (none)              
Password for sftp to Archival Server                    : (none)              
Archival Server directory                               : (none)              
Enable data backup server for IPMS?                     : N                   
Backup Server IP address                                : (none)              
User name for sftp to Backup Server                     : (none)              
Password for sftp to Backup Server                      : (none)              
Backup Server Directory                                 : (none)              
Enable VCX subscriber bulk import?                      : Y                   
VCX Auth & Dir Service IP address                       : 9.5.92.67 
User name for access to Auth & Dir Server               : cworks              
Password for access to Auth & Dir Server                : cworks              
Enable NBX subscriber bulk import?                      : N                   
Is Text To Speech (TTS) enabled?                        : N                   
Table 'TtsServers':
   IP Address        
 1 (none)            
 :
4 (none)            
TTS port number                                         : 1722                
Will this system support IPMSG client systems?          : N                   
Table 'IPMsgClients':
   Client IP Address  Client Hostname   
 1 (none)             (none)            
:
20 (none)             (none) 
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Authentication and directory service parameters

Figure B-26   Authentication and directory service parameters on the secondary System i 
IP Telephony server

---------------------- Displaying Auth & Dir Service ----------------------
Local IP Address                                        : 9.5.92.67 
Site Identifier                                         : 1                   
Site Name                                               : HQ                  
Site Type                                               : rocsa               
Primary Call Processor IP Address                       : 9.5.92.66           
Secondary Call Processor IP Address                     : 9.5.92.67           
Is IPMS configured for Global Messaging?                : N                   
Primary IP Messaging service IP Address                 : 9.5.92.67 
Secondary IP Messaging service IP Address               : 9.5.92.66 
Enable Replication                                      : Y                   
Is this the Master Definition Site?                     : N
ROCSA IP Address                                        : (none)              
Login Username                                          : cworks              
Login Password                                          : (encrypted)         
Enable System Speed Dial Master?                        : Y                   
Enable LDAP Synchronization                             : N
LDAP Server                                             : (none) 
LDAP Server Port Number                                 : 389                 
LDAP Server Username                                    : (none)
LDAP Server Password                                    : (encrypted)         
LDAP Base DN                                            : / 
LDAP Synchronization Interval (seconds)                 : 1800 
LDAP Server Non-VCX User Identifier                     : non-VCX user        
---------------------------------------------------------------------------
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Appendix C. Location of log files

In this appendix, we discuss the location and use of several log files where you can find useful 
information about the tasks for all different applications involved in this integrated solution. We 
discuss the following log files:

� “LDAPSync log file” on page 206
� “System i IP Messaging log files” on page 207
� “System i IP Conferencing log files” on page 208
� “Sametime log files” on page 209

C
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LDAPSync log file

The LDAPSync log file contains error messages that are related to Lightweight Directory 
Access Protocol (LDAP) synchronization. The LDAPSync log file is located in the /var/log 
directory in the System i IP Telephony Linux partition and is called messages.

You can read the LDAPSync log file by using secure FTP WinSCP. To locate the messages 
log file by using the WinSCP tool:

1. Open the WinSCP tool and log into the Linux partition that is hosting the System i IP 
Telephony software with root access. Click Login to log into the Linux partition 
(Figure C-1). 

Figure C-1   Logging into the System i IP Telephony Linux partition with WinSCP
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2. Navigate to the /var/log directory and locate the messages file as shown in Figure C-2.

Figure C-2   Locating the LDAPSync messages log file

3. Open the log file or send it by using FTP to your local client as necessary. You also see 
several more files with the name messages.number.gz. These files are old versions of the 
message file that stores the history of the log file.

Inside this directory, several other log files give specific information regarding the IP 
Telephony solution activities:

– Boot.log file
– cron file
– maillog file
– secure
– vcxSetup.log
– install-upgrade-7.2.5c.log

System i IP Messaging log files

The System i IP Telephony software writes data to various log files and calls information to 
call detail records (CDRs). The IP Messaging software also writes call information to CDRs. 
You can see all of these files with the WinSCP tool.
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In addition, the /opt/3com/VCX/tomcat/logs/ directory contains the following files among 
others:

� catalina.out files
� localhost_access_log files
� manager log files
� voipadmin.log file
� voipuser.log file
� tomcat.log file

The IP Messaging log file, ums_cbipi.log, is stored in the usr/app/cbipi/ directory.

The following files are additional IP Messaging files:

� /usr/app/gen/app.out
� /usr/app/gen/eml_client.out
� /usr/app/gen/cpy4.out

System i IP Conferencing log files

Inside the /opt/logs directory (Figure C-3), you can find several directories that contain log 
files for the following applications:

� Conference bridge in the /confbridge directory
� Conferencing server in the /sipconf directory
� Presence server in the /presence directory
� Database import file in the / vcxdb directory

You can find debug log and error log files in there as well. You can find these files with the 
WinSCP tool logged into the System i IP Conferencing Linux partition.

Figure C-3   System i IP Conferencing log files
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Sametime log files

You can find trace information regarding the Sametime IP Telephony service in your 
Sametime server. In our example, this information is the /Domino/demost/Trace directory, 
where you find the IP Telephony log files (Figure C-4). You can view these files by using a text 
editor. You also can find other useful log files inside this directory.

Figure C-4   Sametime log files
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Appendix D. Performance

In this appendix, we provide performance information related to the Internet Message Access 
Protocol (IMAP) and the IPMADDIN task of the Lotus Domino server to synchronize with the 
message waiting indicator (MWI) on your phone and full text indexing of the Domino LDAP 
directory.

D
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IMAP

The IPMADDIN task of the Domino server uses the Internet Message Access Protocol 
(IMAP4) to synchronize with the MWI on your phone. Therefore, if you open a voice mail 
message that has been delivered to your Domino inbox, the message waiting light turns off on 
your phone. This synchronization is done by the IPMADDIN task.

The IPMADDIN task performs synchronization based on the poll interval that has been set in 
the System i IP Messaging server. The default setting for the poll interval is 30 minutes. See 
“Synchronization interval” on page 217 for the steps to determine the IMAP synchronization 
poll interval for a specific Domino user’s mail file.

Automatic IMAP enablement

The first time a voice mail or fax message is received from the System i IP Messaging 
message store into a user’s Domino mailbox, the mail file is automatically IMAP enabled. 
Additionally, any messages in the Domino user’s inbox that does not contain IMAP headers 
are converted to the Internet Message Access Protocol (MIME) format. E-mail messages are 
normally delivered to the inbox in CD format, which is a format that Lotus Notes understands.

The IPMADDIN task converts each document in the inbox to MIME format. These 
conversions are noted with the “Begin MIME to CD Conversion” messages that are displayed 
on the Domino server console. Figure D-1 on page 213 shows an example.

Any messages in the Domino inbox that have been received from the System i IP Messaging 
message store are already in MIME format. Therefore, they are not converted. All other 
documents, such as e-mail messages and calendar invitations, are converted.

More on conversion: All documents in the Domino inbox that have not already been 
converted to MIME message format are converted when the IPMADDIN task runs. 
Documents in other folders will not be converted.
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Figure D-1   Conversion of messages in the Domino inbox that do not have IMAP headers

09/13/2007 11:29:53   ipmaddin event: InboxAdd:Kim Greene:2386:####196

9/13/2007 11:29:53   IMAP Server: 9.5.92.66 connected
09/13/2007 11:29:53   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000B), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000092A)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000D), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000092E)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000E), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000932)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000A), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000936)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000D), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000092E)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000B), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000092A)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000D), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000093A)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000B), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000093E)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000E), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000932)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000E), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000942)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000A), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000936)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000A), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000946)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000B), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000093E)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000B), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000094A)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000E), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000942)
09/13/2007 11:29:54   Begin CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000E), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000094E)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000A), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000946)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000D), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000093A)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000B), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000094A)
09/13/2007 11:29:54   End CD to MIME Conversion(Process: IMAP Server (00000AAB:0000000E), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 0000094E)
09/13/2007 11:29:54   IMAP Server: Kim Greene/ITSO logged out
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How the IPMADDIN task works

The IPMADDIN task runs on the Domino mail server. This Domino task works with the 
System i IP Messaging message store to provide a unified inbox. It is important to know how 
this task functions so that you can understand how the task can impact performance. The 
following actions occur when voice mail and fax messages are synchronized between the 
System i IP Messaging message store and the Domino user’s mail file:

1. The System i IP Messaging message store receives a voice mail message or fax and 
activates the MWI on the user’s phone.

2. The System i IP Messaging message store sends the newly arrived message to the 
Domino mail server via Simple Mail Transfer Protocol (SMTP).

3. After the message is deposited into the Domino user’s mail file, the IPMADDIN task that is 
running on the Domino mail server sends an InboxAdd event back to the System i IP 
Messaging message store.

4. When the InboxAdd event is received by the System i IP Messaging message store, the 
System i IP Messaging server initiates an IMAP poll.

5. The IMAP poll converts all non-IMAP messages in the Domino user’s inbox that have not 
been previously converted. In doing so, it retrieves the IMAP unique identifier (UID) of the 
message and stores it in the System i IP Messaging message store.

6. When the user opens the voice mail message or fax in the Domino server, the Domino 
server sends a MarkRead event to the System i IP Messaging message store.

7. Upon receiving the MarkRead event, the System i IP Messaging message store updates 
the status of the MWI on the user’s phone.

8. Similarly, when a Domino user deletes a phone mail message or fax from their inbox, 
Domino sends a Delete event to the System i IP Messaging message store.

9. The System i IP Messaging message store receives the Delete event and updates the 
MWI on the user’s phone.

Now that we understand how the IPMADDIN task works with the System i IP Messaging 
message store, let us recap how the Domino mail file is impacted:

1. When the first phone mail message or fax is received into a Domino user’s mail file, the 
mail file is IMAP enabled.

2. At this point, all non-IMAP enabled documents in the inbox are converted to the MIME 
format.

3. As new documents are received into the inbox, they are converted to the MIME format 
when one of the following actions occurs:

– A new voice e-mail message is delivered to the Domino user’s mail file from the 
System i IP Messaging message store.

– A new fax message is delivered to the Domino user’s mail file from the System i IP 
Messaging message store.

– The IPMADDIN task executes at its defined polling interval.
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Setting RouterAppendIMAPItems

The notes.ini variable, RouterAppendIMAPItems=1, can be used to perform a partial Notes 
Rich Text (RTF) to MIME conversion for all Domino mail that is delivered to an IMAP-enabled 
database. When this conversion occurs, IMAP header information for the message is 
calculated and permanently stored with the document in the user’s Domino mail database as 
the message is delivered to the mail file.

Adding this variable to the Domino server’s notes.ini file prevents the need for the 
CD-to-MIME conversion. Implementation of this notes.ini variable is a trade-off between 
preventing the conversion versus increasing the size of each message delivered to the user’s 
inbox.

Figure D-2 on page 216 shows the conversion process for newly delivered mail messages. It 
also shows that the IPMADDIN task is also continuing to convert the messages. The 
messages on the console show the IMAP header being inserted into the e-mail message 
permanently as the router task delivers the e-mail to the user’s Domino mail file.

The IPMADDIN task continues to convert these new messages the first time it encounters 
them, although they already contain IMAP headers. Additionally, the behavior of the 
IPMADDIN task that continues to convert the most recent non-VCX message in the user’s 
inbox is shown, even though the e-mail message contains IMAP headers.

IMAP conversion performance tip: Conversion of all documents in the Domino inbox that 
are not IMAP enabled happens when the first voice mail message or fax is received from 
the System i IP Messaging message store. Therefore, it is important that you use the 
following tips:

� Encourage users to limit the number of documents in their inbox.

� Send a test voice mail message or fax from the System i IP Messaging message store 
to each user as they are enabled in the System i IP Messaging system during off-shift 
hours. By doing so, the one-time CD to MIME conversion of messages in their inbox 
can take place during non-production hours.

Important: While this notes.ini variable prevents the CD-to-MIME conversions from taking 
place, it also increases the size of the messages in the user’s Domino mail file. This can be 
a concern for users who have quotas on their mail files.
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Figure D-2   CD-to MIME conversion message for messages with IMAP headers

09/21/2007 16:29:58   IMAP Server: 9.5.92.66 connected
09/21/2007 16:29:58   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66
09/21/2007 16:29:58   Begin CD to MIME Conversion(Process: IMAP Server (00004A88:00000011), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A1E)
09/21/2007 16:29:58   End CD to MIME Conversion(Process: IMAP Server (00004A88:00000011), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A1E)
09/21/2007 16:29:58   IMAP Server: Kim Greene/ITSO logged out
09/21/2007 16:29:58   IMAP Server: 9.5.92.66 disconnected
09/21/2007 16:30:17   Begin CD to MIME Conversion(Process: Router (00004A91:00000005), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 80000001)
09/21/2007 16:30:17   End CD to MIME Conversion(Process: Router (00004A91:00000005), Database: 
/Domino/demodom/mail/kgreene.nsf, Note: 80000001)
09/21/2007 16:30:28   Begin CD to MIME Conversion(Process: Router (00004A91:00000005), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 80000001)
09/21/2007 16:30:28   End CD to MIME Conversion(Process: Router (00004A91:00000005), Database: 
/Domino/demodom/mail/kgreene.nsf, Note: 80000001)
09/21/2007 16:30:58   IMAP Server: 9.5.92.66 connected
09/21/2007 16:30:58   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66
09/21/2007 16:30:58   Begin CD to MIME Conversion(Process: IMAP Server (00004A88:00000011), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A26)
09/21/2007 16:30:58   Begin CD to MIME Conversion(Process: IMAP Server (00004A88:0000000C), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A2E)
09/21/2007 16:30:58   End CD to MIME Conversion(Process: IMAP Server (00004A88:00000011), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A26)
09/21/2007 16:30:58   End CD to MIME Conversion(Process: IMAP Server (00004A88:0000000C), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A2E)
09/21/2007 16:30:58   IMAP Server: Kim Greene/ITSO logged out
09/21/2007 16:30:58   IMAP Server: 9.5.92.66 disconnected
09/21/2007 16:31:57   IMAP Server: 9.5.92.66 connected
09/21/2007 16:31:57   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66
09/21/2007 16:31:57   Begin CD to MIME Conversion(Process: IMAP Server (00004A88:00000011), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A2E)
09/21/2007 16:31:57   End CD to MIME Conversion(Process: IMAP Server (00004A88:00000011), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A2E)
09/21/2007 16:31:57   IMAP Server: Kim Greene/ITSO logged out
09/21/2007 16:31:57   IMAP Server: 9.5.92.66 disconnected
09/21/2007 16:32:58   IMAP Server: 9.5.92.66 connected
09/21/2007 16:32:58   IMAP Server: Kim Greene/ITSO logged in from 9.5.92.66
09/21/2007 16:32:58   Begin CD to MIME Conversion(Process: IMAP Server (00004A88:00000012), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A2E)
09/21/2007 16:32:58   End CD to MIME Conversion(Process: IMAP Server (00004A88:00000012), 
Database: /Domino/demodom/mail/kgreene.nsf, Note: 00000A2E)
09/21/2007 16:32:58   IMAP Server: Kim Greene/ITSO logged out
09/21/2007 16:32:58   IMAP Server: 9.5.92.66 disconnected
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Figure D-3 shows that the IMAP headers are in the e-mail messages that were converted. 
Both of the Document Properties windows that are shown are for the top message that has 
the subject of “testing 4.”

Figure D-3   Document properties showing the document ID and IMAP header fields

Synchronization interval

The IPMADDIN task performs its synchronization based on the poll interval that has been set 
in the System i IP Messaging server. The default setting for the poll interval is 30 minutes. To 
determine the setting of the IMAP synchronization poll interval for a specific Domino user’s 
mail file:

1. Access the System i IP Messaging Web interface by entering the following URL in a Web 
browser:

http://primary_server_IP_address

Primary messaging server: You must access the primary System i IP Messaging 
server. The primary messaging server in our configuration has an IP address of 
9.5.92.66.
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2. Click the IP Messaging Web Provisioning link as shown in Figure D-4.

Figure D-4   Accessing the System i IP Telephony Web provisioning interface

3. Log in to the IP Messaging Web Provisioning for the System i IP Telephony partition. The 
default user ID and password are sockroot and secret respectively.

4. On the Welcome to 3Com IP Messaging page (Figure D-5), click Edit a Mailbox in the left 
navigation area.

Figure D-5   Selecting to edit a mailbox

 

 

 

218 IBM System i IP Telephony and Integrated Collaboration



 

5. On the Edit Mailbox pane (Figure D-6), enter the mailbox number to edit and click Submit. 

Figure D-6   Entering the mailbox number to edit

6. On the Mailbox Preferences page (Figure D-7), click the External Email link in the left 
navigation area.

Figure D-7   Selecting the External Email link for the mailbox being edited
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7. On the External Email page (Figure D-8), click the View/Edit button.

Figure D-8   Clicking the View/Edit button to edit the external e-mail information for the mailbox

8. On the External Email page (Figure D-9), locate the poll interval for the user’s mailbox that 
is being edited. In our example, the poll interval is the default setting of 30 minutes. If you 
need to change the polling interval, change the value in the Poll interval field and click 
Save. Changes to this parameter take effect immediately.

Figure D-9   Locating the polling interval for the user’s mailbox
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Full text indexing the Domino LDAP directory

It is important to full text index the Domino LDAP directory for optimal performance. Without 
full text indexing the Domino LDAP, the length of time required to look up a user increases as 
more users are added to the directory.

Performance of lookups within nested groups is particularly impacted if there is no full text 
index for the Domino Directory. See 2.2.3, “Full text indexing of the Domino Directory” on 
page 35, for detailed steps to enable full text indexing for the Domino Directory.
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this book.

IBM Redbooks

For information about ordering these publications, see “How to get Redbooks” on page 224. 
Note that some of the documents referenced here may be available in softcopy only. 

� IBM Lotus Domino 6 for iSeries Implementation, SG24-6592

� IBM System i IP Telephony Configuring the System i Infrastructure, SG24-7382

� Implementing IBM Lotus Domino 7 for i5/OS, SG24-7311

� Implementing POWER Linux on IBM System i Platform, SG24-6388

Other publications

These publications are also relevant as further information sources:

� i5/OS and related software Install, upgrade, or delete i5/OS and related software, 
SC41-5120

� IBM Lotus Sametime 8.0 Telephony Conferencing Service Provider Interface (TCSPI) 
Implementer Guide, SC23-8704

� Installing and Managing Sametime 7.5.1 for i5/OS, SC23-5978

� IP Conferencing Module Administration Guide

http://support.3com.com/infodeli/tools/vcx/71/IPCM_7.1_Admin_Guide.pdf

Online resources

These Web sites are also relevant as further information sources:

� 3Com IP Telephony for IBM System i documentation

http://csoweb4.3com.com/iseries/vcx_doc.cfm

� IBM Integrated Domino Fax for i5/OS

http://www.ibm.com/systems/i/software/domino/related/fxd/

� Cygwin

http://www.cygwin.com

� IBM Integrated Domino Fax for i5/OS

http://www.ibm.com/servers/eserver/iseries/domino/related/fxd/

� 3Com Open Network

http://open.3com.com
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How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications 
and Additional materials, as well as order hardcopy Redbooks, at this Web site: 

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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